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1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

3. Descrizione funzionale del software per il sistema EasyTool – lato PC

3.1 Funzionalità
Il software per PC contenuto nel CD ed allegato al sistema EasyTool, permette di:

• definire e configurare l’impianto

• configurare ed attivare i sistemi gestiti dall’impianto

• definire la porta di comunicazione per lo scambio dei dati

• definire gli utenti dell’applicazione

• eseguire il backup ed il restore dei dati dell’applicazione

• esportare su file uno o più impianti gestiti dal sistema ed importare da file uno o più impianti preceden-
temente esportati

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.
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4. Il login

All’attivazione dell’applicazione viene presentata la finestra di Login nella quale è richiesto l'inserimento dei dati 
identificativi dell'utente e la selezione dell'impianto con i quali l’applicazione deve essere attivata.

4.1 Utente 
Un utente è identificato dal nome utente e dalla password di accesso.
Per effettuare il login esistono due utenti utilizzabili e preinseriti con i seguenti dati di accesso: 

		  Utente	 Password

		  Vimar	 Vimar
		  inst	 inst

La tipologia dell'utente con cui si effettua il login ha effetto solo sulla Gestione degli utenti definiti nel 
sistema (vedere paragrafo 5.11). 

L'Amministratore principale e l'Amministratore sono abilitati ad effettuare le seguenti operazioni relative 
alla Gestione degli Utenti del sistema: 

• Inserimento di nuovi utenti

• Eliminazione di utenti esistenti appartenenti alle tipologie Amministratore e Installatore

• Modifica di tutti i dati degli utenti esistenti appartenenti alle tipologie Amministratore e Installatore

• Modifica della password dell'utente Amministratore principale

L'Installatore è abilitato ad effettuare le seguenti operazioni relative alla gestione degli utenti del siste-
ma: 

• Modifica della propria password.
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4.2 Impianto  
L'impianto da gestire nell'applicazione deve essere selezionato dall'apposita lista e può essere un nuovo 
impianto oppure uno degli impianti precedentemente configurati. 

Se viene selezionata la voce <Nuovo Impianto> dalla lista impianti, l'attivazione dell'applicazione è pre-
ceduta dalla visualizzazione della finestra per la codifica dei dati del nuovo impianto.

Una volta effettuato l'inserimento del nuovo impianto (vedere paragrafo 5.1), l'applicazione verrà attivata 
senza presentare alcun sistema nell'apposita barra degli strumenti: la configurazione dei sistemi del nuovo 
impianto dovrà essere effettuata tramite la funzione prevista dal menu Sistemi ► Configurazione. 

Se viene selezionato un impianto già esistente, l'applicazione viene attivata con i dati dell'impianto presen-
tando, nell'apposita barra degli strumenti, i sistemi gestiti dall'impianto scelto.
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Dalla finestra di login è possibile visualizzare tutti i dati identificativi dell’impianto selezionato nella lista 
tramite attivazione del pulsante funzione .
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4.3 Scelta Lingua  
La prima volta che viene eseguita, l’applicazione propone la scelta della lingua:

Selezionando una delle lingue proposte ed il tasto , viene attivata la finestra di Login nella lingua 
scelta; la finestra di Scelta Lingua non sarà più visualizzata alla successiva attivazione dell’applicazione.

Selezionando invece il tasto , viene attivata la finestra di Login nella lingua di default, e la 
finestra di Scelta Lingua verrà nuovamente proposta alla successiva attivazione dell’applicazione.
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5. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

5.1 Inserimento di un nuovo impianto. 
All’inserimento di un nuovo impianto si accede dal menu Impianto ► Nuovo, oppure selezionando la 
voce <Nuovo Impianto> dalla lista impianti della finestra di Login oppure dal tasto  
previsto al termine della procedura di Eliminazione di un impianto. 

	Per poter attivare la finestra corrente, non devono risultare moduli attivi nell'applicazione: si deve proce-
dere quindi alla chiusura di tutti i moduli prima di effettuare l'inserimento di un nuovo impianto. 

Per il nuovo impianto deve essere obbligatoriamente indicata la descrizione, che sarà visualizzata, al 
termine dell'operazione, nel titolo della finestra principale dell'applicazione. 

Mediante l'attivazione del tasto  è possibile gestire delle informazioni aggiuntive quali: 

• Nome del cliente 

• Indirizzo 

• Numero di telefono 

• Indirizzo e-mail 

• Note
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Il nuovo impianto può essere generato copiando i dati di un impianto già esistente tramite l'attivazione 

del tasto .

L'impianto dal quale effettuare la copia dovrà essere selezionato dall'apposita lista presentata nella finestra 
Scegli Impianto.
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Selezionando l’impianto dal quale copiare i dati ed il tasto , viene attivata l’operazione di copia 
che prevede la configurazione del nuovo impianto con i sistemi gestiti dall'impianto copiato e l'inserimento 
automatico di tutti i dati codificati in ciascuno dei sistemi associati.

Al termine della copia, l'applicazione presenterà i dati del nuovo impianto riportando, nella barra degli 
strumenti, i sistemi configurati.

Se il nuovo impianto non viene generato dalla copia di un impianto già esistente, al termine dell'operazione 
di inserimento, l'applicazione non presenterà alcun sistema nella barra degli strumenti: la configurazione 
dei sistemi del nuovo impianto dovrà essere effettuata tramite la funzione prevista dal menu Sistemi ► 
Configurazione. 

5.2 Modifica di un impianto. 
Alla modifica dei dati anagrafici di un impianto si accede dal menu Impianto ► Modifica. 
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Mediante l'attivazione del tasto  è possibile modificare le informazioni aggiuntive dell'im-
pianto quali: 

• Nome del cliente 

•	 Indirizzo 

•	 Numero di telefono 

•	 Indirizzo e-mail 

•	 Note

Se l’operazione viene terminata con l’attivazione del tasto , verranno salvate nell’impianto le 
informazioni modificate ed inoltre, nel caso di modifica della descrizione, questa sarà visualizzata nel titolo 
della finestra principale dell'applicazione. 
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5.3 Eliminazione di un impianto.  
È possibile effettuare l’eliminazione dell’impianto gestito dall’applicazione utilizzando la funzionalità del 
menu Impianto ► Elimina. 

Per poter accedere a questa funzionalità, non devono risultare moduli attivi nell'applicazione: si deve pro-
cedere quindi alla chiusura di tutti i moduli prima di effettuare l'eliminazione dell'impianto. 

La procedura di eliminazione dell'impianto prevede: 

1.	 La cancellazione di tutti i dati eventualmente codificati nei sistemi gestiti dall'impianto

2.	 La cancellazione dei sistemi configurati nell'impianto

3.	 La cancellazione dei dati anagrafici dell'impianto

Se per l’impianto da eliminare esistono dati codificati in uno o più dei sistemi gestiti, la procedura di elimi-
nazione viene eseguita solo dopo aver confermato una richiesta simile a quella sottoriportata.

Se l’impianto da eliminare ha uno o più sistemi associati per i quali non esistono dati codificati, la procedu-
ra di eliminazione viene eseguita solo dopo aver confermato una richiesta simile a quella sottoriportata.

Le funzionalità

Se l’impianto da eliminare ha uno o più sistemi associati per i quali non esistono dati codificati, la procedu-
ra di eliminazione viene eseguita solo dopo aver confermato una richiesta simile a quella sottoriportata.
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Al termine dell'eliminazione dell'impianto, viene visualizzata una finestra che consente di indicare l’impianto 
con cui dovrà essere riattivata l’applicazione. 

Attivando il tasto , viene visualizzata la finestra Scegli Impianto per selezionare, tra tutti 
gli impianti esistenti, quello da gestire.

Attivando il tasto , viene visualizzata la finestra Nuovo Impianto per inserire un nuovo 
impianto da gestire nell’applicazione.

Attivando il tasto , l’applicazione viene riattivata senza visualizzare i dati di alcun impianto.

5.4 Scelta di un impianto. 
La finestra che gestisce la selezione di un impianto tra tutti gli impianti esistenti nel sistema, può essere 

attivata dal menu Impianto ► Scegli, oppure dalla scelta  prevista al termine della pro-

cedura di Eliminazione di un impianto, oppure selezionando il tasto  nella finestra Nuovo 
Impianto. 

Se attivata in una delle prime due modalità sopra descritte, la finestra consente di sostituire l'impianto 
gestito dall'applicazione (selezionato in automatico dalla procedura), con un diverso impianto scelto dall'ap-
posita lista. 
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Selezionando un impianto diverso da quello corrente ed il tasto , i sistemi configurati per l'im-
pianto scelto verranno visualizzati nella barra degli strumenti dell'applicazione. In questi casi, per poter 
accedere alla funzionalità corrente, non devono risultare moduli attivi: si deve procedere quindi alla chiu-
sura di tutti i moduli prima di effettuare la scelta di un impianto. 

Se attivata in fase di creazione di un nuovo impianto, la finestra consente la selezione dell'impianto dal 
quale effettuare la copia dei dati. 

Selezionando l’impianto dal quale copiare i dati ed il tasto , viene attivata l’operazione di copia 
che prevede la configurazione del nuovo impianto con i sistemi gestiti dall'impianto copiato e l'inserimento 
automatico di tutti i dati codificati in ciascuno dei sistemi associati.
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5.5   Report di un impianto. 
È possibile ottenere un report completo dell’impianto gestito dall’applicazione tramite la finestra attivabile 
dal menu Impianto ► Report. 

Nel report prodotto vengono riportati tutti i dati anagrafici dell'impianto corrente e tutti i dati gestiti nei 
moduli associati all'impianto stesso. 

I dati elaborati vengono riportati in un file di testo il cui nome deve essere specificato prima di eseguire 
la procedura.

Il nome del file può essere digitato direttamente nell'apposito campo, oppure può essere specificato tra-

mite l'attivazione del tasto funzione ; in questo caso la procedura prevede l'attivazione di una finestra 
per la ricerca della posizione del file e la scrittura in automatico del nome del file selezionato nell'apposito 
campo. 

Il report prodotto viene visualizzato in un'apposita finestra dalla quale è prevista la possibilità di stamparlo 

tramite il tasto funzione .
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5.6   Configurazione di un impianto. 
Con i dati dell’impianto gestito dall’applicazione, è possibile configurare il Comunicatore GSM collegato 
al PC. 
Si può accedere a questa funzionalità dal menu Impianto ► Configura. 

L'operazione può essere effettuata solo se l'impianto è configurabile, e cioè se: 
• Il sistema Comunicatore è presente tra i sistemi gestiti nell'impianto 
• Nel sistema Comunicatore è stato codificato almeno un modulo GSM 
In caso contrario, verrà segnalato il seguente errore:

All'attivazione della procedura, viene richiesta la selezione di uno dei Comunicatori GSM definiti nell'im-
pianto.

Selezionando uno dei Comunicatori GSM ed il tasto  , il dispositivo collegato al PC verrà confi-
gurato con i dati del Comunicatore GSM scelto, previo conferma dell’operazione.
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Il termine dell’operazione viene segnalato da un apposito messaggio di avviso.
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5.7 Importazione dati in un impianto. 
È possibile acquisire, dal Comunicatore GSM collegato al PC, tutti i dati di configurazione dell’impianto.
Si può accedere a questa funzionalità dal menu Impianto ► Importa dati. 
L'operazione può essere effettuata solo se il sistema Comunicatore è presente tra i sistemi gestiti nell'im-
pianto. In caso contrario, verrà segnalato il seguente errore:

Prima di iniziare l’operazione, la procedura propone un messaggio di conferma simile a quello sottori-
portato.

I dati acquisiti dal Comunicatore GSM collegato al PC, vengono inseriti nell'impianto mediante creazione 
di un nuovo modulo GSM, i cui dati identificativi vengono richiesti a video in fase di importazione. 
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5.8 Configurazione dei sistemi. 
Questa finestra consente di definire i dispositivi ed i sistemi che devono essere associati all'impianto da 
gestire. 
Per poter attivare questa finestra, non devono risultare moduli attivi: si deve procedere quindi alla chiusura 
di tutti i moduli prima di effettuare la configurazione dei sistemi dell'impianto.
Si accede a questa funzionalità dal menu Sistemi ► Configurazione. 

Nella parte alta della finestra viene presentata la struttura gerarchica dell'impianto formata dai Dispositivi 
(Comunicatore 1941, Comunicatore 1942, Cronotermostato GSM 01913 e Centrale By-Me), dalle 
Interfacce ( Interfaccia 1848 ed Interfaccia 1931 applicabili solamente al Comunicatore 1941)  e dai 
Sistemi (Automazione Domestica ed Antintrusione, applicabili solamente al Comunicatore 1941 ed al 
Comunicatore 1942).

Selezionando il primo elemento, che rappresenta l'impianto, nella lista dei Sistemi Disponibili, nella parte 
bassa della finestra, vengono visualizzati i Dispositivi che possono essere associati all'impianto.
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L'aggiunta di un’interfaccia oppure di uno o più moduli ad un sistema, può essere eseguita selezionando l’in-

terfaccia oppure il modulo dalla lista dei Sistemi Disponibili ed attivando il pulsante funzione  
oppure, effettuando un doppio click con il tasto sinistro del mouse. 

L'eliminazione di uno o più moduli da un sistema, può essere eseguita selezionando i moduli precedentemente 

inseriti ed attivando il pulsante funzione .

La struttura dell'impianto viene aggiornata dopo ogni operazione di inserimento, eliminazione o spostamento 
di sistemi o di moduli. 

L'aggiunta di uno o più dispositivi all'impianto, può essere eseguita selezionando il dispositivo dalla lista 

dei Sistemi Disponibili ed cliccando sul pulsante funzione .

L'eliminazione di uno o più dispositivi dall'impianto, può essere eseguita selezionando i sistemi dalla lista 

dei Sistemi Gestiti ed attivando il pulsante funzione .

L'ordine con cui sono visualizzati i dispositivi nella lista dei Sistemi Gestiti, corrisponde all'ordine con cui 
gli stessi vengono riportati nella barra degli strumenti dell'applicazione. 

Selezionando l'elemento della struttura corrispondente ad un dispositivo dell'impianto, vengono visualiz-
zati, nella lista Sistemi Disponibili, le interfacce (per il Comunicatore 1941) oppure direttamente i moduli 
(per il Comunicatore 1942) associabili.
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Per effettuare l'operazione di copia deve essere selezionato, dalla lista Impianti, l'impianto dal quale 
importare i dati e, dalla lista Sistemi uno o più sistemi contenenti i dati da duplicare nell'impianto cor-
rente. 
I dati dei sistemi selezionati vengono sempre aggiunti a quelli eventualmente già codificati nell'impianto 
corrente. 
Nel caso in cui un dato da copiare risulta essere già esistente nell'impianto, la procedura prevede un'espli-
cita segnalazione della sua esistenza e richiede se proseguire comunque con l'operazione di copia. 

5.9 Copia dei sistemi
Nell'impianto gestito dall'applicazione è possibile importare uno o più sistemi già configurati per un altro 
impianto. 
Si può accedere a questa funzionalità dal menu Sistemi ► Copia. 

Attivando il bottone , la copia viene eseguita dopo aver richiesto l’inserimento di una 
nuova descrizione.
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Attivando il tasto , non viene eseguita la copia dell’elemento corrente, e l’operazione 
prosegue analizzando l’elemento successivo presente nel sistema da copiare.

Attivando infine il tasto  viene interrotta la procedura di copia.

Se nell'impianto corrente esiste un dato con caratteristiche diverse da quello da importare ma con uguale 
descrizione, la copia viene eseguita richiedendo solo una descrizione che sarà attribuita al nuovo dato 
inserito. 

Se il dato da copiare non esiste nell'impianto corrente, l'operazione di copia viene eseguita direttamente 
senza ulteriori richieste di conferma. 

È possibile duplicare i dati di un sistema all'interno dello stesso impianto selezionando l'impianto corrente 
nella lista Impianti ed i sistemi da duplicare nella lista Sistemi.

Per ciascun dato da copiare sarà, in questo caso, richiesta un'esplicita conferma a procedere all'opera-
zione di copia. 
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5.10 Comunicazione.
L’applicazione gestisce la selezione della porta di comunicazione che sarà utilizzata per lo scambio dei 
dati con il Comunicatore GSM o con la Centrale By-Me collegati al PC. 
Si può accedere a questa funzionalità dal menu Utility ► Comunicazione.

La porta di comunicazione deve essere selezionata dall'apposita lista in cui sono visualizzate tutte le 
porte di comunicazione disponibili nel sistema. 

Una volta confermata la selezione di una porta di comunicazione con l’attivazione del tasto , 
questa verrà evidenziata in automatico nell'apposita lista alla successiva attivazione della finestra. 
È consentita la selezione di una porta di comunicazione diversa da quella evidenziata, solo nel caso in 
cui quest'ultima non risulti in uso nell'applicazione. 
Nel caso in cui la porta selezionata in precedenza non risulta più disponibile, all'attivazione della finestra 
è prevista la chiusura automatica della porta, nel caso in cui questa risulti aperta, e la possibilità di sele-
zionare un'altra porta tra quelle disponibili.  
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5.11 Gestione degli utenti. 
L’applicazione permette di configurare gli utenti abilitati al suo utilizzo, di assegnare loro i privilegi e di 
gestire le password di accesso.
Si può accedere a questa funzionalità dal menu Utility ► Gestione utenti. 
È possibile inserire nuovi utenti, modificare i dati ed eliminare gli utenti esistenti. 

Per ciascun utente sono gestiti i seguenti campi: 
•	Utente: nome dell'utente 
•	Password: parola chiave di accesso all'applicazione 
•	Gruppo: gruppo di appartenenza dell'utente; può assumere uno dei seguenti valori: 

- Amministratore principale 
- Amministratore 
- Installatore

A seconda del gruppo di appartenenza dell'utente con cui è stato effettuato il login, la finestra si confi-
gura abilitando/disabilitando le varie funzionalità. 

Se l'utente attivo appartiene ai gruppi Amministratore principale o Amministratore, è abilitato ad effet-
tuare le seguenti operazioni: 

• Inserimento di nuovi utenti.
•	 Eliminazione di utenti esistenti appartenenti ai gruppi Amministratore ed Installatore.
•	 Modifica di tutti i dati degli utenti esistenti appartenenti ai gruppi Amministratore ed Installatore.
• 	Modifica della password dell'utente Amministratore principale.

Se l'utente attivo appartiene al gruppo Installatore, è abilitato ad effettuare le seguenti operazioni: 
• Modifica della propria password
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L'utente appartenente al gruppo Amministratore principale è un utente preinserito, non può essere eli-
minato e non possono essere modificati i dati relativi al nome utente ed al gruppo di appartenenza. Non 
possono essere inseriti altri utenti appartenenti al gruppo Amministratore principale. L'unica operazione 
consentita sui dati dell'Amministratore principale è la sola modifica della password. 

La modifica della password di un utente si effettua selezionando l'utente dall'apposita lista ed attivando 

il tasto  . La finestra Cambia Password attivata, consentirà di inserire una nuova 
password per l'utente selezionato previo inserimento della password corrente. 
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5.12 Impostazione tempo di refresh.
L’applicazione consente di specificare l'intervallo di tempo con il quale devono essere aggiornati i dati 
gestiti a video con quelli letti dal Comunicatore GSM collegato. 

Si può accedere a questa funzionalità dal menu Utility ► Tempo refresh.

Il tempo è gestito in secondi e deve essere specificato un tempo minimo di 1 secondo. 

5.13  Backup dei dati.
È possibile eseguire il salvataggio dei dati dell’applicazione utilizzando la funzionalità del menu Utility 
► Backup.

L’operazione di backup esegue il salvataggio dei seguenti dati:

•	tutti gli impianti gestiti dall’applicazione (quelli che compaiono nella lista degli impianti che possono 
essere aperti);

•	tutti gli utenti esistenti;
•	tutti i parametri di configurazione dell’applicazione (tempo di refresh, selezione porta di comunicazione, 

ecc.).
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Il salvataggio viene eseguito tramite l'attivazione del tasto  dopo aver indicato il nome del 
file su cui fare la copia dei dati.

Il nome del file può essere digitato direttamente nell'apposito campo oppure può essere indicato sele-
zionando un elemento dalla lista dei file prevista nella finestra.

In questo caso il file selezionato, dopo la richiesta di conferma, sarà sovrascritto e di conseguenza i dati 
salvati in precedenza verranno persi.

Le funzionalità

5.14 Restore dei dati. 
È possibile eseguire il ripristino dei dati dell’applicazione da un precedente salvataggio utilizzando la 
funzionalità del menu Utility ► Restore.

Questa operazione può essere eseguita solo dall’amministratore principale (Vimar).

L'operazione viene eseguita tramite l'attivazione del tasto  dopo aver indicato il nome del 
file da cui fare il ripristino dei dati.

Il file indicato per il ripristino deve essere un file precedentemente generato tramite la procedura di 
Backup Dati e può essere selezionato dall'apposita lista prevista nella finestra. 

L’operazione di restore esegue il ripristino dei seguenti dati presenti nel file selezionato: 

• impianti;
• utenti;
•	 parametri di configurazione dell’applicazione.
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5.15 Scelta della lingua. 
In qualsiasi momento è possibile modificare la lingua dell’applicazione tramite la funzionalità attivabile 
dal menu Utility ► Lingua.

Selezionando una delle lingue elencate ed il tasto , la lingua scelta verrà applicata solo alla 
successiva esecuzione dell'applicazione, come segnalato dalla procedura al termine dell’operazione.

Ne consegue che saranno persi i dati precedenti all’operazione di restore.

La procedura di restore termina con la chiusura dell’impianto corrente.
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5.16 Esporta impianti su file. 
È possibile esportare su file i dati di uno o più impianti gestiti dal sistema EasyTool utilizzando la funzio-
nalità del menu File ► Esporta impianti.

La finestra può essere attivata solo se non risultano moduli attivi: si deve procedere quindi alla chiusura 
di tutti i moduli prima di effettuare l'esportazione degli impianti su file. 

Gli impianti da esportare devono essere selezionati dall'apposita lista in cui sono visualizzati tutti gli 
impianti esistenti nel sistema.

Tramite il pulsante Seleziona tutto possono essere selezionati o deselezionati in automatico tutti gli 
impianti disponibili. 

Prima di eseguire la procedura deve essere specificato il nome di un file di tipo zip che dovrà contenere 
i dati degli impianti da esportare.

Il nome del file può essere digitato direttamente nell'apposito campo, oppure può essere specificato 

tramite l'attivazione del tasto funzione ; in questo caso la procedura prevede l'attivazione di una 
finestra per la ricerca della posizione del file e la scrittura in automatico del nome del file selezionato 
nell'apposito campo.

Se viene specificato il nome di un file già esistente, dopo una specifica richiesta di conferma a proce-
dere, il file sarà sovrascritto e di conseguenza i dati degli impianti precedentemente esportati verranno 
persi.
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Alla selezione del primo impianto da esportare, la procedura prevede la proposta automatica del nome 
del file di esportazione; il nome proposto può comunque essere modificato. 

L’esportazione su file degli impianti selezionati si attiva tramite il pulsante funzione . 
Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio di 
avviso.
 

I dati degli impianti contenuti nei file di esportazione generati dalla procedura corrente, possono essere 
caricati nel sistema EasyTool tramite la finestra Importa Impianti Da File.
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5.17 Importa impianti da file. 
È possibile caricare nel sistema EasyTool i dati di uno o più impianti contenuti in un file di importazione 
utilizzando la funzionalità del menu File ► Importa impianti.

La finestra può essere attivata solo se non risultano moduli attivi: si deve procedere quindi alla chiusura 
di tutti i moduli prima di effettuare l'importazione degli impianti da file. 

Prima di eseguire la procedura deve essere indicato il nome di un file di tipo zip contenente i dati degli 
impianti da importare.

Il file indicato per l'importazione deve essere un file precedentemente generato tramite la finestra 
Esporta Impianti Su File.

Il nome del file può essere digitato direttamente nell'apposito campo, oppure può essere specificato 

tramite l'attivazione del tasto funzione ; in questo caso la procedura prevede l'attivazione di una 
finestra per la ricerca della posizione del file e la scrittura in automatico del nome del file selezionato 
nell'apposito campo. 

Una volta specificato il file di importazione, vengono visualizzati, nell'apposita lista, gli impianti conte-
nuti nel file indicato. Tra tutti gli impianti disponibili, dovranno essere selezionati uno o più impianti da 
importare nel sistema.

Tramite il pulsante Seleziona tutto possono essere selezionati o deselezionati in automatico tutti gli 
impianti disponibili. 
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All'attivazione del pulsante funzione , la procedura procederà al caricamento, nel sistema 
EasyTool, dei dati degli impianti selezionati. 

Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio di 
avviso.

Gli impianti importati vengono sempre aggiunti a quelli già esistenti nel sistema, anche nel caso in cui 
presentano una descrizione uguale a quella di un impianto preesistente. 

Una volta terminata la procedura di importazione, gli impianti importati potranno essere gestiti dall'appli-
cazione selezionando uno dei nuovi impianti tramite la finestra Scegli Impianto.
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5.18 Help. 
L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea, oppure 
attraverso il tasto F1 dalle finestre principali. 
Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato (ad 
esempio: premendo F1 dalla finestra “Modifica Impianto” verrà visualizzata la parte dell'help relativa alla 
modifica dei dati anagrafici di un impianto).

Le funzionalità
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5.19 Esempi Applicativi. 

5.19.1 Primo avvio del sistema EasyTool.

Operazioni da eseguire

1.	 Scegliere la lingua dell’applicazione dalla finestra Scelta Lingua (vedere il paragrafo 4.3).

2.	 Nella finestra di Login, inserire uno degli utenti predefiniti con la relativa password (vedere il 
paragrafo 4.1).

3.	 Nella finestra di Login, selezionare la voce <Nuovo impianto> dalla lista degli impianti oppure 

attivare il pulsante funzione  per procedere all’inserimento di un nuovo impianto 
(vedere il paragrafo 4.2).

4.	 Nella finestra Nuovo Impianto, inserire e confermare i dati anagrafici del nuovo impianto (vede-
re il paragrafo 5.1).

5.	 Configurare i sistemi dell’impianto attivando la finestra Configurazione Impianto dal menu 
Sistemi ► Configurazione (vedere il paragrafo 5.8).

6.	 Selezionare la porta di comunicazione che dovrà essere utilizzata dall’applicazione per lo 
scambio dei dati con il Comunicatore GSM o con la Centrale By-Me collegati al PC attivando 
la finestra Comunicazione dal menu Utility ► Comunicazione (vedere il paragrafo 5.10).

7.	 Se è stato eseguito il login con utente Vimar, inserire eventuali nuovi utenti dell’applicazione 
attivando la finestra Gestione Utenti dal menu Utility ► Gestione utenti (vedere il paragrafo 
5.11).

8.	 Per il comunicatore GSM è possibile importare i dati di configurazione tramite la voce di menu 
Impianto ► Importa dati (vedere il paragrafo 5.7).

9.	 Attivare i singoli moduli dei sistemi gestiti dall’impianto selezionando i relativi pulsanti funzione 
previsti nella barra principale dell’applicazione.
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5.19.2 Successivi avvii del sistema EasyTool.

Operazioni da eseguire

1.	 Nella finestra di Login inserire uno degli utenti dell’applicazione con la relativa password e 
selezionare l’impianto da gestire (vedere i paragrafi 4.1 e 4.2).

2.	 Per modificare i dati anagrafici dell’impianto attivare la finestra Modifica Impianto dal menu 
Impianto ► Modifica (vedere il paragrafo 5.2).

3.	 Per eliminare l’impianto gestito dall’applicazione e tutti i suoi dati codificati, selezionare il menu 
Impianto ► Elimina (vedere il paragrafo 5.3).

4.	 Per gestire nell’applicazione un impianto diverso da quello corrente, attivare la finestra Scegli 
Impianto dal menu Impianto ► Scegli (vedere il paragrafo 5.4).

5.	 Per configurare i sistemi dell’impianto gestito dall’applicazione, selezionare il menu Impianto 
► Configura (vedere il paragrafo 5.6).

6.	 Per modificare la configurazione dei sistemi dell’impianto attivare la finestra Configurazione 
Impianto dal menu Sistemi ► Configurazione (vedere il paragrafo 5.8).

7.	 Per copiare nell’impianto corrente i dati di un altro impianto dell’applicazione attivare la finestra 
Copia Sistemi dal menu Sistemi ► Copia (vedere il paragrafo 5.9).

8.	 Per modificare la porta di comunicazione utilizzata per lo scambio dei dati con il Comunicatore 
GSM o con la Centrale By-Me collegati al PC, attivare la finestra Comunicazione dal menu 
Utility ► Comunicazione (vedere il paragrafo 5.10).

9.	 Se l’utente con il quale è stato eseguito il login appartiene al gruppo Installatore, è possibile 
modificare la password dell’utente stesso attivando la finestra Gestione Utenti dal menu 
Utility ► Gestione utenti (vedere il paragrafo 5.11).

10.	Se l’utente con il quale è stato eseguito il login appartiene ai gruppi Amministratore o 
Amministratore Principale, è possibile inserire nuovi utenti, modificare o eliminare gli utenti 
esistenti attivando la finestra Gestione Utenti dal menu Utility ► Gestione utenti (vedere il 
paragrafo 5.11).

11.	Per salvare i dati di tutti gli impianti dell’applicazione, attivare la finestra Backup Dati dal menu 
Utility ► Backup (vedere il paragrafo 5.13).

12.	Per ripristinare i dati degli impianti da un precedente salvataggio, attivare la finestra Restore 
Dati dal menu Utility ► Restore (vedere il paragrafo 5.14).

13.	Per modificare la lingua gestita dall’applicazione, attivare la finestra Scelta Lingua dal menu 
Utility ► Lingua (vedere il paragrafo 5.15).
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Sezione 2
Il software EasyTool - Applicazioni 
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Sezione 2.1
Centrale By-me
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1. Requisiti minimi hardware e software

1.1	 Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
      • Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

1.2	 Hardware:

1. Centrale By-Me
2. Interfaccia per programmazione, collegamento al PC su porta USB (Catalogo Vimar, Art. 01998.S)
3. PC con i seguenti requisiti:

• 100 Mb di spazio di memoria su disco fisso
• Mouse 
• CD-ROM 
• Porta USB 

2. Installazione del programma

L’utente verrà guidato nell’installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC. 

3. Descrizione Funzionale del Sistema Centrale By-Me

3.1 Funzionalità
Il sistema di gestione della Centrale By-Me permette di eseguire le seguenti operazioni sulla centrale: 

1. aggiornare il software, cioè il software che risiede nella centrale; 

2. importare, esportare e personalizzare il database interno alla centrale, contenente le informazioni riguar-
danti i gruppi, gli scenari, i dispositivi Clima e gli eventi; 

3. preparare il file di configurazione dell’applicativo per Media Center.

Nell’impianto in gestione, se non già presente, aggiungere il sistema Centrale By-Me tramite il menu 
Sistemi ► Configurazione.

Requisiti - Installazione - Funzionalità
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Successivamente, per accedere alla finestra di configurazione della centrale si seleziona . 

3.2 Gestione del Sistema Centrale By-Me   

La gestione della Centrale By-Me avviene selezionando con il mouse l'opzione  e clic-
cando sul pulsante . A questo punto verrà visualizzata la finestra "Parametri di configurazione".

Descrizione funzionale
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Mediante le informazioni riportate nella cartella Generale si gestiscono i parametri base della centrale 
By-Me. È possibile

1. aggiornare il software; 
2. leggere la versione del software e del database;
3. importare ed esportare il database; 
4. creare il file di configurazione per l’applicazione Media Center. 

I dati riportati nella cartella Gruppi consentono la gestione dei gruppi definiti nella centrale By-Me.
È possibile

1. visualizzare le informazioni dei gruppi definiti; 
2. personalizzare il tipo, il numero, la stanza, la zona e l’accessibilità da remoto mediante comunica-

tore GSM.
3. visualizzare l’elenco dei gruppi che sono attivati dalla voce selezionata.

I dati riportati nella cartella Scenari consentono la gestione degli scenari definiti nella centrale By-Me.
È possibile

1. visualizzare le informazioni degli scenari definiti; 
2. personalizzare i nomi e l’accessibilità da remoto mediante comunicatore GSM; 
3. visualizzare l’elenco dei gruppi che appartengono ad uno scenario. 

I dati riportati nella cartella Clima consentono la gestione delle zone climatiche definite nella centrale 
By-Me. È possibile 

1. visualizzare le informazioni delle zone climatiche; 
2. personalizzare le zone climatiche impostando i relativi parametri; 
3. aggiungere e rimuovere le zone climatiche. 

Le funzionalità
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I dati riportati nella cartella Eventi consentono la gestione degli eventi definiti nella centrale By-Me. È 
possibile 

1. visualizzare gli eventi; 
2. personalizzare gli eventi impostando i parametri funzionali;
3. aggiungere e rimuovere gli eventi.

4. Cartella Generale 

Le funzionalità principali presenti in questa cartella consentono di: 
1. importare i dati nel database dell'EasyTool dalla Centrale By-Me oppure da un file; 
2. esportare i dati dal database dell'EasyTool alla Centrale By-Me oppure su un file;
3. creare il file per l’applicativo Media Center; 
4. salvare e ripristinare i dati della Centrale By-Me; 
5. aggiornare il software.

La selezione, modifica, eliminazione e stampa delle informazioni delle varie Centrali By-Me presenti nell’im-
pianto è possible mediante i pulsanti funzione di navigazione della toolbar.

Cartella Generale
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4.1 Parametri 
Per ciascuna centrale By-Me sono gestiti i seguenti parametri di configurazione: 
1. Descrizione: descrizione della centrale, deve essere obbligatoriamente specificata ed identifica la 

centrale nell’impianto; 
2. Password: password della centrale, da digitare quando richiesta. L’inserimento della password è 

obbligatorio per poter comunicare con la centrale By-Me attraverso il PC quando è collegato ad 
essa mediante l’interfaccia per programmazione (Art. 01998.S);

1. Versione Software: versione del software della centrale, che viene letta e memorizzata tramite il 
pulsante Rileggi; 

2. Database: versione del database della centrale, che viene letta e memorizzata tramite il pulsante 
Rileggi; 

4.2 Operazioni 
Dalla cartella è possibile effettuare le seguenti operazioni. 

4.2.1	 Importare il Database della Centrale By-Me all’interno dell'EasyTool quando è memorizza-
to in un file:
1.1. premere sul pulsante di importazione database Da file; 
1.2. selezionare il nome del file (.HEX) del database; 
1.3. confermare. 

4.2.2. Importare il Database della Centrale By-Me all’interno dell'EasyTool direttamente dalla 
centrale: 
2.1. collegare la centrale By-Me al PC mediante l’interfaccia per programmazione (Art. 01998.S);  
2.2. premere sul pulsante di importazione database Da centrale; 
2.3. inserire la password quando richiesta; 
2.4. confermare.

Cartella Generale
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4.2.3	 Esportare il Database della Centrale su File: 
3.1. premere sul pulsante Su file; 
3.2. selezionare il nome del file (.HEX) che si vuole generare; 
3.3. confermare; 
Nel caso in cui la centrale non si riavvi, si deve disconnettere per qualche secondo il suo cavo di 
alimentazione ed il connettore del bus, che sono posti sul retro della stessa.

4.2.4	 Esportare il Database dell'EasyTool direttamente sulla Centrale By-Me: 
4.1. collegare la centrale By-Me al PC mediante l’interfaccia per programmazione (Art. 01998.S);  
4.2. premere sul pulsante Su Centrale; 
4.3. inserire la password quando richiesta; 
4.4. confermare; 
Nel caso in cui la centrale non si riavvi, si deve disconnettere per qualche secondo il suo cavo di 
alimentazione ed il connettore del bus, che sono posti sul retro della stessa.

4.2.5	 Creare il file per l’applicativo Media Center: 
5.1. premere sul pulsante dell’esportazione del database Su media center; 
5.2. selezionare il nome del file (.HEX) che si vuole generare; 
5.3. confermare;

4.2.6	 Salvare e ripristinare i dati della centrale (da utilizzare quando non si desidera visualizzare tali 
dati all’interno del software dell'EasyTool): 
6.1. collegare la centrale By-Me al PC mediante l’interfaccia per programmazione (Art. 01998.S);  
6.2. premere sul pulsante Salva i dati oppure Ripristina i dati per salvare le informazioni della 

centrale o ripristinare le informazioni salvate sulla centrale; 
6.3. selezionare il nome del file (.HEX) che si vuole generare o inviare alla centrale; 
6.4. inserire la password quando richiesta; 
6.5. confermare;

4.2.7	 Aggiornare la versione del Software: 
7.1. collegare la centrale By-Me al PC mediante l’interfaccia per programmazione (Art. 01998.S);  
7.2. premere su Aggiorna Software; 
7.3. selezionare il file HEX che contiene il software da inviare alla centrale; 
7.4. inserire la password nell’apposita finestra; 
7.5. confermare l’aggiornamento. 

Attenzione. L’aggiornamento del Software provoca l’eliminazione di tutta la configura-
zione della centrale By-Me. Pertanto si consiglia di salvare i dati sul PC, come copia di 
backup, prima di effettuare questa operazione.  

Cartella Generale



50

4.3 Stampa Generale
La stampa dei parametri generali si effettua dalla finestra di stampa disponibile tramite l’omonimo pul-
sante della cartella Generale.

Per eseguire la stampa è necessario: 
1. definire un nuovo file di testo, in cui vengono memorizzate le informazioni da stampare, oppure sovra-

scrivere uno già esistente tramite il pulsante Cerca File; 
2. confermare la scelta con il pulsante Ok; 

3. premere sul pulsante Stampa della finestra che permette la visualizzazione del file appena creato.  

Cartella Generale
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5. Cartella Gruppi

Da questa cartella è possibile personalizzare alcune informazioni sui gruppi presenti nella centrale By-Me; 
è anche possibile scorrere od effettuare una ricerca rapida dei gruppi con i pulsanti funzione di navigazione 
e stampare le relative informazioni, salvandole in un file di testo.

5.1 Parametri 
Per ciascuna gruppo sono riportate le seguenti informazioni: 
1. Id: Indice di gruppo. È l’identificativo univoco del gruppo presente nella centrale By-Me; 
2. Addr: indirizzo esadecimale del primo gruppo;
3. Applicazione: applicazione di cui fa parte il gruppo (es. Controllo carichi, Clima, Luci, Sistema 

antintrusione ...);
4. GSM: indica se il gruppo è abilitato alla gestione remota mediante interfaccia GSM. 
5. Tipo: parte della descrizione, indica la tipologia di dispositivo per cui è stato creato il gruppo (es. relè, 

sensore infrarossi, luce); 
6. Numero: parte della descrizione, è un valore numerico compreso tra 0 e 63; 
7. Stanza: parte della descrizione, indica la locazione, la stanza in cui sono presenti i dispositivi, per cui 

è stato creato il gruppo;
8. Zona: parte della descrizione, indica la zona in cui sono presenti i dispositivi, per cui è stato creato il 

gruppo (es. interno, esterno, nord, zona notte...). 

Cartella Gruppi
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5.2 Operazioni
• Si possono introdurre nuovi gruppi.
• Si possono cancellare dei gruppi,  purché siano vuoti e quindi non siano collegati ad altri gruppi. 
• Per ogni gruppo è possibile modificare:

1. il campo GSM, per la gestione remota, 
2. la descrizione agendo sugli ultimi quattro parametri: Tipo, Numero, Stanza e Zona. 

Per modificare i valori è necessario premere sul pulsante Modifica della toolbar.
I parametri Id, Addr ed Applicazione sono disponibili solo per consultazione. 

Selezionando un gruppo e premendo sul pulsante Gruppi, situato in fondo alla finestra, viene visualiz-
zata un’ulteriore finestra che contiene il dettaglio dei relativi gruppi effettivamente impiegati. 

Cartella Gruppi
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5.3 Stampa Gruppi
La stampa dei gruppi si effettua dalla finestra di stampa disponibile tramite l’omonimo pulsante della 
cartella Gruppi.

Per eseguire la stampa è necessario: 
1. inserire gli Id del primo e dell’ultimo gruppo da stampare; 
2. scegliere le applicazioni di cui devono far parte i gruppi da stampare; 
3. definire un nuovo file di testo, in cui vengono memorizzate le informazioni da stampare, oppure so-

vrascrivere uno già esistente tramite il pulsante Cerca File; 
4. confermare la scelta con il pulsante Ok;

Cartella Gruppi
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5. premere sul pulsante Stampa della finestra che permette la visualizzazione del file appena creato. 

Cartella Gruppi
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6. Cartella Scenari

Da questa cartella è possibile personalizzare alcune informazioni sugli scenari presenti nella Centrale By-Me; 
è anche possibile scorrere od effettuare una ricerca rapida degli scenari con i pulsanti funzione di navigazio-
ne e stampare le relative informazioni, salvandole in un file di testo. 

6.1 Parametri
Per ciascuno scenario sono riportate le seguenti informazioni: 
1. Indice: identificativo dello scenario. È l’identificativo univoco dello scenario presente nella centrale 

By-Me; 
2. Indirizzo: indirizzo di gruppo espresso nel sistema numerico esadecimale;
3. Globale: indica se lo scenario è globale; in tutti gli altri casi lo scenario è locale;
4. GSM: indica se lo scenario è abilitato alla gestione remota tramite protocollo GSM mediante l’inter-

faccia del comunicatore; 
5. Nome: nome dello scenario. 

Cartella Scenari
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6.2 Operazioni
Si possono introdurre nuovi scenari. 
Si possono cancellare degli scenari,  purché siano vuoti e quindi non siano collegati ad nessun gruppo. 
Per ogni scenario è possibile modificare i campi: Globale, GSM e Nome.
Per modificare i valori è necessario premere sul pulsante Modifica della toolbar.
I parametri Indice ed Indirizzo sono disponibili solo per consultazione.

Premendo sul pulsante Gruppi Associati, situato in fondo alla finestra, viene visualizzata un’ulteriore 
finestra che contiene l’elenco dei gruppi che appartengono allo scenario selezionato. 

Cartella Scenari
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6.3 Stampa Scenari
La stampa degli scenari si effettua dalla finestra di stampa disponibile tramite l’omonimo pulsante della 
cartella Scenari. 

Cartella Scenari
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Per eseguire la stampa è necessario: 
1. inserire gli Id del primo e dell’ultimo scenario da stampare; 
2. definire un nuovo file di testo, in cui vengono memorizzate le informazioni da stampare, oppure sovra-

scrivere uno già esistente tramite il pulsante Cerca File; 
3. confermare la scelta con il pulsante Ok; 

4. premere sul pulsante Stampa della finestra che permette la visualizzazione del file appena creato.

Cartella Scenari
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7. Cartella Clima

Da questa cartella è possibile gestire le zone climatiche della Centrale By-Me; è anche possibile scorrere le 
zone climatiche o fare una ricerca rapida con i pulsanti funzione di navigazione. 

7.1  Parametri
1. Zona Clima: identificativo della zona. È l’identificativo univoco della zona presente nella centrale By-

Me. 

2. Gruppo Associato: descrizione del gruppo del termostato a cui è associata la zona Clima; 

3. Impostazioni: pulsante che permette l’apertura di una ulteriore finestra in cui è possibile modificare 
i valori relativi ai SetPoint, differenziale termico e range protezione; il Gruppo Associato è attivo sola-
mente se l’indirizzo fisico del termostato è stato precedentemente inserito nella centrale.

Cartella Clima
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Le  impostazioni della cartella Clima permettono di personalizzare i seguenti parametri delle zone cli-
matiche: 

1.1.	 Zona Clima: indice univoco che identifica la Zona Clima nella Centrale By-Me;

1.2.	 Gruppo Associato: descrizione del gruppo associato alla Zona Clima; 

1.3.	 Setpoint antigelo: temperatura impostata per la funzionalità di antigelo; 

1.4.	 Riduzione del setpoint: temperatura impostata per la modalità ridotta, cioè di risparmio energe-
tico; 

1.5.	 Setpoint manuale: temperatura impostata per la modalità manuale; 

1.6.	 Setpoint override: temperatura impostata per la modalità override, cioè quella che si presenta 
quando, dalla modalità automatica, si cambia manualmente il settaggio; 

1.7.	 Setpoint riscaldamento T1: temperatura impostata per la programmazione del primo livello di 
riscaldamento; 

1.8.	 Setpoint riscaldamento T2: temperatura impostata per la programmazione del secondo livello di 
riscaldamento; 

1.9.	 Setpoint riscaldamento T3: temperatura impostata per la programmazione del terzo livello di 
riscaldamento; 

Cartella Clima
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1.10.	Setpoint condizionamento T1: temperatura impostata per la programmazione del primo livello di 
condizionamento; 

1.11.	 Setpoint condizionamento T2: temperatura impostata per la programmazione del secondo livello 
di condizionamento; 

1.12.	Setpoint condizionamento T3: temperatura impostata per la programmazione del terzo livello di 
condizionamento; 

1.13.	Differenziale termico: isteresi simmetrico sulla regolazione del setpoint; ad esempio se il setpoint 
è di 20 gradi ed il differenziale è di 0.1 allora a 20,1 gradi verrà fermato il riscaldamento, che ripren-
derà a 19.9 gradi; 

1.14.	Range setpoint: intervallo di regolazione in modalità protetta. Questa valore consente di porre un 
limite ai cambiamenti di temperature operabili manualmente. L'utente potrà incrementare o ridurre 
la temperatura impostata dal Setpoint in misura inferiore all'intervallo stabilito. Questa funzionalità 
è molto utile in situazioni particolari, ad esempio negli ambienti pubblici.

7.2 Operazioni
È possibile impostare il funzionamento automatico, in modalità riscaldamento e condizionamento, della 
Zona Clima per ogni giorno della settimana procedendo nel seguente modo: 
1. selezionare il pulsante di Modifica; 
2. selezionare il giorno della settimana attraverso gli appositi pulsanti di ricerca; 
3. selezionare l’area con sfondo bianco relativa al Riscaldamento oppure al Condizionamento; 
4. utilizzare le frecce sulla tastiera oppure il mouse per muoversi all’interno dell’area disegnando i vari 

segmenti che simboleggiano l’associazione dei SetPoint alle ore della giornata (i numeri sotto al ri-
quadro identificano le 24 ore); 

5. confermare le modifiche con premendo sul pulsante Salva Modifiche. 

Premendo sul pulsante Copia da ... è possibile inserire nel giorno selezionato la copia della program-
mazione di un altro giorno. 

L’eliminazione di una Zona Clima usata come zona monitor modifica il funzionamento della centrale 
By-Me nella gestione del Clima. È necessario scegliere la nuova zona monitor dai menu della Centrale 
By-Me.

Cartella Clima
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8. Cartella Eventi

Da questa cartella è possibile gestire gli eventi della centrale By-Me; è anche possibile scorrere tra gli eventi 
o fare una ricerca rapida con i pulsanti funzione di navigazione. 

8.1 Parametri
Per ciascun programma sono riportate le seguenti informazioni: 
1. Nome: nome del programma. Formato da un massimo di 16 caratteri, descrive il programma; 
2. Numero: identificativo del programma, deve essere univoco all’interno della centrale By-Me; 
3. Ingressi: massimo di due ingressi che possono essere associati al programma secondo la logica 

definita nella Logica; 
4. Logica: logica con cui vengono gestiti i due ingressi; in particolare se viene selezionato AND devono 

essere verificate entrambe le condizioni in ingresso affinchè la centrale attivi le uscite definite; se 
viene selezionato OR è sufficiente che sia verificata una sola condizione definita negli ingressi. Per 
esempio, se si associano le accensioni di due luci nei due ingressi, selezionando AND dovranno 
essere accese entrambe per attivare le uscite, selezionando OR sarà sufficiente l’accensione di una 
sola delle due luci. 

5. Uscite: due uscite che possono essere associate al programma affinchè siano attivate quando si 
verificano le condizioni degli ingressi; 

6. Temporizzazione: permettono la scelta e la modifica delle impostazioni di una condizione temporale, 
che viene valutata secondo una logica di AND con gli ingressi. Infatti le uscite di un programma ven-
gono attivate se e solo se si avvera la condizione di temporizzazione, quando questa viene seleziona-
ta. Tali condizioni possono essere impostate tramite uno dei seguenti temporizzatori.

Cartella Eventi
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8.2 Operazioni
Mediante la selezione di Impostazioni è possibile specificare i parametri temporali relativi al fun-
zionamento del programma.

8.2.1 Orologio settimanale 

Questa temporizzazione consente di impostare gli intervalli di tempo in cui il programma è attivo 
all’interno del singolo giorno della settimana.

Si accede alla funzionalità dalla cartella Eventi, selezionando la temporizzazione Orologio setti-
manale e premendo sul pulsante Impostazioni. Nella nuova finestra è necessario procedere nel 
seguente modo: 
1. selezionare il giorno della settimana tramite i pulsanti di navigazione della parte superiore della 

finestra;

2. selezionare l’area con sfondo bianco relativa alla programmazione; 

3. utilizzare le frecce sulla tastiera oppure il mouse per muoversi all’interno dell’area disegnando 
i vari segmenti che simboleggiano l’attivazione/disattivazione del programma con intervalli di 
tempo di 10 minuti delle ore della giornata (i numeri sotto al riquadro identificano le 24 ore); 

4. confermare le modifiche premendo sul pulsante OK.

Sulla destra della finestra è presente un riquadro in cui è possibile copiare la programmazione di 
un giorno della settimana su quello corrente, selezionando il giorno desiderato e premendo sul 
pulsante Esegui. 

Cartella Eventi
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8.2.2 Orologio periodico

Questo programma di temporizzazione consente l’impostazione di uno spazio temporale compo-
sto al più da due intervalli distinti all’interno dei quali il programma stesso è attivo, ossia in cui ven-
gono verificate le condizioni impostate nei parametri di input. È necessario definire un programma 
per ogni giorno della settimana.

Si accede a questa funzionalità dalla cartella Eventi, selezionando la temporizzazione Orologio 
periodico e premendo sul pulsante Impostazioni. Nella della nuova finestra è necessario proce-
dere immettendo per ogni giorno l’ora ed i minuti in cui si desidera che la temporizzazione abbia 
inizio e quella in cui abbia fine. Confermare le modifiche premendo sul pulsante Salva.
Si noti che possono essere definiti al massimo due intervalli di tempo per ogni giorno della setti-
mana. 

Cartella Eventi
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8.2.3 Orologio ciclico

Questo programma di temporizzazione consente l’impostazione di due intervalli di tempo, uno per 
la durata di quando il programma è attivo, ossia all’interno del quale sono verificate le condizioni 
impostate nei parametri di input, l’altro per quando lo stesso non è attivo. Le informazioni inserite 
sono applicate a tutti i giorni della settimana.

Si accede a questa funzionalità dalla cartella Eventi, selezionando la temporizzazione Orologio 
ciclico e premendo sul pulsante Impostazioni.
All’interno della nuova finestra si procede definendo l’intervallo, ossia il numero di ore e di minuti, in 
cui si desidera che la temporizzazione sia attiva, e quello in cui sia non attivo.
Confermare le modifiche premendo sul pulsante Salva.

8.2.4 Temporizzatore

Questa temporizzazione consente di impostare la durata del programma ad eventi dal momento 
in cui si attivano gli ingressi.

All’interno della nuova finestra si accede a questa funzionalità dalla cartella Eventi, selezionando la 
temporizzazione Temporizzatore e premendo sul pulsante Impostazioni. Si procede immettendo 
le ore ed i minuti corrispondenti alla durata da impostare.
Confermare le modifiche premendo sul pulsante Salva.

Cartella Eventi
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9. Funzionalità Generali

9.1  Ricerca dei dati

Questa finestra consente di ricercare dei dati appartenenti all’impianto e memorizzati nelle varie cartelle 
dell’applicazione. Si può accedere a questa funzionalità dal punsante funzione Ricerca dati previsto 
nella barra degli strumenti delle cartelle dell’applicazione. 

La finestra prevede la possibilità di specificare dei criteri di filtro indicando, negli appositi campi previsti, 
uno o più valori da ricercare.
Possono essere indicati anche filtri parziali specificando, ad esempio, solo alcuni caratteri iniziali del 
valore da ricercare. 

All’attivazione del pulsante funzione Cerca, la procedura ricerca, tra tutti i dati presenti nella cartella dalla 
quale la finestra è stata attivata, un elemento i cui valori corrispondono a quelli indicati nei campi di filtro, 
e lo visualizza nella cartella stessa.

All’attivazione del pulsante funzione Cerca successivo, viene ricercato se esiste un altro dato, oltre a 
quello precedentemente visualizzato, che soddisfa alle condizioni di filtro impostate: l’eventuale elemen-
to trovato viene riportato nella cartella dalla quale la finestra è stata attivata. 

Funzionalità Generali
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Sezione 2.2
Comunicatori GSM



70



71

Sezione 2.2.1
Impostazioni Generali e Configurazioni

Comunicatori GSM
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1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

3. Descrizione funzionale del software di gestione delle impostazioni del comunica-
tore – lato PC

3.1 Funzionalità
Il software per PC contenuto nel CD, allegato al sistema Comunicatore, permette di: 
• definire i parametri di configurazione del Comunicatore GSM
•	 configurare i dispositivi
•	 eseguire il test del Comunicatore GSM e dei relativi dispositivi
•	 aggiornare il firmware
•	 effettuare il collegamento diretto al Comunicatore GSM per la lettura del flusso di operazioni che sta 

eseguendo

3.2 Procedura di connessione al Comunicatore GSM
1.	Assicurarsi che sia stata effettuata la procedura di avvio del Comunicatore GSM (vedere il manuale delle 

istruzioni del Comunicatore GSM).

2.	Collegare il cavo seriale in dotazione tra il Comunicatore GSM (vedere manuale delle istruzioni del 
Comunicatore GSM) ed il PC.

3.	Avviare il software su PC.
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Connessione

3.3 Procedura di sconnessione dal Comunicatore GSM
1.	Uscire dall’applicativo

2.	Scollegare il cavo seriale tra il Comunicatore GSM ed il PC.

3.	Nel caso in cui il Comunicatore GSM debba essere spento, attendere almeno un minuto dalla chiusura 
dell’applicativo.

Attenzione!
Nel caso in cui non venga rispettata la procedura di sconnessione, gli eventuali dati configurati 
tramite l’applicativo potrebbero risultare danneggiati nel Comunicatore GSM.

3.4 Note generali

3.4.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.
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Le funzionalità

4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

 	 Ricerca un dato tra quelli della cartella

Pulsanti di edit:

 	 Mette in modifica il dato visualizzato

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione scambio dati tra PC e dispositivo:

 	 Importa nella cartella i dati dal Comunicatore GSM collegato al PC

 	 Configura il Comunicatore GSM collegato al PC con i dati presenti nella cartella

Segue il dettaglio delle finestre dell’applicazione e delle operazioni che rendono disponibili.

La sequenza è utile anche come schema per la configurazione di un Comunicatore GSM di un impianto.
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4.1 Parametri di configurazione del Comunicatore. 
Alla configurazione dei parametri del Comunicatore si accede attivando, dalla barra degli strumenti del 
sistema EasyTool, il modulo Parametri di configurazione definito nel sistema GSM-Impostazioni. 

L'aspetto delle cartelle e i relativi parametri impostabili dipendono dal tipo e dalla versione firmware del 
comunicatore GSM selezionato. 

La finestra è suddivisa in tre o quattro cartelle a seconda del modello del dispositivo GSM scelto ( comu-
nicatore 01941 o 01942 oppure cronotermostato 01913).

Parametri di configurazione
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Le cartelle sono le seguenti: 

Generali permette di: 

•	 modificare i moduli GSM
•	 importare la configurazione dei parametri dal Comunicatore GSM collegato al PC
•	 configurare il comunicatore GSM collegato al PC con i parametri definiti in un modulo GSM
•	 ripristinare le impostazioni iniziali del Comunicatore GSM collegato al PC

Rubrica Telefonica permette di:

•	 memorizzare i numeri di telefono per l'invio di SMS e/o di chiamate vocali;
•	 importare i numeri di telefono configurati nel Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i numeri di telefono gestiti nella cartella.

Messaggi Vocali permette di: 

•	 associare i numeri telefonici ai messaggi vocali;
•	 ascoltare i messaggi vocali utente registrati;
•	 registrare nuovi messaggi vocali utente;
•	 importare i messaggi vocali dal Comunicatore GSM collegato al PC;
•	 configurare il Comunicatore GSM collegato al PC con i messaggi vocali gestiti nella cartella.

SMS permette di: 

•	 associare i numeri telefonici ai messaggi SMS; 
•	 modificare il testo dei messaggi SMS liberi gestiti dal Comunicatore GSM; 
•	 importare i messaggi SMS dal Comunicatore GSM collegato al PC; 
•	 configurare il Comunicatore GSM collegato al PC con i messaggi SMS gestiti nella cartella. 

Parametri di configurazione
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Parametri di configurazione

4.1.1 Generali

Comunicatori GSM 01941 e 01942

Questa cartella gestisce la configurazione generale dei moduli GSM definiti in un impianto. 

È possibile inserire nuovi moduli GSM, modificare i parametri e cancellare i moduli GSM già esi-
stenti.
È inoltre possibile scorrere i moduli GSM configurati con i pulsanti funzione di navigazione, o effet-
tuare una ricerca rapida. 
La descrizione del modulo GSM corrente, quello cioè selezionato nella cartella, viene visualizzata 
nel titolo della finestra. 
Nelle cartelle collegate alla presente, sono gestiti ulteriori parametri di configurazione per il modulo 
GSM corrente: i numeri di telefono nella cartella Rubrica Telefonica, i messaggi vocali nella cartella 
Messaggi Vocali ed i messaggi SMS nella cartella SMS. 
Alcuni parametri di configurazione dei moduli GSM dipendono dal tipo del modulo GSM e dalla 
versione firmware dello stesso. Tali parametri saranno correttamente visualizzati, nelle opportune 
cartelle, selezionando correttamente la versione del modulo GSM utilizzata. 
Per ciascun modulo GSM sono gestiti i seguenti parametri di configurazione generale: 

•	 Descrizione: descrizione del Comunicatore GSM; deve essere obbligatoriamente specificata ed 
identifica il modulo GSM nell'impianto.

•	 Codice Utente: password numerica composta da un minimo di 4 cifre ad un massimo di 10 cifre 
numeriche che permette di accedere al Comunicatore GSM collegato al PC.
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Il codice utente di un Comunicatore GSM non è visibile “in chiaro” ed è modificabile solo tramite la 
finestra Visualizza/Modifica Codice Utente attivabile dal pulsante funzione .

All'inserimento di un nuovo modulo GSM (e per ogni modulo GSM) viene proposto il codice utente 
di default 1234; il valore proposto può comunque essere modificato.

Se il codice utente impostato nella cartella attuale non corrisponde a quello configurato nel 
Comunicatore GSM collegato al PC, sarà segnalato il seguente errore durante tutte le operazioni 
che richiedono la lettura o la configurazione dei dati nel Comunicatore GSM.

•	 Versione: seleziona il tipo e la versione software del modulo GSM.

•	 Modalità Tamper: abilita o disabilita la modalità tamper del Comunicatore (solo per 01941) 

•	 Ridirezione SMS non di comando: abilita o disabilita la ridirezione degli sms non di comando 
ad un numero telefonico.

	 Se abilitata, il numero telefonico deve essere associato attivando la finestra Associa Numeri 
Telefonici dall'apposito pulsante funzione . 

•	 Modalità: imposta la modalità Semplice o Avanzata. (solo per 01941)

•	 Indirizzo: testo che viene accodato ai messaggi SMS di allarme, per la personalizzazione degli 
stessi. Ad esempio per aggiungere l'indirizzo dell'utente ai messaggi SMS di allarme. (solo per 
01942) 

•	 Lingua: imposta la lingua utilizzata per i testi degli SMS, di comando, di risposta e di allarme 
(solo per 01942)

All'inserimento di un nuovo modulo GSM (e per ogni modulo GSM), è previsto l’inserimento auto-
matico dei seguenti dati:
•	 8 posizioni nella rubrica telefonica, per ciascuna delle quali è possibile specificare un numero di 

telefono a cui effettuare chiamate vocali e/o inviare messaggi SMS;
•	 6 messaggi vocali di cui 2 non modificabili (Assenza e Ripristino tensione di rete); (solo per 

01941)
•	 9 messaggi SMS di cui 5 non modificabili (Allarme Intrusione, Allarme Tecnico, Allarme Domotico, 

Assenza tensione di rete, Ripristino tensione di rete); (solo per 01941)
•	 2 relè; (solo per 01941)
•	 2 ingressi digitali. (solo per 01941)
•	 2 gruppi di messaggi vocali (ALLARMI INTRUSIONE, ALLARMI TECNICI); (solo per 01942) 
•	 3 gruppi di messaggi SMS (ALLARMI INTRUSIONE, ALLARMI TECNICI, ALLARMI 

ALIMENTAZIONE). (solo per 01942). 
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È possibile importare nel modulo GSM corrente, i parametri di configurazione impostati nel 

Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione  .

Questa funzionalità prevede la sostituzione dei parametri generali del modulo GSM corrente con 
quelli letti dal Comunicatore GSM e, previo richiesta di conferma a procedere, prevede l'importazio-
ne anche dei dati relativi alla rubrica telefonica, ai messaggi vocali e SMS. In particolare, vengono 
sostituiti i parametri gestiti dalla cartella attuale e, su esplicita richiesta, tutti i numeri telefonici e tutti 
i messaggi vocali ed sms associati al modulo GSM.

Con i parametri impostati nel modulo GSM corrente, è possibile configurare il Comunicatore GSM 
collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo dei parametri generali impostati nella cartella corrente e, previo richiesta di conferma a 
procedere, prevede la configurazione del dispositivo anche con i dati relativi alla rubrica telefonica 
e ai messaggi vocali ed sms associati al modulo GSM elaborato. 

Questa cartella gestisce inoltre la possibilità di ripristinare le impostazioni iniziali del Comunicatore 

GSM collegato al PC, tramite l'attivazione del pulsante funzione .

Questa funzionalità ha effetto solo sul Comunicatore GSM, non prevede quindi la modifica dei 
parametri configurati nella cartella attuale ed in quelle collegate. Per visualizzare il risultato di tale 
funzione è necessario importare i dati dal Comunicatore GSM utilizzando il pulsante funzione 
Importa dati.
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Cronotermostato GSM 01913

 

   È possibile modificare i cronotermostati GSM esistenti scorrendo la lista attraverso i pulsanti 
funzione di navigazione, o effettuando una ricerca rapida. Tramite la funzione Importa dati sono 
caricati tutti i dati presenti nel cronotemostato connesso al PC mentre con Configura, tutti i dati 
presenti nella finestra vengono scaricati al cronotemostato connesso al PC. 

    Sempre nella cartella Generali è presente la funzione Ripristina default, utilizzata per ripristinare 
le condizioni di partenza. 

   Per ciascun cronotermostato GSM sono gestiti i seguenti parametri di configurazione general 
tramite la funzione modifica: 

    •	 Descrizione: descrizione del cronotemostato GSM. 

    •	 Codice Utente: password numerica composta da un minimo di 4 cifre. 

    •	 Versione: selezione del tipo e la versione software del cronotermostato GSM. 

    •	 Indirizzo: stringa per l'identificazione del messaggio d'allarme. 

    •	 Lingua: selezione della lingua dei menù. 

    •	 Ridirezione SMS non di comando: abilitazione della ridirezione dell’SMS d'allarme. 

    •	 Allarme assenza/ripristino: SMS d'allarme in mancanza della tensione di rete. 

Parametri di configurazione
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4.1.2 Rubrica telefonica

Questa cartella contiene i numeri di telefono configurati per il modulo GSM selezionato nella cartella 
Generali, a cui effettuare chiamate vocali e/o inviare messaggi SMS.

Ogni modulo GSM può gestire fino ad un massimo di 8 numeri di telefono. 
Per ciascuna delle 8 posizioni previste nella rubrica telefonica è possibile modificare la descrizione 
e inserire/modificare il corrispondente numero di telefono. 

Per ciascuna posizione della rubrica sono gestite le seguenti informazioni: 

• 	Descrizione: descrizione del numero di telefono; deve essere obbligatoriamente specificata. 

• 	Numero telefonico: numero di telefono a cui effettuare chiamate vocali e/o inviare messaggi 
SMS. 

È possibile importare tutti i numeri di telefono impostati nel Comunicatore GSM collegato al PC tra-
mite l'attivazione del pulsante funzione . Questa funzionalità prevede la sostituzione dei numeri 
di telefono della cartella corrente con quelli letti dal Comunicatore GSM. 

I numeri di telefono impostati nella cartella corrente, possono essere configurati nel Comunicatore 

GSM collegato al PC. Questa funzionalità è disponibile attivando il pulsante funzione  e prevede 
il trasferimento da PC a dispositivo di tutti i numeri telefonici visualizzati nella cartella corrente. 
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4.1.3 Messaggi vocali

Questa cartella contiene i messaggi vocali configurati per il modulo GSM selezionato nella cartella 
Generali.
L'aspetto della cartella ed i dati impostabili dalla stessa dipendono dal tipo di Comunicatore GSM 
selezionato nella cartella Generali durante la fase di creazione del modulo GSM.

Comunicatore 01941

Parametri di configurazione

Ogni modulo GSM gestisce 6 messaggi vocali: 4 messaggi sono modificabili mentre 2 sono pre-
definiti dal sistema e non sono modificabili. I messaggi predefiniti dal sistema sono quelli relativi 
all'Assenza ed al Ripristino della tensione di rete.

A ciascun messaggio vocale configurato possono essere associati uno o più numeri telefonici.

La cartella prevede la possibilità di scorrere i messaggi vocali configurati con i pulsanti funzione di 
navigazione, di effettuare modifiche o di effettuare una ricerca rapida. 

Per ciascun messaggio vocale sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del messaggio vocale; non è una campo modificabile. 
•	 Messaggio vocale utente: percorso del file contenente la registrazione del messaggio vocale 

utente. 

Questa informazione è gestita per i soli 4 messaggi modificabili (MSG 1, MSG 2, MSG 3, MSG 4).
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Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite l'apposito 
pulsante funzione . 

Non è obbligatorio specificare un messaggio vocale utente: se non indicato, in fase di configurazio-
ne, verrà impostato il messaggio vocale di default.

Non è prevista la possibilità di ascoltare la registrazione dei messaggi vocali di default.

•	 Numeri telefonici associati: lista dei numeri di telefono gestiti nella rubrica telefonica (cartella 
Rubrica Telefonica); ciascun numero può essere associato o meno al messaggio vocale cor-
rente.

	 Le modifiche effettuate sull'associazione dei numeri telefonici per uno dei due messaggi pre-
definiti di Assenza e Ripristino tensione di rete, verranno applicate in automatico anche all'altro 
messaggio predefinito, previo visualizzazione di un'apposita segnalazione di avviso.

Per ciascuno dei 4 messaggi vocali modificabili, è prevista la possibilità di ascoltare il messaggio 
utente registrato nel file vocale. A questa funzionalità si accede dal pulsante funzione  tramite il 
quale viene attivata la finestra Registrazione Messaggi. 

È inoltre prevista la possibilità di registrare un messaggio utente diverso da quello indicato. Questa 
operazione è gestita dalla stessa finestra Registrazione Messaggi attivata dal pulsante funzione 

. 

È possibile importare le informazioni relative al messaggio vocale corrente dal Comunicatore GSM 
collegato al PC tramite l'attivazione del pulsante funzione  . Questa funzionalità prevede la sosti-
tuzione dei dati del messaggio vocale con quelli letti dal Comunicatore GSM. 

Il messaggio vocale definito nella cartella corrente, può essere configurato nel Comunicatore GSM 
collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative al messaggio vocale visualizzato nella cartella corrente. Se 
indicato un messaggio vocale utente, questo sostituirà nel comunicatore quello di default mentre, 
nel caso in cui non sia specificato alcun messaggio, verrà configurato il messaggio predefinito di 
default.
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Comunicatore 01942

Parametri di configurazione

Ogni modulo GSM 01942 gestisce 2 gruppi di messaggi vocali: il gruppo dei messaggi vocali degli 
ALLARMI ANTINTRUSIONE ed il gruppo dei messaggi vocali degli ALLARMI TECNICI. 

A ciascun gruppo di messaggi vocali può essere associato uno o più numeri telefonici. 

La cartella prevede la possibilità di scorrere i gruppi di messaggi vocali configurati con i pulsanti 
funzione di navigazione, di effettuare modifiche o di effettuare una ricerca rapida. 

Per ciascun gruppo di messaggi vocali sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del gruppo di messaggi vocali; non è un campo modificabile. 

•	 Numeri telefonici associati: lista dei numeri di telefono gestiti nella rubrica telefonica (cartella 
Rubrica Telefonica); ciascun numero può essere associato o meno al gruppo di messaggi 
vocali corrente. 

È possibile importare le informazioni relative al gruppo di messaggi vocali corrente dal 
Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione Importa dati. 
Questa funzionalità prevede la sostituzione dei dati del gruppo di messaggi vocali con quelli letti 
dal Comunicatore GSM. 

Il gruppo di messaggi vocali definito nella cartella corrente, può essere configurato nel 
Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione Configura e prevede il trasferimento 
da PC al Comunicatore GSM delle informazioni relative al gruppo di messaggi vocali visualizzato 
nella cartella corrente.
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I singoli messaggi vocali di allarme possono essere modificati, registrati ed ascoltati dalla cartella 
Impostazione Voci 01942.

L'impostazione della lingua dei messaggi vocali di allarme del Comunicatore 01942 deve essere 
impostata dalla cartella  Impostazione Voci 01942.

4.1.4 SMS

Questa cartella contiene i messaggi SMS configurati per il modulo GSM selezionato nella cartella 
Generali.
L'aspetto della cartella ed i dati impostabili dalla stessa dipendono dal tipo di Comunicatore GSM 
selezionato.

Comunicatore 01941
 

Ogni modulo GSM gestisce 9 messaggi SMS: 4 messaggi sono modificabili nel testo mentre 5 sono 
predefiniti dal sistema e non sono modificabili. I messaggi predefiniti dal sistema sono i seguenti: 
Allarme Intrusione, Allarme Tecnico, Allarme Domotico, Assenza e Ripristino tensione di rete.
A ciascun messaggio SMS configurato possono essere associati uno o più numeri telefonici. 
La cartella prevede la possibilità di scorrere i messaggi SMS configurati con i pulsanti funzione di 
navigazione, di effettuare modifiche o di effettuare una ricerca rapida. 

Per ciascun messaggio SMS sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del messaggio SMS; non è modificabile. 

•	 Testo: testo del messaggio SMS; è modificabile solo per i soli primi 4 messaggi (SMS 1, SMS 2, 
SMS 3, SMS 4). 
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•	 Numeri telefonici associati: lista dei numeri di telefono gestiti nella rubrica telefonica (cartella 
Rubrica Telefonica); ciascun numero può essere associato o meno al messaggio SMS corren-
te.

	 Le modifiche effettuate sull'associazione dei numeri telefonici per uno dei due messaggi pre-
definiti di Assenza e Ripristino tensione di rete, verranno applicate in automatico anche all'altro 
messaggio predefinito, previo visualizzazione di un'apposita segnalazione di avviso. 

Queste modifiche verranno applicate anche al sistema ClimaRadio (messaggi Batterie cronotermo-
stato in esaurimento e Batterie base radio in esaurimento) nel caso in cui il modulo GSM per il quale 
si stanno configurando i messaggi SMS è indicato come punto di accesso di un sistema radio.

	 È possibile importare le informazioni relative al messaggio SMS corrente dal Comunicatore GSM 

collegato al PC tramite l'attivazione del pulsante funzione . Questa funzionalità prevede la sosti-
tuzione dei dati del messaggio SMS con quelli letti dal Comunicatore GSM. 

	 Il messaggio SMS definito nella cartella corrente, può essere configurato nel Comunicatore GSM 
collegato al PC.

	 Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative al messaggio SMS visualizzato nella cartella corrente. 

	 Per i soli 4 messaggi modificabili, è prevista la possibilità di ripristinare, nel Comunicatore GSM 
collegato al PC, il testo di default di ciascun messaggio. Questa funzionalità è attivabile dal pulsante 
funzione , che prevede la configurazione del dispositivo con il testo di default del messaggio 
SMS visualizzato nella cartella corrente, e la successiva visualizzazione del testo configurato nella 
cartella stessa.
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Comunicatore 01942
 

Ogni modulo GSM 01942 gestisce 3 gruppi di messaggi SMS: il gruppo degli SMS degli ALLARMI 
ANTINTRUSIONE, il gruppo degli SMS degli ALLARMI TECNICI e il gruppo degli SMS degli 
ALLARMI ALIMENTAZIONE. 
A ciascun gruppo di messaggi SMS configurato possono essere associati uno o più numeri tele-
fonici. 

La cartella prevede la possibilità di scorrere i gruppi di messaggi SMS configurati con i pulsanti 
funzione di navigazione, di effettuare modifiche o di effettuare una ricerca rapida. 
Per ciascun gruppo di messaggi SMS sono gestite le seguenti informazioni: 
•	 Descrizione: descrizione del gruppo di messaggi SMS; non è modificabile. 
•	 Numeri telefonici associati: lista dei numeri di telefono gestiti nella rubrica telefonica (cartella 

Rubrica Telefonica); ciascun numero può essere associato o meno al gruppo di messaggi SMS 
corrente. 

È possibile importare le informazioni relative al gruppo di messaggi SMS corrente dal Comunicatore 

GSM collegato al PC tramite l'attivazione del pulsante funzione . 
Questa funzionalità prevede la sostituzione dei dati del messaggio SMS con quelli letti dal 
Comunicatore GSM. 
Il gruppo di messaggi SMS definito nella cartella corrente, può essere configurato nel Comunicatore 
GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da 
PC a dispositivo delle informazioni relative al gruppo di messaggi SMS visualizzato nella cartella 
corrente. 
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Cronotermostato GSM 01913

Ogni cronotermostato GSM 01913 gestisce 4 messaggi SMS:

•  allarme temperatura soglia superiore: messaggio per superamento temperatura TSUP. 

•  allarme temperatura soglia inferiore: messaggio per superamento temperatura TINF. 

•  assenza/ripristino tensione: messaggio per assenza tensione e successivo ripristino. 

•  allarme: messaggio per attivazione ingresso I1. 

In Descrizione è disponibile una breve spiegazione del contenuto dell'SMS; in Anteprima SMS è 
visualizzato il messaggio che verrà inviato dal comunicatore. 
Nella lista Numeri Telefonici Associati è possibile, tramite la funzione modifica, associare il mes-
saggio SMS ai numeri di telefono precedentemente inseriti. 

Il testo dei messaggi SMS di allarme può essere personalizzato impostando il testo Indirizzo, pre-
sente nella cartella Generali. Tale testo verrà aggiunto al testo predefinito di allarme. 

I testo degli SMS degli Allarmi Tecnici può essere ulteriormente personalizzato impostando il testo 
Descrizione Allarme Tecnico Utente nella cartella Allarmi Tecnici del modulo Automazione 
Domestica o nella cartella Allarmi Tecnici del modulo Antintrusione.
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4.1.5 Visualizza/Modifica codice utente

Questa finestra consente di visualizzare e modificare il codice utente impostato per l'accesso al 
Comunicatore GSM collegato al PC. 
Si può accedere a questa funzionalità dalla cartella Generali della finestra Parametri di 
Configurazione tramite il pulsante funzione .

Per poter visualizzare in chiaro il codice utente deve essere inserita, nel campo Password, 
la password di accesso dell'utente all'applicazione e deve essere attivato il pulsante funzione 

; se la password inserita risulta corretta, verrà visualizzato il codice utente nel rispet-
tivo campo della finestra.

Una volta visualizzato in chiaro il codice utente, questo può essere modificato tramite l'attivazione 

del pulsante funzione .
Il codice utente inserito deve essere numerico e deve essere composto da un minimo di 4 cifre ad 
un massimo di 10 cifre.

Ad esempio, selezionando la casella corrispondente ad un numero telefonico, è possibile collegare 
tale numero all'SMS selezionato. Si conferma attivando la funzione Configura, che scarica tutti i 
numeri telefonici e gli allarmi associati ad essi nel cronotermostato GSM connesso al PC. 
Infine la funzione Importa dati consente di caricare nella finestra tutti i numeri telefonici associati ai 
4 SMS d'allarme dal cronotermostato connesso al pc tramite l'interfaccia 01998.S.
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Il nuovo codice utente deve essere confermato tramite il pulsante funzione  che prevede 
anche la possibilità di configurare direttamente il nuovo codice nel Comunicatore GSM collegato al 
PC, previo richiesta di conferma a procedere.

Per poter effettuare la configurazione del nuovo codice utente nel Comunicatore GSM, la procedura 
richiede l’inserimento del codice attualmente impostato nel Comunicatore stesso.  

Parametri di configurazione
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4.2 Dispositivi del Comunicatore 
Alla configurazione dei dispositivi di ciascun modulo GSM definito nell’impianto, si accede attivando, 
dalla barra degli strumenti del sistema EasyTool, il modulo Dispositivi definito nel sistema GSM-
Impostazioni. 

Dispositivi del Comunicatore
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La finestra è divisa nelle seguenti cartelle:  

Modulo Gsm permette di:
•	 scegliere il modulo GSM da configurare;
•	 copiare i dispositivi da un modulo GSM già configurato;
•	 importare la configurazione dei dispositivi dal Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i dispositivi definiti in un modulo GSM.

Dispositivi (solo per Comunicatore GSM 01941) permette di: 

•	 modificare i parametri dei relè e degli ingressi digitali associati a ciascun modulo GSM;
•	 importare la configurazione dei relè e degli ingressi digitali dal Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i parametri dei relè e degli ingressi digitali impo-

stati nella cartella attuale.

Dispositivi del Comunicatore

Dispositivi (solo per Cronotermostato GSM 01913) permette di: 

•   modificare i parametri dell'ingresso e dell'uscita digitale, le soglie d'allarme di temperatura, il programma 
settimanale di riscaldamento-condizionamento, associati a ciascun cronotermostato;

•	 importare lo stato dell'ingresso e dell'uscita digitale, il valore settato delle soglie d'allarme di 
temperatura,il programma settimanale di riscaldamento-condizionamento dal cronotemostato collega-
to all'interfaccia 01998.S; 

•	 scaricare nel cronotemostato collegato all'interfaccia 01998.S i parametri dell'ingresso e dell'uscita 
digitale, il valore delle soglie d'allarme di temperatura, il programma settimanale di riscaldamento-
condizionamento.
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4.2.1 Modulo Gsm

Questa cartella consente di selezionare, tra tutti i moduli GSM definiti nell'impianto, quello per il 
quale deve essere gestita la configurazione dei dispositivi. 

È possibile scorrere i moduli GSM configurati con i pulsanti funzione di navigazione, o effettuare 
una ricerca rapida. 
Per il modulo GSM selezionato, viene visualizzata nel dettaglio la configurazione dei dispositivi 
nell'apposita cartella Dispositivi. 

La cartella gestisce la possibilità di copiare, nel modulo GSM selezionato, la configurazione dei 
dispositivi di un altro modulo GSM definito in un impianto dell'applicazione. A questa funzionalità si 

accede dal pulsante funzione  tramite il quale viene attivata la finestra Copia Dispositivi. 
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È possibile importare nel modulo GSM selezionato, la configurazione dei dispositivi impostata nel 

Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione .

Questa funzionalità prevede la sostituzione dei dispositivi del modulo GSM selezionato con quelli 
letti dal Comunicatore GSM. In particolare, vengono sostituiti i relè e gli ingressi digitali associati al 
modulo GSM.

Con la configurazione dei dispositivi associati al modulo GSM selezionato, è possibile configurare 
il Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo dei dati relativi ai relè ed agli ingressi digitali associati al modulo GSM selezionato. 

Dispositivi del Comunicatore
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4.2.2 Dispositivi

Questa cartella, disponibile solo per il Comunicatore GSM 01941 e il cronotermostato GSM 01913, 
contiene i dati di tutti i dispositivi configurati per il modulo GSM selezionato nella cartella Modulo 
Gsm.
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La cartella è divisa in due sezioni: 
1. Relè 
2. Ingressi Digitali 

Le due sezioni sono indipendenti: ciascuna presenta una propria barra degli strumenti che gestisce 
i soli dati della sezione di appartenenza.
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Relè 
Questa sezione contiene i dati dei relè configurati per il moduli GSM 01941 e GSM 01913, selezio-
nati nella cartella Modulo Gsm.
Ogni modulo GSM 01941 può gestire fino ad un massimo di 2 relè; ogni modulo GSM 01913 ne 
può gestire solamente uno.

La sezione gestisce la modifica dei parametri dei relè e prevede la possibilità di scorrere i relè con-
figurati con i pulsanti funzione di navigazione, o di effettuare una ricerca rapida. 

Per ciascun relè sono gestite le seguenti informazioni: 

• Descrizione Relè: descrizione del relè; deve essere obbligatoriamente indicata.

• Etichetta vocale (solo per il 01941): percorso del file contenente la registrazione del messag-
gio vocale utente associato al relè. Il percorso del file può essere indicato attivando la finestra 

Associa File Vocale tramite l'apposito pulsante funzione  previsto nella sezione.
	 Se non viene indicato il nome di un file, si assume che al relè sia associata l'etichetta vocale 

predefinita.

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; se non specificata, si assume che al 
relè sia associata l’etichetta SMS predefinita. 

•	 Comando (solo 01941): indica se il dispositivo deve essere utilizzato nel sistema installato (abi-
lita comando) o meno (disabilita comando). 

•	 Modalità: indica la modalità Monostabile o Bistabile. 

•	 Tempo di Attivazione: se selezionata la modalità Monostabile, deve essere specificato il tempo 
di attivazione del relè; la procedura prevede la proposta automatica di un tempo pari a 2 secondi, 
che può comunque essere modificato. 

	 Il tempo di attivazione deve essere compreso tra 1 e 3600 secondi. 
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Per ciascun relè configurato in in modulo GSM 01941, è prevista la possibilità di ascoltare il mes-
saggio utente registrato nel file vocale. A questa funzionalità si accede dal pulsante funzione  
tramite il quale viene attivata la finestra Registrazione Messaggi. 

È inoltre prevista la possibilità di registrare un messaggio diverso da quello predefinito. Questa 
operazione è gestita dalla finestra Registrazione Messaggi attivata dal pulsante funzione . 

È possibile importare le informazioni relative al relè visualizzato nella sezione corrente dal 

Comunicatore GSM collegato al PC, tramite l'attivazione del pulsante funzione . Questa funzio-
nalità prevede la sostituzione dei dati del relè con quelli letti dal Comunicatore GSM. 
Se viene letto dal Comunicatore un messaggio vocale utente, questo verrà memorizzato in un file 
vocale il cui nome sarà visualizzato nell'apposito campo della cartella al fine di consentirne l'ascolto. 
Se invece al relè risulta associato il messaggio vocale predefinito, non sarà visualizzato il nome del 
file vocale e, di conseguenza, non è prevista la possibilità di ascoltarne la registrazione. 

Le impostazioni del relè visualizzato nella sezione corrente, possono essere configurate nel 
Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative al relè visualizzato nella sezione corrente. 
Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore, il messaggio predefinito; se invece non è stato indicato alcun file vocale, 
nel Comunicatore verrà ripristinata l’etichetta vocale predefinita.

Ingressi digitali. 
Questa sezione contiene i dati degli ingressi digitali configurati per il moduli GSM 01941 e 01913 
selezionati nella cartella Modulo Gsm.
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Ogni modulo GSM 01941 gestisce fino ad un massimo di 2 ingressi digitali mentre ogni modulo 
GSM 01913 ne può gestire soltanto uno.
La sezione che gestisce la modifica dei parametri degli ingressi digitali associati a ciascun modulo 
GSM 01941, prevede la possibilità di scorrere gli ingressi digitali configurati con i pulsanti funzione 
di navigazione, o di effettuare una ricerca rapida. 

Per ciascun ingresso digitale sono gestite le seguenti informazioni:  

•	 Descrizione Ingresso Digitale: descrizione dell'ingresso digitale; deve essere obbligatoriamen-
te indicata. 

•	 Etichetta vocale (solo per 01941): percorso del file contenente la registrazione del messaggio 
vocale utente associato all’ingresso digitale.

	 Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite l'apposito 
pulsante funzione  previsto nella sezione. 

	 Se non viene indicato il nome di un file, si assume che all’ingresso digitale sia associata l'etichetta 
vocale predefinita.

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; se non specificata, si assume che 
all’ingresso digitale sia associata l’etichetta SMS predefinita.

•	 Tempo di attivazione: tempo di attivazione dell'ingresso; in fase di inserimento di un ingresso 
digitale, la procedura prevede la proposta automatica di un tempo pari a 1 secondo, che può 
comunque essere modificato. 

	 Il tempo di attivazione deve essere compreso tra 1 e 600 secondi. 

•	 Tempo di disattivazione (solo per 01941): tempo di disattivazione dell'ingresso; in fase di 
inserimento di un ingresso digitale, la procedura prevede la proposta automatica di un tempo 
pari a 1 secondo, che può comunque essere modificato. 

	 Il tempo di disattivazione deve essere compreso tra 1 e 600 secondi. 

•	 Comando (solo per 01941) : indica se il dispositivo deve essere utilizzato nel sistema installato 
(abilita comando) o meno (disabilita comando). 

•	 Allarme (solo per 01941): indica se inviare la notifica di allarme quando il canale di ingresso 
digitale risulta aperto o chiuso. 

•	 Allarme Vocale (solo per 01941): permette di associare al dispositivo uno dei 4 messag-
gi vocali modificabili configurati nella cartella Messaggi Vocali della finestra Parametri di 
Configurazione.

	 Nel caso in cui venga indicato un messaggio vocale, è prevista la possibilità di visualizzare i 
numeri di telefono associati all'allarme configurato, tramite l'attivazione del pulsante funzione  
posto a fianco dell'allarme stesso. 

•	 Allarme SMS (solo per 01941): permette di associare al dispositivo uno dei 7 messaggi SMS 
configurati nella cartella SMS della finestra Parametri di Configurazione. Il messaggio deve 
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essere uno dei 4 messaggi modificabili oppure uno dei 3 messaggi predefiniti (Allarme Intrusione, 
Allarme Tecnico, Allarme Domotico).

	 Nel caso in cui venga indicato un messaggio SMS, è prevista la possibilità di visualizzare i numeri 
di telefono associati all'allarme configurato, tramite l'attivazione del pulsante funzione  posto 
a fianco dell'allarme stesso

Per ciascun ingresso digitale configurato in un modolo GSM 01941, è prevista la possibilità di 
ascoltare il messaggio utente registrato nel file vocale. A questa funzionalità si accede dal pulsante 
funzione  tramite il quale viene attivata la finestra Registrazione Messaggi. 

È inoltre prevista la possibilità di registrare un messaggio diverso da quello predefinito. Questa 
operazione è gestita dalla stessa finestra Registrazione Messaggi che viene attivata dal pulsante 
funzione . 

È possibile importare le informazioni relative all'ingresso digitale visualizzato nella sezione corrente 

dal Comunicatore GSM collegato al PC, tramite l'attivazione del pulsante funzione . Questa 
funzionalità prevede la sostituzione dei dati dell'ingresso con quelli letti dal Comunicatore GSM. 
Se viene letto dal Comunicatore un messaggio vocale utente, questo verrà memorizzato in un 
file vocale il cui nome sarà visualizzato nell'apposito campo della sezione al fine di consentirne 
l'ascolto. Se invece all’ingresso digitale risulta associato il messaggio vocale predefinito, non sarà 
visualizzato il nome del file vocale e, di conseguenza, non è prevista la possibilità di ascoltarne la 
registrazione.

Le impostazioni dell'ingresso digitale visualizzato nella sezione corrente, possono essere configurate 
nel Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative all'ingresso visualizzato nella sezione corrente. 

Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore, il messaggio predefinito; se invece non è stato indicato alcun file vocale, 
nel Comunicatore verrà ripristinata l’etichetta vocale predefinita. 
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Clima (solo per il cronotermostato GSM 01913). 
Questa sezione consente di impostare la Descrizione del cronotermostato selezionato nella car-
tella Modulo Gsm, definire l'Etichetta dell'SMS e settare le soglie Superiore ed Inferiore degli 
allarmi.

•	 La Descrizione inizialmente è del tipo “Cronotermostato1” e può essere modificata attraverso i 

seguenti pulsanti         ,        e        . 

    Attivando modifica, primo pulsante a sinistra, si può editare la desrizione, che deve essere con-
fermata tramite il secondo pulsante, mentre con il terzo si annulla l'operazione. 

•  L'Etichetta SMS Predefinita indica l'etichetta di default del Cronotermostato. L'Etichetta SMS 
Utente offre la possibilità di associare all' SMS una stringa personalizzata di massimo 20 carat-
teri. Tali etichette sono poi visualizzate nei messaggi SMS inviati dal Cronotermostato.

•  Gli Allarmi temperatura sono suddivisi in allarme Soglia superiore ed allarme Soglia inferiore. 
Per attivare le soglie è necessario selezionare la casella Abilita ed impostare la temperatura nella 
casella a fianco. Il Differenziale Termico regola la tolleranza d'intervento per la soglia superiore. 
Al superamento delle soglie il Cronotermostato invia, se impostato, un SMS di allarme.
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Per rendere effettive le impostazioni sul Cronotermostato, è necessario attivare la funzione 

Configura (pulsante ) dopo aver salvato le modifiche ed aver connesso il Cronotermostato al 

PC tramite l'interfaccia 01998.S. 

Infine, il pulsante , consente di caricare nella finestra i valori presenti all'interno del 

Cronotermostato collegato all'interfaccia 01998.S. 

Programma (solo per il cronotermostato GSM 01913). 
Questa sezione permette di creare e visualizzare la programmazione settimanale del cronotermo-
stato GSM 01913 selezionato in Modulo Gsm.
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   Per apportare delle modifiche è necessario attivare la funzione Modifica (pulsante  ) e confer-

mare tramite il pulsante  . 

   Il pulsante  consente l'interruzione della programmazione settimanale e il ripristino dei valori 

precedentemente salvati.

   La selezione della giornata è realizzata dai pulsanti          e        dal Lunedì alla Domenica. La   
giornata del programma settimanale del riscaldamento coincide con quello del condizionamento. 
La programmazione viene visualizzata graficamente attraverso un istogramma; i rettangoli corri-
spondono ai valori della temperatura nel tempo, la cui unità di misura è di 15 minuti.

   Il programma del riscaldamento è composto dalla temperatura Antigelo T0 , Temperatura T1, 
Temperatura T2 e Temperatura T3. Tramite il mouse, o la tastiera, si seleziona l'altezza dell'isto-
gramma in corripondenza alle temperature T1-T2-T3. Il valore delle quattro temperature è impo-
stabile in Comanda dispositivo.

Il programma del condizionamento è composto dalla Temperatura T1, Temperatura T2 e 
Temperatura T3. Tramite il mouse o la tastiera, si seleziona l'altezza dell'istogramma in corri-
pondenza alle temperature T1-T2-T3 . Il valore delle tre temperature è impostabile in Comanda 
dispositivo.

La programmazione diventa effettiva selezionando il pulsante  che scarica il programma nel 
Cronotermostato connesso attraverso l'interfaccia 01998.S. La funzione Importa dati consente la 
lettura e la visualizzazione del Cronotermostato programmato e connesso. 
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4.2.3 Copia dispositivi

Per il modulo GSM selezionato nella cartella Modulo Gsm della finestra Dispositivi del 
Comunicatore, è possibile importare i dispositivi configurati per un altro modulo GSM esistente in 
un impianto dell'applicazione. 
Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Modulo 
Gsm. 

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati e, dalla lista Comunicatori Gsm, il modulo GSM al quale sono associati i 
dispositivi da duplicare nel comunicatore corrente. 

All’attivazione del pulsante funzione , i dispositivi configurati per il Comunicatore GSM 
selezionato nella finestra, sostituiranno i relè e gli ingressi digitali del modulo GSM corrente. 
È prevista la possibilità di effettuare l'operazione di copia anche da un Comunicatore GSM esistente 
nello stesso impianto elaborato: verranno in questo caso visualizzati, nell'apposita lista, tutti i moduli 
GSM dell'impianto ad esclusione di quello corrente.

Dispositivi del Comunicatore
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4.3 Test. 
È prevista la possibilità di eseguire il test dei Comunicatori GSM definiti nell'impianto, attivando, dalla barra 
degli strumenti del sistema EasyTool, il modulo Test definito nel sistema GSM-Impostazioni. 
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Le finestre sono divise nelle seguenti cartelle: 

Modulo Gsm permette di: 

•	 scegliere il modulo GSM per il quale eseguire il test;
•	 verificare lo stato del Comunicatore GSM collegato al PC.

Dispositivi (solo per Comunicatore GSM 01941 e Cronotermostato GSM 01913) permette di: 

•	 verificare lo stato dei relè e gli ingressi digitali associati ad un modulo GSM;
• 	abilitare/disabilitare il comando dei relè.

Clima (solo per Cronotermostato GSM 01913) permette di: 

•	 verificare lo stato del cronotermostato;
• 	inviare comandi al cronotermostato.
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4.3.1 Modulo Gsm

Questa cartella consente di selezionare, tra tutti i moduli GSM definiti nell'impianto, quello per il 
quale deve essere eseguito il test. 

È possibile scorrere i moduli GSM configurati con i pulsanti funzione di navigazione, o effettuare 
una ricerca rapida. 
Per il modulo GSM selezionato, vengono visualizzati tutti i dispositivi configurati nell'apposita cartella 
Dispositivi. 

La cartella gestisce la possibilità di visualizzare lo stato del Comunicatore GSM collegato al PC. 
A questa funzionalità si accede dal pulsante funzione  tramite il quale viene attivata la finestra 
Stato Comunicatore Gsm.
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4.3.2 Dispositivi

Questa cartella visualizza i dispositivi configurati per il modulo GSM 01941 selezionato nella cartella 
Modulo Gsm.  

La cartella è divisa in due sezioni: 
1. Relè 
2. Ingressi Digitali 

Le due sezioni sono indipendenti: ciascuna presenta una propria barra degli strumenti che gestisce 
i soli dati della sezione di appartenenza. 

Per ciascuno dei relè e degli ingressi digitali configurati, vengono visualizzate le informazioni relative 
al numero del dispositivo, alla descrizione, all’etichetta vocale, all’etichetta SMS predefinita ed 
utente ed allo stato ON/OFF del dispositivo. 
Lo stato del dispositivo viene visualizzato in automatico dalla procedura leggendo l'informazione dal 
Comunicatore GSM collegato al PC, ed aggiornandola ad intervalli regolari di tempo.

L'intervallo di tempo con il quale viene effettuato l'aggiornamento, è definito nel sistema EasyTool 
dalla funzione attivabile dal menu Utility ► Tempo Refresh.

Lo stato di ciascun dispositivo può essere anche aggiornato tramite la funzionalità prevista dal 
pulsante funzione  presente nella barra degli strumenti delle due sezioni. 
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4.3.3 Stato Comunicatore Gsm.

È possibile visualizzare lo stato del Comunicatore GSM collegato al PC, tramite la funzionali-
tà prevista dal pulsante funzione  presente nella cartella Modulo Gsm della finestra Test 
Comunicatore. 

All’attivazione della finestra, vengono visualizzate le informazioni lette dal Comunicatore GSM col-
legato al PC, e di seguito elencate: 

• Stato del Comunicatore GSM (ATTIVO/DISATTIVO)
• Versione del firmware del Comunicatore GSM.

La sezione relativa ai relè, gestisce la possibilità di modificare, nel Comunicatore GSM collegato 
al PC, lo stato ON/OFF del relè selezionato, attivando la finestra Comanda Dispositivo tramite il 
pulsante funzione  oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga 
del relè da configurare.
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4.3.4 Comanda dispositivo.

È possibile configurare, nel Comunicatore GSM 01941 collegato al PC, lo stato del comando del 
relè selezionato nella sezione Relè della cartella Dispositivi. 

Si può accedere a questa funzionalità dalla sezione sopra citata della finestra Test tramite il pulsante 
funzione   oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga del relè 
da configurare. 

All'attivazione del pulsante funzione , la procedura configura il Comunicatore GSM 
01941 collegato al PC con lo stato ON/OFF indicato nella finestra. 

Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio 
di avviso.



113

Test

4.3.5 Clima (solo per cronotermostato GSM 01913) 

Questa cartella permette di verificare il funzionamento del cronotermostato attraverso i pulsanti    

(Stato dispositivo)  e          (Comanda dispositivo).

Nella finestra è possibile visualizzare la descrizione del dispositivo, l'etichetta SMS predefinita e 
l'etichetta SMS utente.

•  La Descrizione permette di scegliere il cronotermostato in cui effettuare il test funzionale. Tale 
descrizione può essere modificata nella cartella Generali all'interno della sezione Parametri di 
Configurazione. 

•   L'Etichetta SMS predefinita indica il nome di default assegnato al cronotemostato nei messag-
gi SMS. L'Etichetta SMS Utente consente di personalizzare la descrizione del cronotermostato,  
ed è modificabile nella cartella Clima della sezione Dispositivi. 

    Attraverso i pulsanti ,  e  viene efettuata la selezione del cronotermostato desiderato 

tra quelli disponibili nella lista. 
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La funzione Stato Dispositivo, pulsante , attiva la finestra di Stato Cronotermostato 
all'interno della quale è possibile verificare il reale funzionamento del cronotermostato con-
nesso all'interfaccia 01998.S. Attraverso la funzione Leggi viene attivata la funzione di lettura 
del crononotermostato; in particolare viene letta la Temperatura misurata, la Temperatura 
impostata, le Ore di funzionamento e la Modalità funzionamento (Automatico, Manuale, 
ecc.). 

La funzione Comanda  Dispositivo, pulsante   , attiva la  finestra di Stato Cronotermostato 
con un'ulteriore funzione denominata Invia; quest'ultima, permette di scaricare nel cronoter-
mostato connesso all'interfaccia 01998.S la modalità di funzionamento desiderata. 
Le modalità di funzionamento disponibili, sia in Riscaldamento che in Condizionamento,  
sono le seguenti:
• Spento;
• Spento a tempo;
• Manuale
• Manuale a tempo;
• Automatico.

Per quanto riguarda il modo di funzionamento Antigelo, è possibile impostare direttamente 
la temperatura (funzionamento continuo di antigelo) oppure settare la Temperatura antigelo 
per il funzionamento Automatico.
Per la programmazione settimanale è possibile impostare i valori di temperatura T1-T2-T3 ed 
infine è possibile settare il valore della temperatura in funzionamento Manuale.  

Test
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4.4 Manutenzione 
Alla finestra che gestisce le operazioni di manutenzione nel Comunicatore GSM collegato al PC, si acce-
de selezionando, dalla barra degli strumenti del sistema EasyTool, il modulo Manutenzione definito nel 
sistema GSM-Impostazioni. 
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La finestra è divisa in quattro cartelle: 

Monitor permette di: 

•		 effettuare il collegamento diretto al Comunicatore GSM collegato al PC per la lettura del flusso opera-
zioni che sta eseguendo;

•		 memorizzare in un file il flusso operazioni letto.

Modulo Gsm (solo per Cronotermostato GSM 01913) permette di: 

•		 selezionare il cronotermostato GSM 01913 sul quale effettuare la attività di manutenzione presenti nelle 
altre cartelle della finestra.

Manutenzione
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4.4.1 Monitor

Questa cartella consente di effettuare il collegamento diretto al Comunicatore GSM collegato al PC 
per la lettura del flusso operazioni che sta eseguendo.  

Aggiornamento firmware permette di:  

• 	aggiornare il firmware installato nel comunicatore GSM collegato al PC.

Aggiornamento voci permette di:  

•	 aggiornare i messaggi vocali configurati nel comunicatore GSM collegato al PC.

Impostazione Voci 01942 (solo per Comunicatore GSM 01942) permette di:  

•	 modificare la lingua dei messaggi vocali; 

• 	impostare, registrare, ascoltare i messaggi vocali definibili dall'utente; 

• 	aggiornare i messaggi vocali configurati nel comunicatore GSM 01942 collegato al PC.
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Per iniziare la lettura del flusso operazioni, deve essere attivato il pulsante funzione :
i messaggi letti dal Comunicatore GSM verranno visualizzati nell'apposito campo della cartella. 

L'interruzione del collegamento avviene attivando il pulsante funzione . 

La cartella prevede la possibilità di memorizzare in un file il flusso operazioni letto.
Il percorso del file nel quale salvare i dati letti, deve essere specificato nell'apposito campo previsto 
nella cartella prima di iniziare la connessione con il Comunicatore GSM. 
Il nome del file può essere digitato direttamente nell'apposito campo, oppure può essere specificato 

tramite l'attivazione del pulsante funzione ; in questo caso la procedura prevede l'attivazione di 
una finestra per la ricerca della posizione del file e la scrittura in automatico nella cartella  del nome 
del file selezionato.

Una volta specificato il nome del file, può essere iniziata la connessione con il Comunicatore GSM; 
il flusso operazioni letto sarà salvato nel file al termine della connessione (pulsante funzione 

). 

Manutenzione
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4.4.2 Aggiornamento firmware

Questa cartella gestisce l'aggiornamento del firmware del Comunicatore GSM collegato al PC. 

Attenzione! 
Nel caso di Comunicatore GSM già configurato, prima di effettuare l’aggiornamento del firm-
ware, è necessario effettuare l’importazione di tutti i dati contenuti al suo interno.
Vedere la sezione 2.2.1 per le impostazioni generali e le sezioni 2.2.2 e 2.2.3 rispettivamente 
per automazione domestica e antintrusione se presenti.

Prima di procedere all'aggiornamento deve essere specificato il nome del file contenente la nuova 
versione del firmware.
Il nome del file può essere digitato direttamente nell'apposito campo oppure può essere specificato 
tramite l'attivazione del pulsante funzione ; in questo caso la procedura prevede l'attivazione di 
una finestra per la ricerca della posizione del file e la scrittura in automatico nella cartella del nome 
del file selezionato.
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L'operazione di aggiornamento firmware deve essere attivata con il pulsante funzione  
che prevede lo scaricamento del nuovo firmware nel Comunicatore GSM collegato, previo richiesta 
del codice utente del Comunicatore GSM stesso. 

Al termine dell'aggiornamento è prevista un'apposita segnalazione per indicare l'esito dell'opera-
zione eseguita.

Manutenzione

Attenzione! 
Al termine dell’aggiornamento firmware del Comunicatore GSM, è necessario effettuare il 
ripristino delle impostazioni di fabbrica prima di procedere alla configurazione (vedere il 
manuale istruzioni del Comunicatore).
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Nota: Nel caso in cui lo scaricamento del firmware venga interrotto (ad esempio a causa di una 
sconnessione accidentale del connettore seriale) compare la finestra seguente:

Dopo un tale evento, per ripetere l'operazione di Aggiornamento del firmware è necessario seguire 
la seguente procedura:

1.	 Spegnere il comunicatore
2.	 Eliminare la causa che ha generato l'errore (es. reinserendo il connettore seriale, che ha causato 

l'errore in fase di programmazione)
3.	 Chiudere e riavviare la EasyTool
4.	 Riavviare la procedura di scaricamento del firmware
5.	 Premere il pulsante Aggiorna
6.	 Riconfermare l'aggiornamento
7.	 Reinserire il codice e premere OK
8.	 Dopo poco più di 1' compare la finestra seguente. Premere "Si", per effettuare il riavvio manuale 

del comunicatore.

9.	 Seguire le istruzioni che compaiono nella finestra seguente, per il riavvio manuale del comuni-
catore GSM.

10.	La procedura di Aggiornamento del firmware dovrebbe iniziare nuovamente e procedere corret-
tamente come descritto in precedenza. 

	 In caso contrario, controllare i cavi di collegamento seriale tra il comunicatore GSM e il PC e le 
impostazioni seriali del PC e ripetere la procedura appena descritta, dal punto 1. 



122

4.4.3 Aggiornamento Voci

Questa cartella gestisce l'aggiornamento dei messaggi vocali configurati nel Comunicatore GSM 
collegato al PC.  

Prima di procedere all'aggiornamento deve essere specificato il nome del file contenente la nuova 
versione dei messaggi vocali con i quali aggiornare il dispositivo.
Il nome del file può essere digitato direttamente nell'apposito campo oppure può essere specificato 

tramite l'attivazione del pulsante funzione ; in questo caso la procedura prevede l'attivazione di 
una finestra per la ricerca della posizione del file e la scrittura in automatico nella cartella del nome 
del file selezionato.

Manutenzione
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L'aggiornamento dei messaggi vocali può essere effettuato specificando il nome di un file di tipo 
MOT oppure il nome di un file di tipo ZIP contenente uno o più file di tipo MOT da elaborare. Se 
viene specificato un file di tipo ZIP, la procedura prevede l'elaborazione di tutti i file di tipo MOT in 
esso contenuti.

L'operazione di aggiornamento dei messaggi vocali deve essere attivata con il pulsante funzione   

 che prevede lo scaricamento dei nuovi messaggi vocali nel Comunicatore GSM 
collegato al PC.

Nel caso in cui il file specificato è di tipo MOT, l’aggiornamento è preceduto da una richiesta di 
conferma a procedere all’elaborazione del file indicato.

Nel caso in cui il file specificato è di tipo ZIP, viene richiesta un’esplicita conferma prima di procedere 
all’elaborazione di ciascun file di tipo MOT in esso contenuto.
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Un file di tipo MOT può non essere elaborato mediante attivazione dei pulsanti funzione 

 oppure .

Prima di procedere all’elaborazione del primo file indicato, la procedura di aggiornamento prevede 
la richiesta del codice utente del Comunicatore GSM da aggiornare. 

Al termine dell'aggiornamento è prevista un'apposita segnalazione per indicare l'esito dell'opera-
zione eseguita. 

Manutenzione
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4.4.4 Impostazione Voci 01942

Questa cartella gestisce l'aggiornamento dei messaggi vocali di un Comunicatore GSM-BUS 
01942. 

L'aggiornamento può essere effettuato solo se il Comunicatore GSM collegato al PC è un 
Comunicatore GSM 01942. La versione del comunicatore viene verificata direttamente dalla 
procedura nel momento in cui viene selezionata la cartella e previo richiesta del codice utente del 
Comunicatore stesso.
Una volta effettuata la verifica della versione del Comunicatore, è prevista la proposta della lingua 
dei messaggi vocali utilizzata dal Comunicatore GSM 01942 e la determinazione del tempo di 
registrazione. 

Il Comunicatore GSM 01942 gestisce due diversi gruppi di messaggi vocali: 
• 5 messaggi vocali predefiniti e non modificabili dipendenti dalla lingua; 
• 9 messaggi vocali registrabili dall'utente tramite la cartella corrente. 

I messaggi vocali predefiniti possono essere configurati in una delle seguenti lingue: Italiano, Inglese, 
Tedesco, Francese, Spagnolo, Greco. La lingua utilizzata dal Comunicatore GSM 01942 viene 
proposta dalla procedura alla selezione della cartella, e può essere modificata tramite l'apposito 
campo previsto a video. 

Nel Comunicatore GSM 01942 possono essere configurati messaggi vocali per un tempo totale 
massimo di 28 secondi di registrazione. La cartella fornisce indicazioni sul tempo effettivo registrato 
e sul tempo rimanente a disposizione per la registrazione dei messaggi vocali utente.
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È prevista una segnalazione di errore nel caso in cui viene superato il tempo massimo di registra-
zione. 

Per ciascuno dei messaggi vocali utente è previsto a video un campo in cui deve essere specificato 
il percorso del file contenente la registrazione del messaggio vocale.
I nomi dei file dei messaggi vocali utente sono proposti in automatico e possono essere modificati 
direttamente nel campo previsto a video o attivando la finestra Associa File 

Vocale tramite l'apposito pulsante funzione .
I file proposti sono inizialmente vuoti.
Per ciascun messaggio vocale utente è prevista la possibilità di ascoltare il messaggio utente regi-
strato e/o di registrare un messaggio diverso attivando la finestra 

Registrazione Messaggi dal pulsante funzione  .
Al termine della registrazione di un nuovo messaggio, è previsto l'aggiornamento della barra conte-
nente l'indicazione del tempo di registrazione effettivo e residuo. 

L'operazione di aggiornamento dei messaggi vocali nel Comunicatore GSM 01942 si realizza in 
due fasi: 

•	 generazione del file .mot 

•	 aggiornamento del Comunicatore GSM 01942 con il file .mot generato. 

Tramite l'attivazione del pulsante funzione  vengono eseguite, in successione le due 
suddette fasi che si concludono con lo scaricamento, nel Comunicatore GSM 01942 collegato, dei 
messaggi vocali predefiniti nella lingua impostata e di quelli utente. 

Tramite l'attivazione del pulsante funzione , viene eseguita solo la prima delle 
due fasi suddette: la generazione del file .mot con il quale possono essere aggiornati, in seguito, i 
messaggi vocali del Comunicatore GSM 01942 dalla cartella Aggiornamento Voci.
 

Manutenzione
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4.5 Utility generali 

4.5.1 Modulo Gsm

È prevista la possibilità di ricercare dei dati appartenenti all'impianto e memorizzati nelle varie car-
telle dell'applicazione, tramite la finestra Ricerca Dati. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella barra degli strumenti 
delle cartelle dell'applicazione. 

La finestra prevede la possibilità di specificare dei criteri di filtro indicando, negli appositi campi 
previsti, uno o più valori da ricercare.
Possono essere indicati anche filtri parziali specificando, ad esempio, solo alcuni caratteri iniziali 
del valore da ricercare.

All'attivazione del pulsante funzione , la procedura ricerca, tra tutti i dati presenti nella 
cartella dalla quale la finestra è stata attivata, un elemento i cui valori corrispondono a quelli indicati 
nei campi di filtro, e lo visualizza nella cartella stessa.

All'attivazione del pulsante funzione , viene ricercato se esiste un altro dato, 
oltre a quello precedentemente visualizzato, che soddisfa alle condizioni di filtro impostate: l'even-
tuale elemento trovato viene riportato nella cartella dalla quale la finestra è stata attivata.
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4.5.2 Associa numeri telefonici

La finestra Associa Numeri Telefonici consente di associare i numeri telefonici selezionandoli tra 
quelli configurati nella cartella Rubrica Telefonica di ciascun modulo GSM dell'impianto. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Generali 
della finestra Parametri di Configurazione e nella sezione Ingressi Digitali della cartella Dispositivi 
gestita dalla finestra Dispositivi del modulo GSM-Impostazioni. 

Se attivata dalla cartella Generali, prevede la selezione di un solo numero di telefono corrispondente 
a quello a cui ridirezionare gli SMS non di comando. 

Se attivata dalla sezione Ingressi Digitali, prevede la sola visualizzazione dei numeri di telefono 
associati ad un messaggio vocale e/o SMS, senza possibilità di effettuare alcuna modifica della 
situazione presentata. 

Utility generali
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4.5.3 Associa file vocale

La selezione di un file contenente la registrazione di un messaggio vocale è gestita dalla finestra 
Associa File Vocale.  

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Messaggi 
Vocali (finestra Parametri di Configurazione), e nelle sezioni Relè ed Ingressi Digitali della cartella 
Dispositivi (finestra Dispositivi del modulo GSM-Impostazioni).  

Il file vocale può essere indicato selezionando un elemento dalla lista dei file prevista nella finestra, 
oppure digitando il nome nell'apposito campo. 

È prevista la possibilità di specificare il nome di un file non esistente; in questo caso, una volta disat-
tivata la finestra attuale, dovrà essere effettuata la registrazione del messaggio vocale da inserire 
nel file. Questa funzionalità è gestita dalla finestra Registrazione Messaggi attivabile dalla stessa 
cartella dalla quale è stata richiesta la finestra corrente mediante il pulsante funzione .

Tramite l'attivazione del pulsante funzione , la procedura prevede la visualizzazione 
del percorso completo del file vocale specificato, nell'apposito campo della cartella dalla quale la 
finestra è stata attivata.
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4.5.4 Registrazione messaggi

La finestra Registrazione Messaggi prevede la possibilità di ascoltare la registrazione di un mes-
saggio vocale esistente e di effettuare la registrazione di un nuovo messaggio.

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Messaggi 
Vocali (finestra Parametri di Configurazione), e nelle sezioni Relè ed Ingressi Digitali della cartella 
Dispositivi (finestra Dispositivi del modulo GSM-Impostazioni). 

La procedura visualizza, nell'apposito campo, il percorso del file vocale gestito dalla finestra corren-
te; il nome del file è desunto dalla cartella dalla quale la finestra è stata attivata.

Se il file vocale contiene già la registrazione di un messaggio, questo può essere ascoltato mediante 

l'attivazione del pulsante funzione funzione . 

La finestra prevede inoltre la possibilità di effettuare la registrazione di un nuovo messaggio 

vocale. Questa funzionalità è gestita dal pulsante funzione , la cui attivazione dà inizio alla 

fase di registrazione che ha termine con la selezione del pulsante funzione .

Il nuovo messaggio registrato può essere ascoltato, sempre mediante l'attivazione del pulsante 

funzione , e può essere salvato nel file vocale gestito dalla finestra. Questa funzionalità è 
attivabile dal pulsante funzione , previo richiesta di conferma a procedere. 

Utility generali
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4.5.5 Impostazione tempo di refresh.

L’applicazione consente di specificare l'intervallo di tempo con il quale devono essere aggiornati i 
dati gestiti a video con quelli letti dal Comunicatore GSM collegato. 

Si può accedere a questa funzionalità dal menu principale Utility ► Tempo refresh.

Il tempo è gestito in secondi e deve essere specificato un tempo minimo di 1 secondo.
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4.5.6 Esportazione dei dati dei comunicatori attraverso EasyTool.

              Il software EasyTool consente la creazione di files contenenti i database dei comunicatori GSM in 
              modo che possano essere importati dall'applicativo per Vimar By-phone. Per fare questo è necessario: 

             1. Essere provvisti del software EasyTool versione 4.1 o successive;

             2. Essere provvisti di connessione fra PC e comunicatore;

             3. Aver importato il database del comunicatore all'interno di EasyTool;

             Se i tre punti sopra riportati sono stati effettuati correttamente, per attivare la procedura di creazione 
             del file è sufficiente selezionare il pulsante “Esportazione su Cellulare”  presente nella finestra 
             "Parametri di Configurazione" relativa al comunicatore desiderato. 
             Una volta premuto il pulsante basterà seguire le istruzioni che vengono visualizzate da EasyTool.

             Le figure che seguono illustrano la finestre che permettono di esportare i database dei comunicatori
             GSM 01941 e 01942 in modo da renderli utilizzabili dall'applicativo Vimar By-phone.    
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4.5.7 Help.

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del 
sistema EasyTool, oppure attraverso il tasto F1 dalle finestre principali. 
Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato 
(ad esempio: premendo F1 dalla finestra “Parametri di configurazione” verrà visualizzata la parte 
dell'help relativa alla gestione dei parametri di configurazione dei moduli GSM).
Selezionando il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta 
essere in primo piano tra tutte quelle attive nell’applicazione.
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4.6 Esempio Applicativo 
4.6.1 Sistema antintrusione generico

Configurazione sistema antintrusione generico per l’invio di un messaggio di allarme vocale e SMS, 
tramite un Comunicatore GSM 01941, nel caso di:

1.	Rilevamento antintrusione con comando proveniente da centrale antintrusione collegata all’in-
gresso IN1

2.	Rilevamento manomissione del centralino con comando proveniente da antitamper collegato 
all’uscita OUT2.

	 Operazioni da eseguire

1. Attivare la finestra Parametri di configurazione e posizionarsi, nella cartella Generali, sul modulo 
GSM da gestire (vedere i paragrafi 4.1 e 4.1.1)

2. Modificare il modulo GSM da elaborare ed abilitare la ricezione dell’allarme di tamper (vedere il 
paragrafo 4.1.1)

3. Selezionare la cartella Rubrica Telefonica e memorizzare, in due posizioni libere, due numeri di 
telefono: uno per la segnalazione di allarme vocale e l’altro per la segnalazione di allarme SMS 
(vedere il paragrafo 4.1.2)

 4.	Nella cartella Messaggi Vocali, selezionare uno dei primi quattro messaggi vocali liberi, modifi-
care il messaggio scelto ed eseguire le seguenti operazioni (vedere il paragrafo 4.1.3): 

	 4.1. registrare il messaggio di allarme vocale utente
	 4.2. associare il numero di telefono inserito nella rubrica per la segnalazione di allarme vocale

5.	Nella cartella SMS, modificare il messaggio Allarme Intrusione (SMS n. 5) ed associare il numero 
di telefono inserito nella rubrica per la segnalazione di allarme SMS (vedere il paragrafo 4.1.4)

6.	Dalla cartella Generali, eseguire la configurazione del Comunicatore GSM collegato al PC con 
tutti i parametri impostati nella finestra (punti da 2 a 5) tramite il pulsante funzione  (vedere il 
paragrafo 4.1.1)

7.	Attivare la finestra Dispositivi e selezionare, nella cartella Modulo Gsm, il modulo GSM da 
gestire (vedere i paragrafi 4.2 e 4.2.1)

8.	Selezionare la cartella Dispositivi, modificare, nella sezione Ingressi Digitali, il primo ingresso 
digitale ed eseguire le seguenti operazioni (vedere il paragrafo 4.2.2):
8.1.	associare il messaggio vocale libero per il quale è stata effettuata la registrazione del mes-

saggio vocale utente
8.2.	associare il messaggio SMS di Allarme Intrusione
8.3.	impostare la modalità di attivazione dell’ingresso digitale (Quando Aperto - Quando 

Chiuso)

9.	Dopo aver confermato le modifiche effettuate ai dati del primo ingresso digitale (punto 8), ese-
guire, per l’ingresso stesso, la procedura di configurazione del Comunicatore GSM collegato al 
PC tramite il pulsante funzione  (vedere il paragrafo 4.2.2)

Esempio  applicativo
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Sezione 2.2.2
Automazione domestica

Comunicatori GSM
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1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

3. Descrizione funzionale del software GSM-Automazione Domestica – lato PC

3.1 Funzionalità
Il software per PC contenuto nel CD ed allegato al sistema GSM-Automazione Domestica, permette di:

• definire i parametri di configurazione dei sistemi di automazione domestica 

• configurare le centrali

•	configurare i dispositivi comfort per effettuare la lettura, l'impostazione e la regolazione delle zone clima-
tiche

•	configurare gli scenari ed attivare ciascuno degli scenari configurati

•	configurare i gruppi, leggerne lo stato ed attivare e/o disattivare i gruppi configurati

•	avviare la procedura di controllo del funzionamento di tutti i dispositivi configurati e leggere tutti i dati 
rilevati nell'ultima scansione diagnostica relativi agli eventuali dispositivi guasti

•	configurare gli allarmi tecnici.

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.
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Le funzionalità

4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

 	 Ricerca un dato tra quelli della cartella

Pulsanti di edit:

 	 Mette in modifica il dato visualizzato

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione scambio dati tra PC e dispositivo:

 	 Importa nella cartella i dati dal Comunicatore GSM collegato al PC

 	 Configura il Comunicatore GSM collegato al PC con i dati presenti nella cartella

Segue il dettaglio delle finestre dell’applicazione e delle operazioni che rendono disponibili.

La sequenza è utile anche come schema per la configurazione di un sistema di automazione domestica di 
un impianto.
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4.1 Parametri di configurazione Sistema GSM-Automazione Domestica.
Alla configurazione dei parametri dei sistemi di automazione domestica si accede attivando, dalla barra 
degli strumenti del sistema EasyTool, il modulo Parametri di configurazione definito nel sistema GSM-
Automazione Domestica.

Parametri di configurazione

La finestra è formata da una sola cartella Generali che permette di: 

• 	modificare i sistemi di automazione domestica di un impianto.
• 	ripristinare le impostazioni iniziali del Comunicatore GSM collegato al PC.
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4.1.1   Generali

Questa cartella gestisce la configurazione generale dei sistemi di automazione domestica definiti 
in un impianto.

È possibile inserire nuovi sistemi di automazione domestica, modificare i parametri e cancellare i 
sistemi già esistenti.
È inoltre possibile scorrere i sistemi di automazione domestica configurati con i pulsanti funzione di 
navigazione, o effettuare una ricerca rapida. 
La descrizione del sistema di automazione domestica corrente, quello cioè selezionato nella cartella, 
viene visualizzata nel titolo della finestra.

L'aspetto delle cartelle ed i parametri  di configurazione di un sistema di automazione domestica 
dipende dal tipo di centrale automazione utilizzata. 

Per ciascun sistema di automazione domestica sono gestiti i seguenti parametri di configurazione 
generale: 

•	 Descrizione: descrizione del sistema di automazione domestica; deve essere obbligatoriamente 
specificata ed identifica il sistema di automazione domestica nell'impianto. 

•	 Versione: tramite un menu a tendina è possibile selezionare il tipo di centrale automazione utiliz-
zata nell'impianto. 

Parametri di configurazione
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Parametri di configurazione

•	 Punto di accesso: identifica il dispositivo che permette la comunicazione del sistema con il PC; 
deve essere obbligatoriamente indicato selezionando uno dei moduli GSM definiti nell'impianto.

	 Un modulo GSM può essere impostato come punto di accesso di un solo sistema di automazione 
domestica.  In caso contrario, in fase di conferma dei dati della cartella tramite il pulsante funzione 

 viene segnalato il seguente errore:

	 Questa cartella gestisce la possibilità di ripristinare le impostazioni iniziali del Comunicatore GSM 

collegato al PC, tramite l'attivazione del pulsante funzione .
	 Questa funzionalità ha effetto solo sul dispositivo, non prevede quindi la modifica dei parametri 

configurati nella cartella attuale. 
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Dispositivi Sistema

La finestra è divisa nelle seguenti cartelle: 

Sistemi GSM-Automazione Domestica permette di: 

•	 scegliere il sistema di automazione domestica da configurare;

•	 copiare i dispositivi da un sistema di automazione domestica già configurato;

•	 importare la configurazione dei dispositivi leggendo i dati dal Comunicatore GSM collegato al PC;

•	 configurare il comunicatore GSM collegato al PC con i dispositivi definiti in un sistema di automazione 
domestica.

4.2 Dispositivi Sistema GSM-Automazione Domestica 
Alla configurazione dei dispositivi per ciascun sistema di automazione domestica definito nell’impianto, 
si accede attivando, dalla barra degli strumenti del sistema EasyTool, il modulo Dispositivi definito nel 
sistema GSM-Automazione Domestica. 

L'aspetto delle cartelle ed i parametri di configurazione dipendono dal tipo di centrale automazione uti-
lizzata. 
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Centrali permette di: 

•	 inserire, modificare, eliminare le centrali per ciascun sistema di automazione domestica;
•	 copiare una centrale già configurata per un altro sistema di automazione domestica esistente in un 

impianto dell'applicazione;
•	 associare automaticamente i dispositivi comfort;
•	 associare automaticamente gli scenari;
•	 importare la configurazione delle centrali leggendo i dati dal Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i dati delle centrali gestite nella cartella.

Comfort permette di: 

•	 inserire, modificare, eliminare i dispositivi comfort per ciascun sistema di automazione domestica;
•	 copiare un dispositivo comfort già configurato per un altro sistema di automazione domestica esistente 

in un impianto dell'applicazione;
•	 importare la configurazione dei dispositivi comfort leggendo i dati dal Comunicatore GSM collegato al 

PC;
•	 configurare il comunicatore GSM collegato al PC con i dati dei dispositivi comfort gestiti nella cartella.

Scenari permette di: 

•	 inserire, modificare, eliminare gli scenari per ciascun sistema di automazione domestica;
•	 copiare uno scenario già configurato per un altro sistema di automazione domestica esistente in un 

impianto dell'applicazione;
•	 importare la configurazione degli scenari leggendo i dati dal Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i dati degli scenari gestiti nella cartella.

Gruppi permette di: 

•	 inserire, modificare, eliminare i gruppi per ciascun sistema di automazione domestica;
•	 copiare un gruppo già configurato per un altro sistema di automazione domestica esistente in un 

impianto dell'applicazione;
•	 importare la configurazione dei gruppi leggendo i dati dal Comunicatore GSM collegato al PC;
•	 configurare il comunicatore GSM collegato al PC con i dati dei gruppi gestiti nella cartella.

Allarmi Tecnici permette di: 

•	 inserire, modificare, eliminare gli allarmi tecnici per ciascun sistema di automazione domestica; 
•	 copiare un allarme tecnico già configurato per un altro sistema di automazione domestica esistente in 

un impianto dell'applicazione; 
•	 importare la configurazione degli allarmi tecnici leggendo i dati dal Comunicatore GSM collegato al 

PC; 
•	 configurare il comunicatore GSM collegato al PC con i dati degli allarmi tecnici gestiti nella cartella.
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4.2.1  Sistemi GSM-Automazione Domestica

Questa cartella consente di selezionare, tra tutti i sistemi di automazione domestica definiti nell'im-
pianto, quello per il quale deve essere gestita la configurazione dei dispositivi. 

È possibile scorrere i sistemi di automazione domestica configurati con i pulsanti funzione di naviga-
zione, o effettuare una ricerca rapida. 
Per il sistema di automazione domestica selezionato, viene visualizzata la descrizione nel titolo della 
finestra e viene visualizzata nel dettaglio la configurazione dei dispositivi nelle apposite cartelle Cen-
trali, Comfort, Scenari e Gruppi e Allarmi Tecnici. 

La cartella gestisce la possibilità di copiare, nel sistema di automazione domestica selezionato, la 
configurazione dei dispositivi di un altro sistema di automazione domestica definito in un impianto 

dell'applicazione. A questa funzionalità si accede dal pulsante funzione  tramite il quale viene 
attivata la finestra Copia Dispositivi. 

È possibile importare nel sistema di automazione domestica selezionato, la configurazione dei di-
spositivi impostata nel Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione 

.
Questa funzionalità prevede la sostituzione di tutti i dispositivi del sistema di automazione domestica 
selezionato, con quelli letti dal Comunicatore GSM. 
Nel caso di importazione di un dispositivo che non risulta essere configurato nella relativa cartella, è 
previsto il suo inserimento automatico nella cartella con una descrizione predefinita.
Con la configurazione dei dispositivi associati al sistema di automazione domestica selezionato, è 
possibile configurare il Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da 
PC a dispositivo dei dati relativi a tutti i dispositivi associati al sistema di automazione domestica 
selezionato.
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4.2.2 Centrali

Questa cartella gestisce i dati delle centrali configurate per il sistema di automazione domestica 
selezionato nella cartella Sistemi GSM-Automazione Domestica.

Ogni sistema di automazione domestica può gestire fino ad un massimo di 8 centrali. 
La cartella gestisce l'inserimento di nuove centrali, la modifica e la cancellazione delle centrali già 
esistenti.
Prevede inoltre la possibilità di scorrere le centrali configurate con i pulsanti funzione di navigazione, 
o di effettuare una ricerca rapida. 

Per ciascuna centrale sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione della centrale; deve essere obbligatoriamente inserita ed identifica la 
centrale all'interno di un sistema di automazione domestica. 

•	 N. Centrale (Comunicatore): numero che identifica il sistema associato alla centrale di controllo; 
il valore inserito deve essere compreso tra 1 e 8; non può essere indicato lo stesso numero per 
due diverse centrali appartenenti allo stesso sistema di automazione domestica; è utilizzato per la 
composizione dei messaggi da inviare al Comunicatore GSM.

•	 Dati di configurazione: rappresentano l'indirizzo che identifica univocamente la centrale all'in-
terno di un sistema di automazione domestica; devono essere obbligatoriamente inseriti e sono 
composti dai seguenti campi: 

•	Area: identificativo dell'area. 
•	Linea: identificativo della linea. 
•	Identificativo centrale: identificativo della centrale.
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Nella cartella è prevista la possibilità di copiare una centrale già configurata per un altro sistema di 
automazione domestica esistente in un impianto dell'applicazione. A questa funzionalità si accede 

dal pulsante funzione  tramite il quale viene attivata la finestra Copia Centrale.

Per ciascuna centrale configurata è possibile avviare la procedura di arruolamento automatico 

delle zone climatiche tramite il pulsante funzione . Questa procedura effettua un'associazione 
sequenziale delle zone climatiche che la centrale gestita rende disponibili remotamente. 
A fronte di ciascuna zona climatica abilitata della centrale, viene creato un dispositivo comfort per il 
quale vengono riportati, come dati di configurazione, l'indirizzo della centrale e l'identificativo della 
zona climatica. I dispositivi comfort così generati saranno disponibili, al termine della procedura, 
nella cartella Comfort nella quale vengono inseriti con una descrizione predefinita. 

Tramite la funzionalità prevista dal pulsante funzione , è possibile avviare la procedura di arruo-
lamento automatico degli scenari per ciascuna centrale configurata. Questa procedura effettua 
un'associazione sequenziale degli scenari che la centrale rende disponibili remotamente. 
A fronte di ogni scenario disponibile, viene creato un nuovo dispositivo nella cartella Scenari per il 
quale vengono riportati, come dati di configurazione, l'indirizzo della centrale ed il numero identifi-
cativo dello scenario e, come descrizione, una descrizione predefinita. 

È possibile importare le informazioni relative alla centrale visualizzata nella cartella corrente dal 

Comunicatore GSM collegato al PC, tramite l'attivazione del pulsante funzione . Questa fun-
zionalità prevede la sostituzione dei dati di configurazione della centrale con quelli letti dal Comu-
nicatore GSM. 

Le impostazioni della centrale visualizzata nella cartella corrente, possono essere configurate nel 
Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo dei dati di configurazione relativi alla centrale visualizzata nella cartella corrente. 
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4.2.3 Comfort

Questa cartella gestisce i dati dei dispositivi comfort configurati per il sistema di automazione do-
mestica selezionato nella cartella Sistemi GSM-Automazione Domestica.
L'aspetto della cartella ed i dati impostabili dalla stessa dipendono dal tipo di Comunicatore GSM 
selezionato nella cartella Generali durante la fase di creazione del modulo GSM.

Ogni sistema di automazione domestica può gestire fino ad un massimo di 40 dispositivi comfort 
(cronotermostati), in funzione del tipo e della versione firmware del comunicatore GSM. 

La cartella gestisce l'inserimento di nuovi dispositivi comfort, la modifica e la cancellazione dei di-
spositivi già esistenti.

Prevede inoltre la possibilità di scorrere i dispositivi comfort configurati con i pulsanti funzione di 
navigazione, o di effettuare una ricerca rapida.  

Per ciascun dispositivo comfort sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del dispositivo comfort; deve essere obbligatoriamente inserita ed iden-
tifica il dispositivo all'interno di un sistema di automazione domestica. 

•	 Etichetta vocale: (solo per comunicatore GSM 01941) percorso del file contenente la registrazio-
ne del messaggio vocale utente associato al dispositivo comfort.

	 Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite il pulsante 

funzione .
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Se non viene indicato il nome di un file, si assume che al dispositivo comfort sia associata l'etichetta 
vocale predefinita.  

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; se non specificata, si assume che al 
dispositivo comfort sia associata l’etichetta SMS predefinita.

•	 N. Comfort (Comunicatore): numero del cronotermostato relativamente al comunicatore; non 
può essere indicato lo stesso numero per due diversi dispositivi comfort appartenenti allo stesso 
sistema di automazione domestica; è utilizzato per la composizione dei messaggi da inviare al 
Comunicatore GSM.

•	 Dati di configurazione: identificano univocamente il dispositivo comfort all'interno di un sistema 
di automazione domestica; devono essere obbligatoriamente inseriti e sono composti dall'indiriz-
zo della centrale e dall'identificativo della zona climatica: 

•	Area: identificativo dell'area. 
•	Linea: identificativo della linea. 
•	Identificativo centrale: identificativo della centrale.
•	Zona climatica: identificativo della zona climatica.

Tramite la funzionalità prevista dal pulsante funzione , è possibile eliminare tutti i dispositivi 
comfort gestiti nella cartella corrente. 
Questa operazione non prevede l'eliminazione immediata dei dispositivi anche dal Comunicatore 
GSM collegato al PC, ma solo dalla cartella corrente. L'eliminazione della configurazione di questi 
dispositivi nel Comunicatore GSM, sarà effettuata solo in fase di esecuzione della procedura di 
configurazione dati avviata dalla cartella Sistemi GSM-Automazione Domestica. 

Per ciascun dispositivo comfort configurato, per il comunicatore GSM 01941, è prevista la possi-
bilità di ascoltare il messaggio utente registrato nel file vocale. A questa funzionalità si accede dal 

pulsante funzione  tramite il quale viene attivata la finestra Registrazione Messaggi. 

Per il comunicatore 01941 è inoltre prevista la possibilità di registrare un messaggio diverso da 
quello predefinito. Questa operazione è gestita dalla finestra Registrazione Messaggi attivata dal 

pulsante funzione . 

È possibile copiare un dispositivo comfort già configurato per un altro sistema di automazione 
domestica esistente in un impianto dell'applicazione. A questa funzionalità si accede dal pulsante 

funzione  tramite il quale viene attivata la finestra Copia Comfort. 

Tramite l'attivazione del pulsante funzione  è possibile importare, dal Comunicatore GSM 
collegato al PC, le informazioni relative al dispositivo comfort visualizzato nella cartella corrente. 
Questa funzionalità prevede la sostituzione dei dati del dispositivo comfort con quelli letti dal Co-
municatore GSM.
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Se viene letto dal Comunicatore GSM 01941 un messaggio vocale utente, questo verrà memo-
rizzato in un file vocale il cui nome sarà visualizzato nell'apposito campo della cartella al fine di 
consentirne l'ascolto. Se invece al dispositivo comfort risulta associato il messaggio vocale prede-
finito, non sarà visualizzato il nome del file vocale e, di conseguenza, non è prevista la possibilità di 
ascoltarne la registrazione. 

Le impostazioni del dispositivo comfort visualizzato nella cartella corrente, possono essere con-
figurate nel Comunicatore GSM collegato al PC. Questa funzionalità è disponibile attivando il 

pulsante funzione  e prevede il trasferimento da PC a dispositivo delle informazioni relative al 
dispositivo comfort. 
Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore GSM 01941, il messaggio predefinito; se invece non è stato indicato alcun 
file vocale, nel Comunicatore GSM 01941 verrà ripristinata l’etichetta vocale predefinita. 
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4.2.4 Scenari

Questa cartella gestisce i dati relativi agli scenari configurati per il sistema di automazione domesti-
ca selezionato nella cartella Sistemi GSM-Automazione Domestica.
L'aspetto della cartella ed i dati impostabili dalla stessa dipendono dal tipo di Comunicatore GSM 
selezionato nella cartella Generali durante la fase di creazione del modulo GSM.

Ogni sistema di automazione domestica può gestire fino ad un massimo di 32 scenari.

Per il comunicatore GSM 01941, per i primi 8 scenari è possibile assegnare un'etichetta SMS e/o 
un'etichetta vocale. 

Per il comunicatore GSM 01942, per i primi 8 scenari è possibile assegnare un'etichetta SMS. 

La cartella gestisce l'inserimento di nuovi scenari, la modifica e la cancellazione degli scenari già 
esistenti.

Prevede inoltre la possibilità di scorrere gli scenari configurati con i pulsanti funzione di navigazione, 
o di effettuare una ricerca rapida. 

Per ciascuno scenario sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione dello scenario; deve essere obbligatoriamente inserita ed identifica lo 
scenario all'interno di un sistema di automazione domestica.

•	 Etichetta vocale: (solo per comunicatore GSM 01941) percorso del file contenente la registrazio-
ne del messaggio vocale utente associato allo scenario.

	 Questa informazione è gestita solo per i primi 8 scenari configurati (numero scenario comunicatore 
compreso tra 1 e 8).
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Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite il pulsante 

funzione .

Se non viene indicato il nome di un file, si assume che allo scenario sia associata l'etichetta vocale 
predefinita. 

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; è gestita solo per i primi 8 scenari (nu-
mero scenario comunicatore compreso tra 1 e 8); se non specificata, si assume che allo scenario 
sia associata l’etichetta SMS predefinita.

•	 N. Scenario (Comunicatore): numero dello scenario relativamente al comunicatore;  non può 
essere indicato lo stesso numero per due diversi scenari appartenenti allo stesso sistema di au-
tomazione domestica; è utilizzato per la composizione dei messaggi da inviare al Comunicatore 
GSM.

•	 Dati di configurazione: identificano univocamente lo scenario all'interno di un sistema di auto-
mazione domestica; devono essere obbligatoriamente inseriti e sono composti dall'indirizzo della 
centrale e dall’identificativo dello scenario: 

•	Area: identificativo dell'area. 
•	Linea: identificativo della linea. 
•	Identificativo centrale: identificativo della centrale.
•	N. Scenario (Centrale): identificativo dello scenario relativamente alla centrale. 

Tramite la funzionalità prevista dal pulsante ffunzione , è possibile eliminare tutti gli scenari 
gestiti nella cartella corrente. 
Questa operazione non prevede l'eliminazione immediata degli scenari anche dal Comunicatore 
GSM collegato al PC, ma solo dalla cartella corrente. L'eliminazione della configurazione di questi 
scenari nel Comunicatore GSM, sarà effettuata solo in fase di esecuzione della procedura di confi-
gurazione dati avviata dalla cartella Sistemi GSM-Automazione Domestica. 

Per i primi 8 scenari configurati, solo per il comunicatore GSM 01941, è prevista la possibilità di 
ascoltare il messaggio utente registrato nel file vocale. A questa funzionalità si accede dal pulsante 

funzione  tramite il quale viene attivata la finestra Registrazione Messaggi. 

Per i primi 8 scenari, solo per il comunicatore GSM 01941, è inoltre prevista la possibilità di re-
gistrare un messaggio diverso da quello predefinito. Questa operazione è gestita dalla finestra 

Registrazione Messaggi  attivata dal pulsante funzione . 

È possibile copiare uno scenario già configurato per un altro sistema di automazione domestica 
esistente in un impianto dell'applicazione. A questa funzionalità si accede dal pulsante funzione 

 tramite il quale viene attivata la finestra Copia Scenario. 
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Tramite l'attivazione del pulsante funzione  è possibile importare, dal Comunicatore GSM col-
legato al PC, le informazioni relative allo scenario visualizzato nella cartella corrente. Questa funzio-
nalità prevede la sostituzione dei dati dello scenario con quelli letti dal Comunicatore GSM. 
Se viene letto dal Comunicatore GSM 01941 un messaggio vocale utente, questo verrà memo-
rizzato in un file vocale il cui nome sarà visualizzato nell'apposito campo della cartella al fine di 
consentirne l'ascolto. Se invece allo scenario risulta associato il messaggio vocale predefinito, non 
sarà visualizzato il nome del file vocale e, di conseguenza, non è prevista la possibilità di ascoltarne 
la registrazione. 

Le impostazioni dello scenario visualizzato nella cartella corrente, possono essere configurate nel 
Comunicatore GSM collegato al PC. Questa funzionalità è disponibile attivando il pulsante funzione 

 e prevede il trasferimento da PC a dispositivo delle informazioni relative allo scenario. 
Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore GSM 01941, il messaggio predefinito; se invece non è stato indicato alcun 
file vocale, nel Comunicatore GSM 01941 verrà ripristinata l’etichetta vocale predefinita. 
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4.2.5 Gruppi

Questa cartella gestisce i dati relativi agli scenari configurati per il sistema di automazione domesti-
ca selezionato nella cartella Sistemi GSM-Automazione Domestica.
L'aspetto della cartella ed i dati impostabili dalla stessa dipendono dal tipo di Comunicatore GSM 
selezionato nella cartella Generali durante la fase di creazione del modulo GSM.

Ogni sistema di automazione domestica può gestire fino ad un massimo di 8 gruppi. 

La cartella gestisce l'inserimento di nuovi gruppi, la modifica e la cancellazione dei gruppi già esi-
stenti.

Prevede inoltre la possibilità di scorrere i gruppi configurati con i pulsanti funzione di navigazione, o 
di effettuare una ricerca rapida. 

Per ciascun gruppo sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del gruppo; deve essere obbligatoriamente inserita ed identifica il grup-
po all'interno di un sistema di automazione domestica. 

•	 Etichetta vocale: (solo per comunicatore GSM 01941) percorso del file contenente la registrazio-
ne del messaggio vocale utente associato al gruppo.

	 Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite il pulsante 

funzione .
	 Se non viene indicato il nome di un file, si assume che al gruppo sia associata l'etichetta vocale 

predefinita. 

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata
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•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; se non specificata, si assume che al 
gruppo sia associata l’etichetta SMS predefinita. 

•	 N. Scenario (Comunicatore): numero del gruppo relativamente al comunicatore; il valore inserito 
deve essere compreso tra 1 e 8; non può essere indicato lo stesso numero per due diversi gruppi 
appartenenti allo stesso sistema di automazione domestica; è utilizzato per la composizione dei 
messaggi da inviare al Comunicatore GSM.

•	 Dati di configurazione: identificano univocamente il gruppo all'interno di un sistema di automa-
zione domestica; devono essere obbligatoriamente inseriti e sono composti dall'indirizzo della 
centrale e dall'identificativo del gruppo: 

•	Area: identificativo dell'area. 
•	Linea: identificativo della linea. 
•	Identificativo centrale: identificativo della centrale.
•	N. Gruppo (Centrale): numero del gruppo relativamente alla centrale di controllo. 

Per ciascun gruppo configurato,per il comunicatore GSM 01941, è prevista la possibilità di ascol-
tare il messaggio utente registrato nel file vocale. A questa funzionalità si accede dal pulsante 
funzione  tramite il quale viene attivata la finestra Registrazione Messaggi. 
Per il comunicatore 01941 è inoltre prevista la possibilità di registrare un messaggio diverso da 
quello predefinito. Questa operazione è gestita dalla finestra Registrazione Messaggi attivata dal 
pulsante funzione . 

È possibile copiare un gruppo già configurato per un altro sistema di automazione domestica esi-

stente in un impianto dell'applicazione. A questa funzionalità si accede dal pulsante funzione  
tramite il quale viene attivata la finestra Copia Gruppo. 

Tramite l'attivazione del pulsante funzione  è possibile importare, dal Comunicatore GSM col-
legato al PC, le informazioni relative al gruppo visualizzato nella cartella corrente. Questa funziona-
lità prevede la sostituzione dei dati del gruppo con quelli letti dal Comunicatore GSM. 

Se viene letto dal Comunicatore GSM 01941 un messaggio vocale utente, questo verrà memo-
rizzato in un file vocale il cui nome sarà visualizzato nell'apposito campo della cartella al fine di 
consentirne l'ascolto. Se invece al gruppo risulta associato il messaggio vocale predefinito, non 
sarà visualizzato il nome del file vocale e, di conseguenza, non è prevista la possibilità di ascoltarne 
la registrazione. 

Le impostazioni del gruppo visualizzato nella cartella corrente, possono essere configurate nel 
Comunicatore GSM collegato al PC. Questa funzionalità è disponibile attivando il pulsante funzione 

 e prevede il trasferimento da PC a dispositivo delle informazioni relative al gruppo. 
Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore GSM 01941, il messaggio predefinito; se invece non è stato indicato alcun 
file vocale, nel Comunicatore GSM 01941 verrà ripristinata l’etichetta vocale predefinita. 
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4.2.6 Allarmi Tecnici

Questa cartella gestisce i dati degli allarmi tecnici configurati per il sistema di automazione dome-
stica selezionato nella cartella Sistemi GSM-Automazione Domestica.

Ogni sistema di automazione domestica può gestire fino ad un massimo di:
•	 1 allarme tecnico per il Comunicatore GSM 01941;
•	 8 allarmi tecnici per il Comunicatore GSM 01942.
La cartella gestisce l'inserimento di nuovi allarmi, la modifica e la cancellazione degli allarmi tecnici 
già esistenti.
Prevede inoltre la possibilità di scorrere gli allarmi configurati con i pulsanti funzione di navigazione, o 
di effettuare una ricerca rapida. 

Per ciascun allarme tecnico sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione dell'allarme tecnico; deve essere obbligatoriamente inserita ed identifica 
l'allarme tecnico all'interno di un sistema di automazione domestica.

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Descrizione Allarme Tecnico Utente: descrizione aggiuntiva che consente di riconoscere il tipo 
di allarme tecnico (es. gas, fumo, acqua, ecc.); se specificata, sarà concatenata in fase di com-
posizione dei messaggi SMS relativi agli allarmi tecnici; possono essere inseriti al massimo 10 
caratteri (solo per Comunicatore GSM 01942) . 

•	 N.Allarme Tecnico: numero dell'allarme tecnico relativamente al comunicatore; il valore inserito 
deve essere compreso tra 1 e 8; non può essere indicato lo stesso numero per due diversi allarmi 
tecnici appartenenti allo stesso sistema di automazione domestica; è utilizzato per la composizio-
ne dei messaggi da inviare al Comunicatore GSM. 

Nota: il Comunciatore GSM 01941 può gestire un solo allarme tecnico. 
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•	 Dati di configurazione: identificano univocamente l'allarme tecnico all'interno di un sistema di 
automazione domestica; devono essere obbligatoriamente inseriti e sono composti dal valore del 
gruppo o dall'indirizzo del gruppo: 

•	 Valore Gruppo: identifica il gruppo al quale deve essere associato il messaggio di allarme 
tecnico. Il valore del gruppo da inserire corrisponde alla zona della centrale antintrusione SAI in 
cui è inserita l'interfaccia contatti che genera l'allarme tecnico. Il valore del gruppo deve essere 
compreso tra 1 e 31. 

	 Nota: tale impostazione deve essere utilizzata se la centrale antintrusione SAI appartiene ad 
uno dei tipi: 14480, 16930, 20480. 

•	 Indirizzo Gruppo: rappresenta l'indirizzo di gruppo a cui appartiene l'interfaccia contatti (4 cifre 
esadecimali). Se il valore dell'indirizzo di gruppo è 0xABCD, il parametro da inserire è ABCD. 

	 Nota: tale impostazione deve essere utilizzata in tutti i casi in cui l'interfaccia contatti dell'allar-
me tecnico non appartiene ad un impianto gestito da una delle seguenti centrali SAI: 14480, 
16930, 20480. 

È possibile copiare un allarme tecnico già configurato per un altro sistema di automazione do-
mestica esistente in un impianto dell'applicazione. A questa funzionalità si accede dal pulsante 

funzione  tramite il quale viene attivata la finestra Copia Allarme Tecnico.

Tramite l'attivazione del pulsante funzione  è possibile importare, dal Comunicatore GSM col-
legato al PC, le informazioni relative all'allarme tecnico visualizzato nella cartella corrente. Questa 
funzionalità prevede la sostituzione dei dati dell'allarme tecnico con quelli letti dal Comunicatore 
GSM. 
Le impostazioni dell'allarme tecnico visualizzato nella cartella corrente, possono essere configu-
rate nel Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative all'allarme tecnico. 
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4.2.7 Copia dispositivi

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare i dispositivi configurati per un altro sistema di automazione domestica esistente in un im-
pianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Sistemi 
GSM-Automazione Domestica.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal qua-
le importare i dati e, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automazione 
domestica al quale sono associati i dispositivi da duplicare nel sistema corrente. 

All’attivazione del tasto , i dispositivi configurati per il sistema di automazione domesti-
ca selezionato nella finestra, sostituiranno tutti i dispositivi del sistema corrente (centrali, comfort, 
scenari e gruppi). 

È prevista la possibilità di effettuare l'operazione di copia anche da un sistema di automazione do-
mestica esistente nello stesso impianto elaborato: verranno in questo caso visualizzati, nell'apposita 
lista, tutti i sistemi dell'impianto ad esclusione di quello corrente. 
 



161

Dispositivi Sistema

4.2.8 Copia centrale

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare una centrale configurata per un altro sistema di automazione domestica esistente in un 
impianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Centrali.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automazione 
domestica al quale è associato il dispositivo da duplicare e, dalla lista Centrali, la centrale da dupli-
care nel sistema corrente. 

All’attivazione del tasto , la centrale selezionata per la copia verrà aggiunta alle centrali 
già configurate nel sistema di automazione domestica corrente. 

Nel caso in cui la centrale da copiare ha lo stesso numero o gli stessi dati di configurazione di una 
centrale già configurata nel sistema di automazione domestica corrente, verrà richiesta una conferma 
a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesta la modifica dei 
dati della centrale da copiare; questa operazione è gestita dalla finestra Copia Centrale - Modifica 
Dati. 
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Nel caso in cui la centrale da copiare presenta una descrizione uguale a quella di una centrale già con-
figurata nel sistema di automazione domestica corrente ma dati di configurazione diversi, verrà richiesta 
una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesto 
l’inserimento di una nuova descrizione da attribuire alla centrale da importare.
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4.2.9 Copia comfort

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare un dispositivo comfort configurato per un altro sistema di automazione domestica esisten-
te in un impianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Comfort.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automazione 
domestica al quale è associato il dispositivo da duplicare e, dalla lista Comfort, il dispositivo comfort 
da duplicare nel sistema corrente. 

All’attivazione del tasto , il dispositivo comfort selezionato per la copia verrà aggiunto ai 
dispositivi già configurati nel sistema di automazione domestica corrente. 

Nel caso in cui il dispositivo comfort da copiare ha lo stesso numero o gli stessi dati di configurazione 
di un dispositivo già configurato nel sistema di automazione domestica corrente, verrà richiesta una 
conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesta la 
modifica dei dati del dispositivo comfort da copiare; questa operazione è gestita dalla finestra Copia 
Comfort - Modifica Dati. 
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Nel caso in cui il dispositivo comfort da copiare presenta una descrizione uguale a quella di una dispo-
sitivo già configurato nel sistema di automazione domestica corrente ma dati di configurazione diversi, 
verrà richiesta una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà 
richiesto l’inserimento di una nuova descrizione da attribuire al dispositivo comfort da importare. 
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4.2.10  Copia scenario

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare uno scenario configurato per un altro sistema di automazione domestica esistente in un 
impianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Scenari.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automazio-
ne domestica al quale è associato il dispositivo da duplicare e, dalla lista Scenari, lo scenario da 
duplicare nel sistema corrente.  

All’attivazione del tasto , lo scenario selezionato per la copia verrà aggiunto agli sce-
nari già configurati nel sistema di automazione domestica corrente. 

Nel caso in cui lo scenario da copiare ha lo stesso numero scenario (comunicatore) o gli stessi dati 
di configurazione di uno scenario già configurato nel sistema di automazione domestica corrente, 
verrà richiesta una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, 
verrà richiesta la modifica dei dati dello scenario da copiare; questa operazione è gestita dalla fine-
stra Copia Scenario - Modifica Dati.
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Nel caso in cui lo scenario da copiare presenta una descrizione uguale a quella di uno scenario già con-
figurato nel sistema di automazione domestica corrente ma dati di configurazione diversi, verrà richiesta 
una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesto 
l’inserimento di una nuova descrizione da attribuire allo scenario da importare. 
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4.2.11 Copia gruppo

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare un gruppo configurato per un altro sistema di automazione domestica esistente in un 
impianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Gruppi.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automa-
zione domestica al quale è associato il dispositivo da duplicare e, dalla lista Gruppi, il gruppo da 
duplicare nel sistema corrente.  

All’attivazione del tasto , il gruppo selezionato per la copia verrà aggiunto ai gruppi già 
configurati nel sistema di automazione domestica corrente. 

Nel caso in cui il gruppo da copiare ha lo stesso numero gruppo (comunicatore) o gli stessi dati di 
configurazione di un gruppo già configurato nel sistema di automazione domestica corrente, verrà 
richiesta una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà 
richiesta la modifica dei dati del gruppo da copiare; questa operazione è gestita dalla finestra Copia 
Gruppo - Modifica Dati. 
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Nel caso in cui il gruppo da copiare presenta una descrizione uguale a quella di un gruppo già confi-
gurato nel sistema di automazione domestica corrente ma dati di configurazione diversi, verrà richiesta 
una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesto 
l’inserimento di una nuova descrizione da attribuire al gruppo da importare. 

Dispositivi Sistema
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4.2.12 Copia Allarme Tecnico

Per il sistema di automazione domestica selezionato nella cartella Sistemi GSM-Automazione 
Domestica della finestra Dispositivi Sistema GSM-Automazione Domestica, è possibile im-
portare un Allarme Tecnico configurato per un altro sistema di automazione domestica esistente 
in un impianto dell'applicazione 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Allarmi 
Tecnici.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi GSM-Automazione Domestica, il sistema di automazio-
ne domestica al quale è associato il dispositivo da duplicare e, dalla lista Allarmi Tecnici, l'allarme 
tecnico da duplicare nel sistema corrente.   

Nel caso in cui l'allarme tecnico da copiare ha lo stesso numero allarme tecnico (comunicatore) o 
gli stessi dati di configurazione di un allarme tecnico già configurato nel sistema di automazione 
domestica corrente, verrà richiesta una conferma a procedere all'operazione di copia e, nel caso 
di risposta affermativa, verrà richiesta la modifica dei dati dell'allarme tecnico da copiare; questa 
operazione è gestita dalla finestra Copia Allarme Tecnico - Modifica Dati. 

Dispositivi Sistema
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Nel caso in cui l'allarme tecnico da copiare presenta una descrizione uguale a quella di un allarme tec-
nico già configurato nel sistema di automazione domestica corrente ma dati di configurazione diversi, 
verrà richiesta una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà 
richiesta l'inserimento di una nuova descrizione da attribuire all'allarme tecnico da importare. 

L'allarme tecnico selezionato per la copia verrà aggiunto agli allarmi tecnici già configurati nel sistema 
di automazione domestica corrente.  

Dispositivi Sistema
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4.3 Test Sistemi  GSM-Automazione Domestica.
È prevista la possibilità di eseguire il test dei sistemi di automazione domestica definiti nell'impianto, 
attivando, dalla barra degli strumenti del sistema EasyTool, il modulo Test definito nel Sistemi  GSM-
Automazione Domestica. 

La finestra è divisa in cinque cartelle: 

Sistemi  GSM-Automazione Domestica permette di: 

•	 scegliere il sistema di automazione domestica per il quale eseguire il test

•	 verificare lo stato del Modulo di Comunicazione Interna (MCI)

Centrali permette di: 

•	 leggere le informazioni relative alla centrale (tipo centrale, versione hardware, versione software, numero 
dei dispositivi guasti rilevati nell'ultima scansione diagnostica)

•	 leggere tutti i dati rilevati nell'ultima scansione diagnostica relativi agli eventuali dispositivi guasti

•	 avviare una nuova scansione diagnostica
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Comfort permette di: 

•	 verificare lo stato dei dispositivi comfort associati ad un sistema di automazione domestica

•	 impostare la modalità di funzionamento di ciascun dispositivo comfort.

Scenari permette di: 

•	 attivare gli scenari configurati per un sistema di automazione domestica.

Gruppi permette di: 

•	 leggere lo stato dei gruppi configurati per un sistema di automazione domestica

•	 attivare/disattivare ciascun gruppo configurato. 
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4.3.1 Sistemi  GSM-Automazione Domestica

Questa cartella consente di selezionare, tra tutti i sistemi di automazione domestica definiti nell'im-
pianto, quello per il quale deve essere eseguito il test. 

È possibile scorrere i sistemi di automazione domestica configurati con i pulsanti funzione di naviga-
zione, o effettuare una ricerca rapida. 
Per ciascun sistema di automazione domestica vengono visualizzate le informazioni relative alla de-
scrizione ed al punto di accesso. 
Per il sistema di automazione domestica selezionato, viene visualizzata la descrizione nel titolo della 
finestra e viene visualizzato l’elenco dei dispositivi configurati nelle apposite cartelle Centrali, Com-
fort, Scenari e Gruppi. 

La cartella gestisce la possibilità di visualizzare lo stato del Modulo di Comunicazione Interna (MCI). 
A questa funzionalità si accede dal pulsante funzione  tramite il quale viene attivata la finestra 
Stato MCI. 



174

Test Sistemi 

4.3.2 Centrali

Questa cartella visualizza le centrali configurate per il sistema di automazione domestica selezio-
nato nella cartella Sistemi  GSM-Automazione Domestica.

Per ciascuna centrale configurata, vengono visualizzate le informazioni relative al numero della cen-
trale, alla descrizione e all’indirizzo della centrale (area, linea, identificativo centrale).

È prevista la possibilità di visualizzare le informazioni relative a ciascuna centrale selezionando, 
dall'apposita lista, la centrale da verificare, ed attivando la finestra Stato Centrale tramite il pulsante 
funzione . Questa finestra prevede la visualizzazione di informazioni quali il tipo della centrale, la 
versione hardware e software, il numero dei dispositivi guasti rilevati nell'ultima scansione diagnostica 
e tutti i dati rilevati nell'ultima scansione diagnostica relativi agli eventuali dispositivi guasti. 

Per la centrale selezionata, è prevista inoltre la possibilità di avviare una nuova scansione diagnosti-
ca. Questa funzionalità è disponibile attivando la finestra Comanda Centrale dal pulsante funzione 

 oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga della centrale da 
elaborare.  
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4.3.3 Comfort

Questa cartella visualizza i dispositivi comfort configurati per il sistema di automazione domestica 
selezionato nella cartella Sistemi  GSM-Automazione Domestica.

Per ciascuno dei dispositivi comfort configurati, vengono visualizzate le informazioni relative al 
numero comfort, alla descrizione, all’etichetta vocale, all’etichetta SMS predefinita ed utente, all’in-
dirizzo della centrale (area, linea, centrale) e alla zona climatica. 

È gestita la possibilità di visualizzare lo stato di ciascun dispositivo comfort selezionando, dall'ap-
posita lista, il dispositivo da verificare, ed attivando la finestra Stato Comfort tramite il pulsante 
funzione . 

Per il dispositivo comfort selezionato, è prevista inoltre la possibilità di modificare la modalità di fun-
zionamento. Questa funzionalità è disponibile attivando la finestra Stato Comfort dal pulsante fun-
zione  oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga del dispositivo 
da configurare.   
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4.3.4 Scenari

Questa cartella visualizza gli scenari configurati per il sistema di automazione domestica seleziona-
to nella cartella Sistemi  GSM-Automazione Domestica.

Per ciascuno degli scenari configurati, vengono visualizzate le informazioni relative al numero sce-
nario (comunicatore), alla descrizione, all’etichetta vocale, all’etichetta SMS predefinita ed utente, 
all’indirizzo della centrale (area, linea, centrale) e al numero scenario (centrale). 

La cartella prevede la possibilità di attivare uno degli scenari configurati selezionando, dall'appo-
sita lista, lo scenario da attivare, e richiamando la finestra Comanda Scenario tramite il pulsante 
funzione  ; questa finestra può essere richiamata anche eseguendo un doppio click con il tasto 
sinistro del mouse sulla riga dello scenario da attivare. 



177

Test Sistemi

4.3.5 Gruppi

Questa cartella visualizza i gruppi configurati per il sistema di automazione domestica selezionato 
nella cartella Sistemi  GSM-Automazione Domestica.

Per ciascuno dei gruppi configurati vengono visualizzate le informazioni relative al numero gruppo 
(comunicatore), alla descrizione, all’etichetta vocale, all’etichetta SMS predefinita ed utente, all’indi-
rizzo della centrale (area, linea, centrale), al numero gruppo (centrale) ed allo stato Attivo/Disattivo 
del gruppo. 

Lo stato dei gruppi viene visualizzato in automatico dalla procedura leggendo l'informazione dal 
Comunicatore GSM collegato al PC, ed aggiornandola ad intervalli regolari di tempo.
L'intervallo di tempo con il quale viene effettuato l'aggiornamento, è definito nel sistema EasyTool 
dalla funzione attivabile dal menu Utility ► Tempo Refresh.
Lo stato dei gruppi può essere anche aggiornato tramite la funzionalità prevista dal pulsante fun-
zione . 

La cartella prevede la possibilità di modificare, nel Comunicatore GSM collegato al PC, lo stato 
Attivo/Disattivo del gruppo selezionato, attivando la finestra Comanda Gruppo tramite il pulsante 
funzione  oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga del grup-
po da configurare. 
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4.3.6 Stato MCI

È possibile visualizzare lo stato del Modulo di Comunicazione Interna (MCI), tramite la funzionalità 
prevista dal pulsante funzione  presente nella cartella Sistemi  GSM-Automazione Domesti-
ca della finestra Test Sistemi  GSM-Automazione Domestica. 
Nel caso in cui si utilizzi un comunicatore GSM 01941, il Modulo di Comunicazione Interna (MCI) è 
rappresentato dall'interfaccia BUS-Comunicatore 01848.
Nel caso in cui si utilizzi un comunicatore GSM 01942, il Modulo di Comunicazione Interna (MCI) è 
rappresentato dall'interfaccia BUS-Comunicatore integrata nel comunicatore stesso.

Alla sua attivazione, vengono visualizzate le informazioni lette dal Comunicatore GSM collegato al 
PC, e di seguito elencate: 

•	 Stato del Modulo di Comunicazione Interna (ATTIVO TP, ATTIVO RF, DISATTIVO)
•	 Versione del firmware del Modulo di Comunicazione Interna
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4.3.7 Stato centrale

Questa finestra visualizza le informazioni relative alla centrale selezionata nella cartella Centrali, e 
consente la lettura delle informazioni dei dispositivi non funzionanti rilevati dalla centrale durante 
l'ultima scansione. 
Si può accedere a questa funzionalità dalla cartella sopra citata della finestra Test Sistemi  GSM-
Automazione Domestica tramite il pulsante funzione .
Alla sua attivazione, vengono visualizzate le informazioni lette tramite il Comunicatore GSM colle-
gato all'Interfaccia di Comunicazione Interna, e di seguito elencate: 

•	 tipo della centrale (Tipo)

•	 versione hardware (Versione HW)

•	 versione software (Versione SW)

•	 numero dei dispositivi guasti rilevati nell'ultima scansione diagnostica (N. dispositivi guasti)
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Una volta attivata la finestra, è possibile effettuare una nuova lettura della informazioni relative alla 
centrale tramite la funzionalità prevista dal pulsante funzione . 

All'attivazione del pulsante funzione  viene avviata la procedura di lettura delle 
informazioni dei dispositivi non funzionanti che la centrale ha rilevato durante l'ultima scansione.

I dati letti vengono visualizzati nel campo Ultima scansione diagnostica della finestra corrente nel 
quale vengono riportati il dettaglio di ciascun dispositivo guasto ed il numero totale dei dispositivi 
non funzionanti.

Per ciascun dispositivo guasto vengono visualizzate le seguenti informazioni: 

•	 identificativo dell'area (Area)

•	 identificativo della linea (Linea)

•	 indirizzo fisico del dispositivo guasto (ID Dispositivo)

•	 descrizione e codice del tipo di device (Tipo Device)
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•	 tipo di errore (Tipo Errore)

•	 numero dei giorni dall'ultimo reset della centrale (Giorni dall'ultimo reset).

È prevista la possibilità di memorizzare in un file i dati relativi all'ultima scansione diagnostica.

Il salvataggio dei dati avviene tramite attivazione del pulsante funzione  solo 
dopo aver avviato, almeno una volta, la lettura dell'ultima scansione diagnostica e dopo aver spe-
cificato il percorso del file nel quale salvare i dati letti.

Il percorso del file può essere digitato direttamente nell'apposito campo previsto nella finestra, 

oppure può essere specificato tramite l'attivazione del tasto funzione ; in questo caso la pro-
cedura prevede l'attivazione della finestra Salva scansione su file per la ricerca della posizione del 
file e la scrittura in automatico nella finestra del nome del file selezionato.
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4.3.8 Stato comfort

È possibile visualizzare lo stato di ciascun dispositivo comfort configurato in un sistema di auto-
mazione domestica, attivando la finestra Stato Comfort tramite il pulsante funzione  presente 
nella cartella Comfort della finestra Test Sistemi  GSM-Automazione Domestica.

Per ciascun dispositivo comfort configurato nel sistema, è inoltre possibile impostare la modalità di 
funzionamento tramite la finestra Stato Comfort attivabile dalla cartella Comfort della finestra Test 
Sistemi  GSM-Automazione Domestica tramite il pulsante funzione  oppure eseguendo un 
doppio click con il tasto sinistro del mouse sulla riga del dispositivo comfort da configurare.
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All’attivazione della finestra Stato Comfort, vengono visualizzate le informazioni lette tramite il 
Comunicatore GSM collegato all'Interfaccia di Comunicazione Interna, e di seguito elencate:  

•	 Temperatura misurata

•	 Temperatura impostata

•	 Numero di ore (modalità spento a termine o manuale temporaneo)

•	 Modalità di funzionamento

Una volta attivata la finestra, è possibile effettuare una nuova lettura dello stato del dispositivo 
comfort tramite la funzionalità prevista dal pulsante funzione .
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Se la finestra è stata attivata dal pulsante funzione  oppure tramite doppio click del tasto sini-
stro del mouse, è prevista la possibilità di impostare la modalità di funzionamento per il dispositivo 
comfort elaborato.

Sono gestite le seguenti modalità di funzionamento: 

•	 Spento: permette di spegnere il cronotermostato

•	 Spento a Termine: imposta il funzionamento del cronotermostato in modalità spento a termine ed 
il numero delle ore in cui il dispositivo deve mantenere la modalità; il numero delle ore deve essere 
compreso tra 0 e 99

•	 Manuale: imposta il funzionamento del cronotermostato in modalità manuale e la relativa tempe-
ratura; la temperatura impostata deve avere un valore compreso tra 0 e 99,9

•	 Manuale Temporaneo: imposta il funzionamento del cronotermostato in modalità manuale tem-
poraneo, la relativa temperatura ed il numero delle ore; la temperatura impostata deve avere un 
valore compreso tra 0 e 99,9 e le ore devono essere comprese tra 0 e 99

•	 Automatico: imposta la modalità di funzionamento automatico del cronotermostato

•	 Antigelo: imposta il funzionamento del cronotermostato in modalità antigelo e la relativa tempera-
tura; la temperatura impostata deve avere un valore compreso tra 0 e 99,9

•	 Temperature Funzionamento Automatico: imposta i tre livelli di temperatura del cronotermosta-
to per la modalità di funzionamento automatico; vengono impostati i soli livelli indicati; se specifi-
cata, la temperatura di ciascun livello deve avere un valore compreso tra 0 e 99,9.

È inoltre gestita l'impostazione della stagione tramite la selezione di una delle seguenti modalità: 

•	 Riscaldamento: imposta il funzionamento Riscaldamento (inverno)

•	 Condizionamento: imposta il funzionamento Condizionamento (estate)

Il dispositivo comfort viene configurato con la modalità di funzionamento selezionata, tramite l'attiva-
zione del tasto . 
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4.3.9 Comanda centrale

Questa finestra consente di avviare una nuova scansione diagnostica per la centrale selezionata 
nella cartella Centrali della finestra Test Sistemi  GSM-Automazione Domestica. 

Si può accedere a questa funzionalità dalla cartella sopra citata tramite il pulsante funzione    
oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga della centrale da ela-
borare. 

All'attivazione del pulsante tasto , viene avviata la procedura di controllo del funziona-
mento di tutti i dispositivi configurati, tramite la comunicazione con il Comunicatore GSM collegato 
al PC.
Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio 
di avviso.
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4.3.10 Comanda scenario

Questa finestra consente di attivare lo scenario selezionato nella cartella Scenari della finestra 
Test Sistemi  GSM-Automazione Domestica. 
Si può accedere a questa funzionalità dalla cartella sopra citata tramite il pulsante funzione    
oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga dello scenario da 
elaborare. 

All'attivazione del pulsante funzione  , la procedura attiva lo scenario elaborato, tramite 
la comunicazione con il Comunicatore GSM collegato al PC. 
Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio 
di avviso.
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Test Sistemi

4.3.11 Comanda gruppo

Questa finestra consente di attivare o disattivare il gruppo selezionato nella cartella Gruppi della 
finestra Test Sistemi  GSM-Automazione Domestica. 

Si può accedere a questa funzionalità dalla cartella sopra citata tramite il pulsante funzione  
oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga del gruppo da ela-
borare. 

All'attivazione del pulsante funzione , la procedura imposta lo stato Attivo/Disattivo in-
dicato nella finestra per il gruppo elaborato, tramite la comunicazione con il Comunicatore GSM 
collegato al PC. 
Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio 
di avviso.
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4.4 Utility generali

4.4.1 Ricerca dati

È prevista la possibilità di ricercare dei dati appartenenti all'impianto e memorizzati nelle varie car-
telle dell'applicazione, tramite la finestra Ricerca Dati. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella barra degli strumen-
ti delle cartelle dell'applicazione. 

Utility generali

La finestra prevede la possibilità di specificare dei criteri di filtro indicando, negli appositi campi 
previsti, uno o più valori da ricercare.
Possono essere indicati anche filtri parziali specificando, ad esempio, solo alcuni caratteri iniziali 
del valore da ricercare.
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All'attivazione del tasto , la procedura ricerca, tra tutti i dati presenti nella cartella dalla 
quale la finestra è stata attivata, un elemento i cui valori corrispondono a quelli indicati nei campi di 
filtro, e lo visualizza nella cartella stessa.

All'attivazione del tasto , viene ricercato se esiste un altro dato, oltre a quello 
precedentemente visualizzato, che soddisfa alle condizioni di filtro impostate: l'eventuale elemento 
trovato viene riportato nella cartella dalla quale la finestra è stata attivata. 

Utility generali
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4.4.2   Associa file vocale

La selezione di un file contenente la registrazione di un messaggio vocale è gestita dalla finestra 
Associa File Vocale. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nelle cartelle Comfort, 
Scenari e Gruppi della finestra Dispositivi Sistemi  GSM-Automazione Domestica. 

Utility generali

Il file vocale può essere indicato selezionando un elemento dalla lista dei file prevista nella finestra, 
oppure digitando il nome nell'apposito campo. 

È prevista la possibilità di specificare il nome di un file non esistente; in questo caso, una volta disat-
tivata la finestra attuale, dovrà essere effettuata la registrazione del messaggio vocale da inserire 
nel file. Questa funzionalità è gestita dalla finestra Registrazione Messaggi attivabile dalla stessa 
cartella dalla quale è stata richiesta la finestra corrente mediante il pulsante funzione . 

Tramite l'attivazione del pulsante funzione , la procedura prevede la visualizzazione 
del percorso completo del file vocale specificato, nell'apposito campo della cartella dalla quale la 
finestra è stata attivata. 
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Utility generali

4.4.3   Registrazione messaggi

La finestra Registrazione Messaggi prevede la possibilità di ascoltare la registrazione di un mes-
saggio vocale esistente e di effettuare la registrazione di un nuovo messaggio.
Si può accedere a questa funzionalità dal pulsante funzione  previsto nelle cartelle Comfort, 
Scenari e Gruppi della finestra Dispositivi Sistemi  GSM-Automazione Domestica. 

La procedura visualizza, nell'apposito campo, il percorso del file vocale gestito dalla finestra cor-
rente; il nome del file è desunto dalla cartella dalla quale la finestra è stata attivata.

Se il file vocale contiene già la registrazione di un messaggio, questo può essere ascoltato median-
te l'attivazione del tasto . 

La finestra prevede inoltre la possibilità di effettuare la registrazione di un nuovo messaggio 
vocale. Questa funzionalità è gestita dal tasto , la cui attivazione dà inizio alla fase di regi-
strazione che ha termine con la selezione del tasto .

Il nuovo messaggio registrato può essere ascoltato, sempre mediante l'attivazione del tasto
, e può essere salvato nel file vocale gestito dalla finestra. Questa funzionalità è attivabile dal tasto 

, previo richiesta di conferma a procedere. 
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Utility generali

4.4.4 Help

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del 
sistema EasyTool, oppure attraverso il tasto F1 dalle finestre principali. 
Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato 
(ad esempio: premendo F1 dalla finestra “Parametri di Configurazione Sistemi  GSM-Automazione 
Domestica” verrà visualizzata la parte dell'help relativa ai parametri generali dei sistemi di automa-
zione domestica configurati in un impianto).
Selezionando il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta 
essere in primo piano tra tutte quelle attive nell’applicazione.



193

4.5 Esempio Applicativo

4.5.1 Descrizione

Esempio di gestione da remoto di un sistema composto da:
•	 2 zone climatiche
•	 2 luci comandate da due punti
•	 2 scenari definiti (ingresso, uscita)
•	 Invio di messaggio vocale di allarme a un numero telefonico in caso di allarme intrusione.

Per l’elenco dei dispositivi e lo schema del sistema vedere il manuale delle istruzioni dell’Interfaccia 
di Comunicazione Interna tra il sistema BUS e il comunicatore telefonico (paragrafo 15).

Operazioni da eseguire

1.	Attivare la finestra Parametri di configurazione ed inserire, nella cartella Generali, un nuovo 
sistema di automazione domestica (vedere i paragrafi 4.1 e 4.1.1)

2.	Attivare la finestra Dispositivi e selezionare, nella cartella Sistemi  GSM-Automazione Domesti-
ca, il sistema da gestire (vedere i paragrafi 4.2 e 4.2.1).

3.	Arruolare la centrale di controllo nel seguente modo:

3.1.	 Selezionare la cartella Centrali ed inserire una nuova centrale specificando, come dati di 
configurazione, l’indirizzo che identifica la centrale (vedere il paragrafo 4.2.2); i valori da 
specificare sono quelli visualizzati nella centrale di controllo tramite il menu Diagnostica-
Informazioni (vedere manuale istruzioni della centrale di controllo).

3.2.	Dopo aver confermato i dati della centrale inserita, eseguire, per la centrale stessa, la pro-
cedura di configurazione del Comunicatore GSM collegato al PC tramite il pulsante funzione 

  (vedere il paragrafo 4.2.2).

4.	Arruolare le zone climatiche 1 e 2 della centrale di controllo utilizzando la procedura automatica 
oppure quella manuale:
4.1.	 Automatica: sempre dalla cartella Centrali, attivare la procedura di arruolamento per la 

centrale precedentemente inserita (punto 3.1), tramite il pulsante funzione  (vedere il 
paragrafo 4.2.2).

4.2.	Manuale (vedere il paragrafo 4.2.3): 
4.2.1.	 selezionare la cartella Comfort 
4.2.2.	 inserire un nuovo elemento (comfort n. 1) indicando, come dati di configurazione, 

l’indirizzo della centrale di controllo e la zona climatica 1
4.2.3.	 confermare il dispositivo comfort inserito ed eseguire la procedura di configurazione 

del Comunicatore GSM tramite il pulsante funzione . 
4.2.4.	 inserire un nuovo elemento (comfort n. 2) indicando, come dati di configurazione, 

l’indirizzo della centrale di controllo e la zona climatica 2
4.2.5.	 confermare il dispositivo comfort inserito ed eseguire la procedura di configurazione 

del Comunicatore GSM tramite il pulsante funzione .  

Si presuppone che le due zone climatiche siano abilitate, sulla centrale di controllo, alla gestione 
da remoto.

Esempio applicativo
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5.	Personalizzare eventualmente i due dispositivi comfort associando un messaggio vocale utente 
o un’etichetta SMS utente, selezionando la cartella Comfort e modificando il dispositivo da 
personalizzare (vedere il paragrafo 4.2.3).

	 Dopo aver effettuato le modifiche sui dati di un dispositivo comfort, eseguire la procedura di 
configurazione del Comunicatore GSM tramite il pulsante funzione .

	 Di default il “termostato 1” possiede l'etichetta vocale “termostato uno” e l'etichetta SMS “C1”, 
mentre il “termostato 2” possiede le etichette “termostato due” e “C2”.

6.	Arruolare gli scenari 1 e 2 della centrale di controllo utilizzando la procedura automatica oppure 
quella manuale:

6.1.	 Automatica: dalla cartella Centrali, attivare la procedura di arruolamento per la centrale 
precedentemente inserita (punto 3.1), tramite il pulsante funzione   (vedere il paragrafo 
4.2.2)

6.2.	Manuale (vedere il paragrafo 4.2.4): 

6.2.1.	 selezionare la cartella Scenari  

6.2.2.	 inserire un nuovo elemento (scenario n. 1) indicando, come dati di configurazione, 
l’indirizzo della centrale di controllo e il numero scenario (centrale) 1

6.2.3.	 confermare lo scenario inserito ed eseguire la procedura di configurazione del Co-
municatore GSM tramite il pulsante funzione  

6.2.4.	 inserire un nuovo elemento (scenario n. 2) indicando, come dati di configurazione, 
l’indirizzo della centrale di controllo e il numero scenario (centrale) 2

6.2.5.	 confermare lo scenario inserito ed eseguire la procedura di configurazione del Co-
municatore GSM tramite il pulsante funzione   

Si presuppone che i due scenari siano abilitati, sulla centrale di controllo, alla gestione da re-
moto.

7.	 Personalizzare eventualmente i due scenari associando un messaggio vocale utente o un’eti-
chetta SMS utente, selezionando la cartella Scenari e modificando lo scenario da personalizza-
re (vedere il paragrafo 4.2.4). 

	 Dopo aver effettuato le modifiche sui dati di uno scenario, eseguire la procedura di configurazio-
ne del Comunicatore GSM tramite il pulsante funzione .

	 Di default lo “scenario 1” possiede l'etichetta vocale “scenario uno” e l'etichetta SMS “SC1”, 
mentre lo “scenario 2” possiede le etichette “scenario due” e “SC2”.

Esempio applicativo
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8.	Arruolare i gruppi 1 e 2 della centrale di controllo tramite la procedura manuale (vedere il para-
grafo 4.2.5):

8.1.	 selezionare la cartella Gruppi

8.2.	inserire un nuovo elemento (gruppo n. 1) indicando, come dati di configurazione, l’indirizzo 
della centrale di controllo e il numero gruppo (centrale) 1

8.3.	personalizzare eventualmente il gruppo associando un messaggio vocale utente o un’eti-
chetta SMS utente; il “gruppo 1” possiede l’etichetta vocale “gruppo uno”

8.4.	confermare il gruppo inserito ed eseguire la procedura di configurazione del Comunicatore 
GSM tramite il pulsante funzione   

8.5.	inserire un nuovo elemento (gruppo n. 2) indicando, come dati di configurazione, l’indirizzo 
della centrale di controllo e il numero gruppo (centrale) 2

8.6.	personalizzare eventualmente il gruppo associando un messaggio vocale utente o un’eti-
chetta SMS utente; il “gruppo 2” possiede l’etichetta vocale “gruppo due”

8.7.	 confermare il gruppo inserito ed eseguire la procedura di configurazione del Comunicatore 
GSM tramite il pulsante funzione   

9.	Impostare il numero di telefono al quale inoltrare la chiamata vocale di allarme proveniente dalla 
centrale del sistema antintrusione via bus (vedere il manuale istruzioni del Comunicatore):

9.1.	 attivare la finestra Parametri di configurazione del sistema Comunicatore

9.2.	selezionare, nella cartella Generali, il modulo GSM indicato come punto di accesso del 
sistema di automazione domestica

9.3.	selezionare la cartella Rubrica Telefonica e memorizzare il numero di telefono in una delle 
posizioni libere

9.4.	confermare il numero telefonico ed eseguire la procedura di configurazione del Comunica-
tore GSM tramite il pulsante funzione   

10. Associare il messaggio di allarme 3 al numero di telefono appena inserito (vedere il manuale 
istruzioni del Comunicatore):

10.1.	 sempre dalla finestra Parametri di configurazione del sistema Comunicatore, selezio-
nare la cartella Messaggi Vocali 

10.2.	 modificare il messaggio MSG 3, associare il numero di telefono inserito nella rubrica telefo-
nica e personalizzare il messaggio vocale di allarme, registrando il messaggio desiderato

10.3.	 confermare le modifiche effettuate ed eseguire la procedura di configurazione del Comu-
nicatore GSM tramite il pulsante funzione   

Esempio applicativo
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Sezione 2.2.3
Antintrusione

Comunicatori GSM
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Requisiti - Installazione - Descrizione funzionale
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1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

3. Descrizione funzionale del software GSM-Antintrusione – lato PC

3.1 Funzionalità
Il software per PC contenuto nel CD ed allegato al sistema GSM-Antintrusione, permette di:

• definire i parametri di configurazione dei Sistemi Antintrusione 

• richiedere lo stato dei Sistemi  Antintrusione

•	inserire e/o disinserire l'antintrusione. 

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.
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Le funzionalità

4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

 	 Ricerca un dato tra quelli della cartella

Pulsanti di edit:

 	 Mette in modifica il dato visualizzato

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione scambio dati tra PC e dispositivo:

 	 Importa nella cartella i dati dal Comunicatore GSM collegato al PC

 	 Configura il Comunicatore GSM collegato al PC con i dati presenti nella cartella

Segue il dettaglio delle finestre dell’applicazione e delle operazioni che rendono disponibili.

La sequenza è utile anche come schema per la configurazione di un Comunicatore GSM di un impianto.
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4.1 Parametri di configurazione Sistema  GSM-Antintrusione.
Alla configurazione dei parametri dei Sistemi  Antintrusione si accede attivando, dalla barra degli strumenti 
del sistema EasyTool, il modulo Parametri di configurazione definito nel Sistema  GSM-Antintrusione. 

Parametri di configurazione

La finestra è formata da una sola cartella Generali che permette di: 

• modificare i Sistemi  Antintrusione di un impianto
•	 importare la configurazione dei parametri del sistema leggendo i dati dal Comunicatore GSM collegato 

al PC
•	 configurare il comunicatore GSM collegato al PC con i parametri definiti in un Sistema  Antintrusione
•	 ripristinare le impostazioni iniziali del Comunicatore GSM collegato al PC.
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4.1.1 Generali

Questa cartella gestisce la configurazione generale dei Sistemi  Antintrusione definiti in un 
impianto.

È possibile modificare i parametri dei sistemi Antintrusione precedentemente inseriti.
È inoltre possibile scorrere i Sistemi  Antintrusione configurati con i pulsanti funzione di navigazione, 
o effettuare una ricerca rapida. 
La descrizione del Sistema  Antintrusione corrente, quello cioè selezionato nella cartella, viene 
visualizzata nel titolo della finestra.

Per ciascun Sistema  Antintrusione sono gestiti i seguenti parametri di configurazione generale:  

•	 Descrizione: descrizione del Sistema  Antintrusione; deve essere obbligatoriamente specificata 
ed identifica il Sistema  Antintrusione nell'impianto. 

•	 Versione: identifica il tipo di Sistema  Antintrusione SAI.

•	 Punto di accesso: identifica il dispositivo che permette la comunicazione del sistema con il PC; 
deve essere obbligatoriamente indicato selezionando uno dei moduli GSM definiti nell'impianto.

	 Un modulo GSM può essere impostato come punto di accesso di un solo Sistema  Antintrusio-

ne.  In caso contrario, in fase di conferma dei dati della cartella tramite il pulsante ffunzione , 
viene segnalato il seguente errore:

Parametri di configurazione
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Parametri di configurazione

	 È possibile importare la configurazione dei parametri del Sistema  Antintrusione dal Comunica-

tore GSM collegato al PC tramite l'attivazione del pulsante funzione .
	 Questa funzionalità prevede la sostituzione dei parametri del Sistema  GSM-Antintrusione cor-

rente con quelli letti dal Comunicatore GSM. 

	 Con i parametri impostati nel Sistema  GSM-Antintrusione corrente, è possibile configurare il 
Comunicatore GSM collegato al PC.

	 Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da 
PC a dispositivo dei parametri impostati nella cartella corrente.

	 Questa cartella gestisce inoltre la possibilità di ripristinare le impostazioni iniziali del Comunica-

tore GSM collegato al PC, tramite l'attivazione del pulsante funzione .
	 Questa funzionalità ha effetto solo sul dispositivo, non prevede quindi la modifica dei parametri 

configurati nella cartella attuale.  
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Parametri di configurazione

4.2 Dispositivi Sistema GSM-Antintrusione 
Alla dei dispositivi per ciascun Sistema  Antintrusione definito nell’impianto, si accede attivando, dalla barra 
degli strumenti del sistema EasyTool, il modulo Dispositivi definito nel Sistema  GSM-Antintrusione. 

L'aspetto delle cartelle ed i parametri di configurazione dipendono dal tipo di centrale antintrusione e dal 
tipo e versione firmware del comunicatore GSM. 

La finestra è divisa nelle seguenti cartelle: 
Antintrusione permette di: 
•	 scegliere il Sistema  Antintrusione da configurare; 
•	 copiare i dispositivi da un Sistema  Antintrusione già configurato; 
•	 importare la configurazione dei dispositivi leggendo i dati dal Comunicatore GSM collegato al PC; 
•	 configurare il comunicatore GSM collegato al PC con i dispositivi definiti in un Sistema  Antintrusione. 

Allarmi Tecnici permette di: 
•	 inserire, modificare, eliminare gli allarmi tecnici per ciascun Sistema  Antintrusione; 
•	 copiare un allarme tecnico già configurato per un altro Sistema  Antintrusione esistente in un impianto 

dell'applicazione; 
•	 importare la configurazione degli allarmi tecnici leggendo i dati dal Comunicatore GSM collegato al PC; 
•	 configurare il comunicatore GSM collegato al PC con i dati degli allarmi tecnici gestiti nella cartella. 



206

Parametri di configurazione

4.2.1  Antintrusione

Questa cartella consente di selezionare, tra tutti i Sistemi  Antintrusione definiti nell'impianto, 
quello per il quale deve essere gestita la configurazione dei dispositivi 

È possibile scorrere i Sistemi  Antintrusione configurati con i pulsanti funzione di navigazione, o 
effettuare una ricerca rapida. 
Per il Sistema  Antintrusione selezionato, viene visualizzata la descrizione nel titolo della finestra e 
viene visualizzata nel dettaglio la configurazione degli allarmi tecnici nell'apposita cartella Allarmi 
Tecnici. 3

La cartella gestisce la possibilità di copiare, nel Sistema  Antintrusione selezionato, la configura-
zione dei dispositivi di un altro Sistema  Antintrusione definito in un impianto dell'applicazione. A 
questa funzionalità si accede dal pulsante funzione  tramite il quale viene attivata la finestra 
Copia Dispositivi.

È possibile importare nel Sistema  Antintrusione selezionato, la configurazione dei dispositivi 
leggendo i dati dal Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione 

 del sistema selezionato.

Questa funzionalità prevede la sostituzione di tutti gli allarmi tecnici del Sistema  Antintrusione 
selezionato, con quelli letti dal Comunicatore GSM. Nel caso di importazione di un allarme tecnico 
che non risulta essere configurato nella relativa cartella, è previsto il suo inserimento automatico 
con una descrizione predefinita. 

Con i dati dei dispositivi associati al Sistema  Antintrusione selezionato, è possibile configurare il 
Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  del sistema  selezionato e pre-
vede il trasferimento da PC a dispositivo dei dati relativi a tutti gli allarmi tecnici associati al Sistema  
Antintrusione selezionato.
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4.2.2 Allarmi Tecnici

Questa cartella gestisce i dati degli allarmi tecnici configurati per il sistema di automazione dome-
stica selezionato nella cartella Sistemi Automazione Domestica.

Ogni sistema di automazione domestica può gestire fino ad un massimo di:
•	 1 allarme tecnico per il Comunicatore GSM 01941;
•	 8 allarmi tecnici per il Comunicatore GSM 01942.
La cartella gestisce l'inserimento di nuovi allarmi, la modifica e la cancellazione degli allarmi tecnici 
già esistenti.
Prevede inoltre la possibilità di scorrere gli allarmi configurati con i pulsanti funzione di navigazione, 
o di effettuare una ricerca rapida. 

Per ciascun allarme tecnico sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione dell'allarme tecnico; deve essere obbligatoriamente inserita ed identifi-
ca l'allarme tecnico all'interno di un sistema di automazione domestica.

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Descrizione Allarme Tecnico Utente: descrizione aggiuntiva che consente di riconoscere il 
tipo di allarme tecnico (es. gas, fumo, acqua, ecc.); se specificata, sarà concatenata in fase di 
composizione dei messaggi SMS relativi agli allarmi tecnici; possono essere inseriti al massimo 
10 caratteri (solo per Comunicatore GSM 01942) . 

•	 N.Allarme Tecnico: numero dell'allarme tecnico relativamente al comunicatore; il valore inserito 
deve essere compreso tra 1 e 8; non può essere indicato lo stesso numero per due diversi 
allarmi tecnici appartenenti allo stesso Sistema  Antintrusione; è utilizzato per la composizione 
dei messaggi da inviare al Comunicatore GSM. 

	 Nota: il Comunicatore GSM 01941 può gestire un solo allarme tecnico. 
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•	 Dati di configurazione: identificano univocamente l'allarme tecnico all'interno di un Sistema  
Antintrusione; devono essere obbligatoriamente inseriti e sono composti dal valore del gruppo o 
dall'indirizzo del gruppo: 

•	 Valore Gruppo: identifica il gruppo al quale deve essere associato il messaggio di allarme 
tecnico. Il valore del gruppo da inserire corrisponde alla zona della centrale antintrusione SAI 
in cui è inserita l'interfaccia contatti che genera l'allarme tecnico. Il valore del gruppo deve 
essere compreso tra 1 e 31. 

	 Nota: tale impostazione deve essere utilizzata se la centrale antintrusione SAI appartiene ad 
uno dei tipi: 14480, 16930, 20480. 

•	 Indirizzo Gruppo: rappresenta l'indirizzo di gruppo a cui appartiene l'interfaccia contatti (4 
cifre esadecimali). Se il valore dell'indirizzo di gruppo è 0xABCD, il parametro da inserire è 
ABCD.  

	 Nota: tale impostazione deve essere utilizzata in tutti i casi in cui l'interfaccia contatti dell'allar-
me tecnico non appartiene ad un impianto gestito da una delle seguenti centrali SAI: 14480, 
16930, 20480. 

È possibile copiare un allarme tecnico già configurato per un altro Sistema  Antintrusione esi-

stente in un impianto dell'applicazione. A questa funzionalità si accede dal pulsante  funzione  
tramite il quale viene attivata la finestra Copia Allarme Tecnico.

Tramite l'attivazione del pulsante funzione  è possibile importare, dal Comunicatore GSM 
collegato al PC, le informazioni relative all'allarme tecnico visualizzato nella cartella corrente. 
Questa funzionalità prevede la sostituzione dei dati dell'allarme tecnico con quelli letti dal Comu-
nicatore GSM. 
Le impostazioni dell'allarme tecnico visualizzato nella cartella corrente, possono essere configu-
rate nel Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da 
PC a dispositivo delle informazioni relative all'allarme tecnico. 
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4.2.3 Copia dispositivi

Per il Sistema  Antintrusione selezionato nella cartella Antintrusione della finestra Dispositivi 
Sistema  GSM-Antintrusione, è possibile importare i dispositivi configurati per un altro Sistema  
Antintrusione esistente in un impianto dell'applicazione.  

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Antintru-
sione.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati e, dalla lista Sistemi  Antintrusione, il sistemaantintrusione al quale sono 
associati i dispositivi da duplicare nel sistema corrente. 

All’attivazione del tasto , i dispositivi configurati per il Sistema  Antintrusione selezionato 
nella finestra, sostituiranno tutti i dispositivi del sistema corrente (allarmi tecnici). 

È prevista la possibilità di effettuare l'operazione di copia anche da un sistemaantintrusione esi-
stente nello stesso impianto elaborato: verranno in questo caso visualizzati, nell'apposita lista, tutti i 
sistemi dell'impianto ad esclusione di quello corrente. 
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4.2.4  Copia Allarme Tecnico

Per il Sistema  Antintrusione selezionato nella cartella Antintrusione della finestra Dispositivi 
Sistema  Antintrusione è possibile importare un allarme tecnico configurato per un altro Siste-
ma  Antintrusione esistente in un impianto dell'applicazione. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Allarmi 
Tecnici.

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto 
dal quale importare i dati, dalla lista Sistemi  Antintrusione, il Sistema  Antintrusione al quale è 
associato il dispositivo da duplicare e, dalla lista Allarmi Tecnici, l'allarme tecnico da duplicare nel 
sistema corrente. 

Nel caso in cui l'allarme tecnico da copiare ha lo stesso numero allarme tecnico (comunicatore) 
o gli stessi dati di configurazione di un allarme tecnico già configurato nel Sistema  Antintrusione 
corrente, verrà richiesta una conferma a procedere all'operazione di copia e, nel caso di risposta 
affermativa, verrà richiesta la modifica dei dati dell'allarme tecnico da copiare; questa operazione 
è gestita dalla finestra Copia Allarme Tecnico - Modifica Dati. 

Parametri di configurazione
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Nel caso in cui l'allarme tecnico da copiare presenta una descrizione uguale a quella di un allarme tec-
nico già configurato nel Sistema  Antintrusione corrente ma dati di configurazione diversi, verrà richiesta 
una conferma a procedere all'operazione di copia e, nel caso di risposta affermativa, verrà richiesta 
l'inserimento di una nuova descrizione da attribuire all'allarme tecnico da importare. 

Parametri di configurazione

L'allarme tecnico selezionato per la copia verrà aggiunto agli allarmi tecnici già configurati nel Sistema  
Antintrusione corrente.
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4.3 Test Sistema  GSM-Antintrusione.
È prevista la possibilità di eseguire il test dei Sistemi  Antintrusione definiti nell'impianto, attivando, dalla 
barra degli strumenti del sistema EasyTool, il modulo Test definito nel Sistema  Antintrusione. 

La finestra è formata da una sola cartella Antintrusione che permette di: 

•	 scegliere il Sistema  Antintrusione per il quale eseguire il test

•	 verificare lo stato del Modulo di Comunicazione Interna (MCI)

•	 richiedere le informazioni relative allo stato del Sistema  Antintrusione

•	 inserire e/o disinserire il sistema.
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4.3.1 Antintrusione

Questa cartella consente di selezionare, tra tutti i Sistemi  Antintrusione definiti nell'impianto, 
quello per il quale deve essere eseguito il test.  

È possibile scorrere i Sistemi  Antintrusione configurati con i pulsanti funzione di navigazione, o 
effettuare una ricerca rapida. 
Per ciascun Sistema  Antintrusione vengono visualizzate le informazioni relative alla descrizione ed 
al punto di accesso. 
La descrizione del Sistema  Antintrusione selezionato viene visualizzata nel titolo della finestra.

La cartella gestisce la possibilità di visualizzare lo stato del Modulo di Comunicazione Interna (MCI). 
A questa funzionalità si accede dal pulsante funzione  tramite il quale viene attivata la finestra 
Stato MCI. 

Tramite l'attivazione del pulsante funzione  vengono visualizzate, nella finestra Stato Sistema, 
le informazioni relative allo stato del Sistema  Antintrusione selezionato. 

Un Sistema  Antintrusione può essere inserito o disinserito dalla finestra Comanda Sistema atti-
vabile dal pulsante funzione . La finestra può essere attivata anche eseguendo un doppio click 
con il tasto sinistro del mouse sulla riga del Sistema  Antintrusione da elaborare. 
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4.3.2 Stato MCI

È possibile visualizzare lo stato del Modulo di Comunicazione Interna (MCI), tramite la funziona-
lità prevista dal pulsante funzione   presente nella cartella Antintrusione della finestra Test 
Sistema  Antintrusione. 

Alla sua attivazione, vengono visualizzate le informazioni lette dal Comunicatore GSM collegato al 
PC, e di seguito elencate: 

•	 Stato del Modulo di Comunicazione Interna (ATTIVO TP, ATTIVO RF, DISATTIVO)
•	 Versione del firmware del Modulo di Comunicazione Interna
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4.3.3 Stato sistema

Questa finestra visualizza lo stato del Sistema  Antintrusione selezionato nella cartella Antintru-
sione della finestra Test Sistema  Antintrusione. 
Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella sopra 
citata. 
 

Alla sua attivazione, vengono visualizzate le seguenti informazioni relative allo stato del sistema 
lette tramite il Comunicatore GSM collegato all'Interfaccia di Comunicazione Interna:

•	 Antintrusione inserito/disinserito (INSERITO / DISINSERITO)

•	 Antintrusione parzializzato/non parzializzato (PARZIALIZZATO/NON PARZIALIZZATO)

•	 Allarme intrusione (ALLARME INTRUSIONE/NO ALLARME INTRUSIONE)

•	 Allarme tamper (ALLARME TAMPER/NO ALLARME TAMPER)

•	 Memoria allarme (MEMORIA/NO MEMORIA).

Una volta attivata la finestra, è possibile effettuare una nuova lettura dello stato del sistema trami-
te la funzionalità prevista dal pulsante funzione .  

Test Sistema
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4.3.4 Comanda sistema

Questa finestra consente di inserire o disinserire il Sistema  Antintrusione selezionato nella cartella 
Antintrusione della finestra Test Sistema  Antintrusione. 

Si può accedere a questa funzionalità dalla cartella sopra citata tramite il pulsante funzione  
oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga del Sistema  Antintru-
sione da elaborare. 

All'attivazione del pulsante funzione , la procedura attiva o disattiva il sistema elabora-
to, tramite il Comunicatore GSM collegato all'Interfaccia di Comunicazione Interna.

Il buon esito dell’operazione viene segnalato tramite la visualizzazione di un apposito messaggio 
di avviso.  
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4.4 Utility generali

4.4.1 Ricerca dati

È prevista la possibilità di ricercare dei dati appartenenti all'impianto e memorizzati nelle varie 
cartelle dell'applicazione, tramite la finestra Ricerca Dati. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella barra degli stru-
menti delle cartelle dell'applicazione. 

Utility generali

La finestra prevede la possibilità di specificare dei criteri di filtro indicando, negli appositi campi 
previsti, uno o più valori da ricercare.
Possono essere indicati anche filtri parziali specificando, ad esempio, solo alcuni caratteri iniziali 
del valore da ricercare. 
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All'attivazione del tasto , la procedura ricerca, tra tutti i dati presenti nella cartella 
dalla quale la finestra è stata attivata, un elemento i cui valori corrispondono a quelli indicati nei 
campi di filtro, e lo visualizza nella cartella stessa.

All'attivazione del tasto , viene ricercato se esiste un altro dato, oltre a 
quello precedentemente visualizzato, che soddisfa alle condizioni di filtro impostate: l'eventuale 
elemento trovato viene riportato nella cartella dalla quale la finestra è stata attivata

Utility generali
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4.4.2   Help

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del 
sistema EasyTool, oppure attraverso il tasto F1 dalle finestre principali. 
Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato 
(ad esempio: premendo F1 dalla finestra “Parametri di Configurazione Sistema  Antintrusione” 
verrà visualizzata la parte dell'help relativa ai parametri generali dei Sistemi  Antintrusione configu-
rati in un impianto).
Selezionando il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta 
essere in primo piano tra tutte quelle attive nell’applicazione.
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4.5 Esempio Applicativo

4.5.1 Attivazione e test di un Sistema  Antintrusione

Esempio di gestione di un Sistema  Antintrusione con invio di un messaggio SMS di allarme ad 
un numero telefonico in caso di allarme tecnico proveniente dalla centrale antintrusione.

Operazioni da eseguire

1.	 Impostare il numero di telefono al quale inoltrare il messaggio SMS di allarme tecnico prove-
niente dalla centrale antintrusione (vedere il manuale istruzioni del Comunicatore):

1.1.	 attivare la finestra Parametri di configurazione del sistema Comunicatore

1.2.	selezionare, nella cartella Generali, il modulo GSM indicato come punto di accesso del 
Sistema  Antintrusione

1.3.	selezionare la cartella Rubrica Telefonica e memorizzare il numero di telefono in una 
delle posizioni libere

1.4.	confermare il numero telefonico ed eseguire la procedura di configurazione del Comunica-
tore GSM tramite il pulsante funzione   

2.	Arruolare la centrale di controllo nel seguente modo:

2.1.	 sempre dalla finestra Parametri di configurazione del sistema Comunicatore, selezio-
nare la cartella SMS 

2.2.	modificare il messaggio SMS 4, associare il numero di telefono inserito nella rubrica 
telefonica ed eventualmente impostare un ulteriore messaggio SMS da accodare a quello 
preimpostato di “ALLARME TECNICO”

2.3.	confermare le modifiche effettuate ed eseguire la procedura di configurazione del Comu-
nicatore GSM tramite il pulsante funzione   

3.	Attivare la finestra Test del Sistema  Antintrusione e selezionare, nella cartella Antintrusione, il 
sistema da gestire (vedere i paragrafi 4.2 e 4.2.1).

4.	Attivare la finestra Comanda Sistema tramite il pulsante funzione , per attivare il Sistema  
Antintrusione selezionato (vedere i paragrafi 4.2.1 e 4.2.4).

5.	Attivare la finestra Stato Sistema tramite il pulsante funzione , per visualizzare lo stato del 
Sistema  Antintrusione selezionato (vedere i paragrafi 4.2.1 e 4.2.3).

Esempio Applicativo
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Comunicatori GSM

Sezione 2.2.4
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Requisiti - Installazione - Funzionalità - Connessione

226

1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

3. Descrizione funzionale del software GSM ClimaRadio – lato PC

3.1 Funzionalità
Il software per PC contenuto nel CD, allegato al Sistema  GSM-ClimaRadio, permette di:  
• definire i parametri di configurazione dei sistemi radio
• configurare i cronotermostati
• eseguire il test del Modulo di Comunicazione Interna (MCI)
• eseguire il test dei cronotermostati configurati ed impostare, per ciascuno, la modalità di funzionamento

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.
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4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

 	 Ricerca un dato tra quelli della cartella

Pulsanti di edit:

 	 Mette in modifica il dato visualizzato

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione scambio dati tra PC e dispositivo:

 	 Importa nella cartella i dati dal Comunicatore GSM collegato al PC

 	 Configura il Comunicatore GSM collegato al PC con i dati presenti nella cartella

Segue il dettaglio delle finestre dell’applicazione e delle operazioni che rendono disponibili.

La sequenza è utile anche come schema per la configurazione di un Comunicatore GSM di un impianto.
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4.1 Parametri di configurazione GSM-ClimaRadio. 
Alla configurazione dei parametri dei sistemi radio si accede attivando, dalla barra degli strumenti del 
sistema EasyTool, il modulo Parametri di configurazione definito nel Sistema  GSM-ClimaRadio. 

La finestra è divisa in due cartelle che corrispondono ai parametri impostabili nei sistemi radio.

Parametri di configurazione
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Le cartelle sono: 

Generali permette di: 

•	 modificare i sistemi radio

•	 importare la configurazione dei parametri dal Comunicatore GSM collegato al PC

•	 configurare il comunicatore GSM collegato al PC con i parametri definiti in un sistema radio

•	 ripristinare le impostazioni iniziali del Comunicatore GSM collegato al PC

SMS permette di: 

•	 associare i numeri telefonici ai messaggi SMS; 

•	 importare i messaggi SMS dal Comunicatore GSM collegato al PC; 

•	 configurare il Comunicatore GSM collegato al PC con i messaggi SMS gestiti nella cartella. 

Parametri di configurazione
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4.1.1 Generali

Questa cartella gestisce la configurazione generale dei sistemi radio definiti in un impianto. 

È possibile inserire nuovi sistemi radio, modificare i parametri e cancellare i sistemi radio già esistenti 
e modificare i parametri dei sistemi radio precedentemente inseriti.
È inoltre possibile scorrere i sistemi radio configurati con i pulsanti funzione di navigazione, o effet-
tuare una ricerca rapida. 
La descrizione del sistema radio corrente, quello cioè selezionato nella cartella, viene visualizzata 
nel titolo della finestra.
Nella cartella SMS collegata alla presente, sono gestiti i messaggi SMS configurati per il sistema 
radio corrente. 

Per ciascun sistema radio sono gestiti i seguenti parametri di configurazione generale:  

•	 Descrizione: descrizione del sistema radio; deve essere obbligatoriamente specificata ed iden-
tifica il sistema radio nell'impianto. 

•	 Versione: identifica il tipo di sistema radio.

•	 Punto di accesso: identifica il dispositivo che permette la comunicazione del sistema con il PC; 
deve essere obbligatoriamente indicato selezionando uno dei moduli GSM definiti nell'impianto.

	 Un modulo GSM può essere impostato come punto di accesso di un solo sistema radio.  In 

caso contrario, in fase di conferma dei dati della cartella tramite il pulsante funzione , viene 
segnalato il seguente errore:
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La modifica del punto di accesso di un sistema radio, implica la modifica dei messaggi SMS confi-
gurati e delle relative associazioni con i numeri telefonici. In questo caso, il salvataggio della modifica 
sarà effettuato solo previo esplicita richiesta di conferma. 

È possibile importare nel sistema radio, i parametri di configurazione impostati nel Comunicatore 

GSM collegato al PC tramite l'attivazione del pulsante funzione .
Questa funzionalità prevede la sostituzione dei parametri del sistema radio corrente con quelli letti 
dal Comunicatore GSM. In particolare, vengono sostituiti i parametri gestiti dalla cartella attuale, i 
messaggi sms associati al sistema radio con i relativi numeri telefonici configurati. 

Con i parametri impostati nel sistema radio corrente, è possibile configurare il Comunicatore GSM 
collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione   e prevede il trasferimento da 
PC a dispositivo dei parametri impostati nella cartella corrente e dei messaggi sms associati al 
sistema radio elaborato. 

Questa cartella gestisce inoltre la possibilità di ripristinare le impostazioni iniziali del Comunicatore 

GSM collegato al PC, tramite l'attivazione del pulsante funzione .
Questa funzionalità ha effetto solo sul dispositivo, non prevede quindi la modifica dei parametri 
configurati nella cartella attuale ed in quelle collegate.  
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4.1.2 SMS

Questa cartella contiene i messaggi SMS configurati per il sistema radio selezionato nella cartella  
Generali.

Ogni sistema radio può gestire 2 messaggi SMS, predefiniti e non modificabili (Batterie cronotermo-
stato in esaurimento e Batterie base radio in esaurimento).
A ciascun messaggio SMS configurato possono essere associati uno o più numeri telefonici.
La cartella prevede la possibilità di scorrere i messaggi SMS configurati con i pulsanti funzione di 
navigazione, o di effettuare una ricerca rapida.  

Per ciascun messaggio SMS sono gestite le seguenti informazioni: 

•	 Descrizione: descrizione del messaggio SMS; non è modificabile. 

•	 Testo: testo del messaggio SMS; non è modificabile.  

•	 Numeri telefonici associati: lista dei numeri di telefono gestiti nella rubrica telefonica del comu-
nicatore GSM indicato come punto di accesso del sistema radio; ciascun numero può essere 
associato o meno al messaggio SMS corrente.

	 Le modifiche effettuate sull'associazione dei numeri telefonici per uno dei due messaggi, verran-
no applicate in automatico sia all'altro messaggio che ai due messaggi predefiniti di Assenza e 
Ripristino tensione di rete gestiti dal sistema Comunicatore; questa operazione di allineamento 
dei numeri telefonici per i messaggi sopra indicati è preceduta dalla visualizzazione di un'apposita 
segnalazione di avviso. 
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	 È possibile importare le informazioni relative al messaggio SMS corrente dal Comunicatore GSM 

collegato al PC tramite l'attivazione del pulsante funzione . Questa funzionalità prevede la sosti-
tuzione dei dati del messaggio SMS con quelli letti dal Comunicatore GSM. 

	 Il messaggio SMS definito nella cartella corrente, può essere configurato nel Comunicatore GSM 
collegato al PC.

	 Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative al messaggio SMS visualizzato nella cartella corrente. 
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4.2 Dispositivi ClimaRadio 
Alla configurazione dei dispositivi per ciascun sistema radio definito nell’impianto, si accede attivando, dalla 
barra degli strumenti del sistema EasyTool, il modulo Dispositivi definito nel Sistema  GSM-ClimaRadio.

La finestra è divisa nelle seguenti cartelle:  

Sistemi Radio permette di:

•	 scegliere il sistema radio da configurare

•	 copiare i dispositivi da un sistema radio già configurato

•	 importare la configurazione dei dispositivi dal Comunicatore GSM collegato al PC

•	 configurare il comunicatore GSM collegato al PC con i dispositivi definiti in un sistema radio.

Cronotermostati permette di:

•	 inserire, modificare, eliminare i cronotermostati per ciascun sistema radio

•	 importare la configurazione dei cronotermostati dal Comunicatore GSM collegato al PC

•	 configurare il comunicatore GSM collegato al PC con i dati dei cronotermostati gestiti nella cartella. 
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4.2.1 Sistemi radio

Questa cartella consente di selezionare, tra tutti i sistemi radio definiti nell'impianto, quello per il 
quale deve essere gestita la configurazione dei cronotermostati.  

È possibile scorrere i sistemi radio configurati con i pulsanti funzione di navigazione, o effettuare 
una ricerca rapida. 
Per il sistema radio selezionato, viene visualizzata nel dettaglio la configurazione dei cronotermostati 
nell'apposita cartella Cronotermostati. 

La cartella gestisce la possibilità di copiare, nel sistema radio selezionato, la configurazione dei 
dispositivi di un altro sistema radio definito in un impianto dell'applicazione. A questa funzionalità si 

accede dal pulsante funzione  tramite il quale viene attivata la finestra Copia Dispositivi. 

È possibile importare nel sistema radio selezionato, la configurazione dei dispositivi impostata nel 

Comunicatore GSM collegato al PC tramite l'attivazione del pulsante funzione .
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Questa funzionalità prevede la sostituzione dei cronotermostati del sistema radio selezionato con 
quelli letti dal Comunicatore GSM. 

Nel caso di importazione dal dispositivo di un cronotermostato che non risulta essere configurato 
nella cartella Cronotermostati, è previsto il suo inserimento automatico nella cartella sopra indicata 
con una descrizione predefinita. 

Con la configurazione dei dispositivi associati al sistema radio selezionato, è possibile configurare 
il Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante funzione  e prevede il trasferimento da PC 
a dispositivo dei dati relativi ai cronotermostati associati al sistema radio selezionato. 

Le procedure di importazione dati e di configurazione, prevedono la visualizzazione di un'apposita 
segnalazione di avviso nel caso in cui il numero dei cronotermostati impostato nel Comunicatore 
GSM collegato al PC, non corrisponde a quello dei cronotermostati definiti nella cartella 
Cronotermostati. 



237

Dispositivi ClimaRadio

4.2.2 Cronotermostati

Questa cartella gestisce i dati dei cronotermostati configurati per il sistema radio selezionato nella 
cartella Sistemi Radio.

Ogni sistema radio può gestire fino ad un massimo di 8 cronotermostati. 
La cartella gestisce l'inserimento di nuovi cronotermostati, la modifica e la cancellazione dei cro-
notermostati già esistenti.
Prevede inoltre la possibilità di scorrere i cronotermostati configurati con i pulsanti funzione di navi-
gazione, o di effettuare una ricerca rapida. 

Per ciascun cronotermostato sono gestite le seguenti informazioni:  

•	 Descrizione: descrizione del cronotermostato; deve essere obbligatoriamente inserita ed iden-
tifica il cronotermostato all'interno di un sistema radio. 

•	 Etichetta vocale: percorso del file contenente la registrazione del messaggio vocale utente 
associato al cronotermostato.

	 Il percorso del file può essere indicato attivando la finestra Associa File Vocale tramite l'apposito 

pulsante funzione .
	 Se non viene indicato il nome di un file, si assume che al cronotermostato sia associata l'etichetta 

vocale predefinita.

•	 Etichetta SMS Predefinita: etichetta SMS predefinita; non può essere modificata.

•	 Etichetta SMS Utente: etichetta SMS definita dall’utente; se non specificata, si assume che al 
cronotermostato sia associata l’etichetta SMS predefinita.
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•	 N. Cronotermostato: numero del cronotermostato; il valore inserito deve essere compreso tra 1 
e 8; non può essere indicato lo stesso numero per due diversi cronotermostati; il valore inserito 
è utilizzato per la composizione dei messaggi da inviare al Comunicatore GSM.

Per ciascun cronotermostato configurato, è prevista la possibilità di ascoltare il messaggio utente 

registrato nel file vocale. A questa funzionalità si accede dal pulsante funzione  tramite il quale 
viene attivata la finestra Registrazione Messaggi. 

È inoltre prevista la possibilità di registrare un messaggio diverso da quello predefinito. Questa ope-

razione è gestita dalla stessa finestra Registrazione Messaggi attivata dal pulsante funzione . 

È possibile copiare un cronotermostato già configurato per un altro sistema radio esistente in un 

impianto dell’applicazione. A questa funzionalità si accede dal pulsante funzione  tramite il quale 
viene attivata la finestra Copia Cronotermostato.

È possibile importare le informazioni relative al cronotermostato visualizzato nella cartella corrente 

dal Comunicatore GSM collegato al PC, tramite l'attivazione del pulsante funzione . Questa 
funzionalità prevede la sostituzione dei dati del cronotermostato con quelli letti dal Comunicatore 
GSM. 
Se viene letto dal Comunicatore un messaggio vocale utente, questo verrà memorizzato in un 
file vocale il cui nome sarà visualizzato nell'apposito campo della cartella al fine di consentirne 
l'ascolto. Se invece al cronotermostato risulta associato il messaggio vocale predefinito, non sarà 
visualizzato il nome del file vocale e, di conseguenza, non è prevista la possibilità di ascoltarne la 
registrazione. 

Le impostazioni del cronotermostato visualizzato nella cartella corrente, possono essere configu-
rate nel Comunicatore GSM collegato al PC.

Questa funzionalità è disponibile attivando il pulsante  funzione  e prevede il trasferimento da PC 
a dispositivo delle informazioni relative al cronotermostato visualizzato nella cartella corrente. 
Se è stato indicato il nome di un file vocale, la registrazione del messaggio in esso contenuta sosti-
tuirà, nel Comunicatore, il messaggio predefinito; se invece non è stato indicato alcun file vocale, 
nel Comunicatore verrà ripristinata l’etichetta vocale predefinita.
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4.2.3 Copia dispositivi

Per il sistema radio selezionato nella cartella Sistemi Radio della finestra Dispositivi del 
ClimaRadio, è possibile importare i dispositivi configurati per un altro sistema radio esistente in un 
impianto dell'applicazione. 
Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella Sistemi 
Radio. 

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati e, dalla lista Sistemi Radio, il sistema radio al quale sono associati i cronoter-
mostati da duplicare nel sistema radio corrente.  

All’attivazione del tasto , i dispositivi configurati per il sistema radio selezionato nella 
finestra, sostituiranno i cronotermostati del sistema radio corrente. 

È prevista la possibilità di effettuare l'operazione di copia anche da un sistema radio esistente nello 
stesso impianto elaborato: verranno in questo caso visualizzati, nell'apposita lista, tutti i sistemi 
radio dell'impianto ad esclusione di quello corrente.
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Per il sistema radio selezionato nella cartella Sistemi Radio della finestra Dispositivi del 
ClimaRadio, è possibile importare un cronotermostato configurato per un altro sistema radio esi-
stente in un impianto dell'applicazione. 
Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella 
Cronotermostati. 

Per effettuare l'operazione di copia devono essere selezionati, dalla lista Impianti, l'impianto dal 
quale importare i dati, dalla lista Sistemi Radio, il sistema radio al quale è associato il dispositivo 
da duplicare e, dalla lista Cronotermostati, il cronotermostato da duplicare nel sistema radio 
corrente.  

All’attivazione del tasto , il cronotermostato selezionato per la copia verrà aggiunto ai 
cronotermostati già configurati nel sistema radio. 

Nel caso in cui il numero cronotermostato del dispositivo da copiare è uguale a quello di un cro-
notermostato già configurato nel sistema radio corrente, verrà richiesta una conferma a procedere 
all'operazione di copia e, nel caso di risposta affermativa, verrà richiesto l’inserimento di un nuovo 
numero da attribuire al cronotermostato da importare. 

Dispositivi ClimaRadio
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Nel caso in cui il cronotermostato da copiare presenta una descrizione uguale a quella di un cro-
notermostato già configurato nel sistema radio corrente, verrà richiesta una conferma a procedere 
all'operazione di copia e, nel caso di risposta affermativa, verrà richiesto l’inserimento di una nuova 
descrizione da attribuire al cronotermostato da importare.
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4.3 Test ClimaRadio 
È prevista la possibilità di eseguire il test dei sistemi radio definiti nell'impianto, attivando, dalla barra degli 
strumenti del sistema EasyTool, il modulo Test definito nel Sistema  GSM-ClimaRadio 

La finestra è divisa in due cartelle: 

Comunicazion permette di: 

•	 scegliere il sistema radio per il quale eseguire il test
• 	verificare lo stato del Modulo di Comunicazione Interna (MCI)

Cronotermostati permette di: 

•	 verificare lo stato dei cronotermostati associati ad un sistema radio
• 	impostare la modalità di funzionamento di ciascun cronotermostato 
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4.3.1 Comunicazione

Questa cartella consente di selezionare, tra tutti i sistemi radio definiti nell'impianto, quello per il 
quale deve essere eseguito il test.  

È possibile scorrere i sistemi radio configurati con i pulsanti funzione di navigazione, o effettuare 
una ricerca rapida. 
Per ciascun sistema radio vengono visualizzate le informazioni relative alla descrizione ed al punto 
di accesso. 
Per il sistema radio selezionato, vengono visualizzati tutti i cronotermostati configurati nell'apposita 
cartella Cronotermostati. 

La cartella gestisce la possibilità di visualizzare lo stato del Modulo di Comunicazione Interna (MCI). 
A questa funzionalità si accede dal pulsante funzione  tramite il quale viene attivata la finestra 
Stato MCI. 
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4.3.2 Cronotermostati

Questa cartella visualizza i cronotermostati configurati per il sistema radio selezionato nella cartella 
Comunicazione. 

Per ciascuno dei cronotermostati configurati, vengono visualizzate le informazioni relative al numero 
del cronotermostato, alla descrizione, all’etichetta vocale, all’etichetta SMS predefinita ed utente.  

È gestita la possibilità di visualizzare lo stato di ciascun cronotermostato selezionando, dall'apposita 
lista, il cronotermostato da verificare, ed attivando la finestra Stato Cronotermostato tramite il 
pulsante funzione . 

Per il cronotermostato selezionato, è prevista inoltre la possibilità di modificare la modalità di 
funzionamento. Questa funzionalità è disponibile attivando la finestra Stato Cronotermostato dal 

pulsante funzione  oppure eseguendo un doppio click con il tasto sinistro del mouse sulla riga 
del cronotermostato da configurare.
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4.3.3 Stato MCI.

È possibile visualizzare lo stato del Modulo di Comunicazione Interna (MCI), tramite la funzionalità 
prevista dal pulsante funzione  presente nella cartella Comunicazione della finestra Test 
ClimaRadio.  

Alla sua attivazione, vengono visualizzate le informazioni lette dal Comunicatore GSM collegato al 
PC, e di seguito elencate:  

• Stato del Modulo di Comunicazione Interna (ATTIVO/DISATTIVO)

• Versione del firmware del Modulo di Comunicazione Interna

• Numero di cronotermostati configurati nell'impianto
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4.3.4 Stato cronotermostato.

È possibile visualizzare lo stato di ciascun cronotermostato configurato in un sistema radio, atti-
vando la finestra Stato Cronotermostato tramite il pulsante funzione  presente nella cartella 
Cronotermostati della finestra Test ClimaRadio. 

Per ciascun cronotermostato configurato nel sistema, è inoltre possibile impostare la modalità di 
funzionamento tramite la finestra Stato Cronotermostato attivabile dalla cartella Cronotermostati 
della finestra Test ClimaRadio tramite il pulsante funzione  oppure eseguendo un doppio click 
con il tasto sinistro del mouse sulla riga del cronotermostato da configurare.
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All’attivazione della finestra Stato Cronotermostato, vengono visualizzate le informazioni lette 
tramite il Comunicatore GSM collegato all'interfaccia di Comunicazione Interna, e di seguito elen-
cate:   

•  Temperatura misurata

•  Temperatura impostata

•  Modalità di funzionamento

Una volta attivata la finestra, è possibile effettuare una nuova lettura dello stato del cronotermostato 
tramite la funzionalità prevista dal tasto .
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Se la finestra è stata attivata dal pulsante funzione  oppure tramite doppio click del tasto sinistro 
del mouse, è prevista la possibilità di impostare la modalità di funzionamento per il cronotermostato 
elaborato.

Sono gestite le seguenti modalità di funzionamento: 

• Spento: permette di spegnere il cronotermostato.

• Spento a Termine: imposta il funzionamento del cronotermostato in modalità spento a termine 
ed il numero delle ore in cui il dispositivo deve mantenere la modalità; il numero delle ore deve 
essere compreso tra 0 e 99.

•	 Manuale: imposta il funzionamento del cronotermostato in modalità manuale e la relativa tem-
peratura; la temperatura impostata deve avere un valore compreso tra 0 e 99,9.

•	 Manuale Temporaneo: imposta il funzionamento del cronotermostato in modalità manuale 
temporaneo e la relativa temperatura; la temperatura impostata deve avere un valore compreso 
tra 0 e 99,9.

•	 Automatico: imposta la modalità di funzionamento automatico del cronotermostato.

•	 Antigelo: imposta il funzionamento del cronotermostato in modalità antigelo e la relativa tempe-
ratura; la temperatura impostata deve avere un valore compreso tra 0 e 99,9.

•	 Temperatura Funzionamento Manuale: imposta la temperatura del cronotermostato per la 
modalità di funzionamento manuale; la temperatura impostata deve avere un valore compreso 
tra 0 e 99,9.

•	 Temperature Funzionamento Automatico: imposta i tre livelli di temperatura del cronotermo-
stato per la modalità di funzionamento automatico; vengono impostati i soli livelli indicati; se 
specificata, la temperatura di ciascun livello deve avere un valore compreso tra 0 e 99,9.

È inoltre gestita l'impostazione della stagione tramite la selezione di una delle seguenti modalità: 

•	 Riscaldamento: imposta il funzionamento Riscaldamento (inverno).

•	 Condizionamento: imposta il funzionamento Condizionamento (estate).

Il cronotermostato viene configurato con la modalità di funzionamento selezionata, tramite l'attiva-
zione del tasto .

Test ClimaRadio
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4.4 Utility generali 
4.4.1 Ricerca dati

È prevista la possibilità di ricercare dei dati appartenenti all'impianto e memorizzati nelle varie car-
telle dell'applicazione, tramite la finestra Ricerca Dati. 

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella barra degli strumenti 
delle cartelle dell'applicazione. 

La finestra prevede la possibilità di specificare dei criteri di filtro indicando, negli appositi campi 
previsti, uno o più valori da ricercare.
Possono essere indicati anche filtri parziali specificando, ad esempio, solo alcuni caratteri iniziali 
del valore da ricercare. 
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All'attivazione del tasto , la procedura ricerca, tra tutti i dati presenti nella cartella dalla 
quale la finestra è stata attivata, un elemento i cui valori corrispondono a quelli indicati nei campi di 
filtro, e lo visualizza nella cartella stessa.

All'attivazione del tasto , viene ricercato se esiste un altro dato, oltre a quello 
precedentemente visualizzato, che soddisfa alle condizioni di filtro impostate: l'eventuale elemento 
trovato viene riportato nella cartella dalla quale la finestra è stata attivata. 

Utility generali
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4.4.2 Associa file vocale

La selezione di un file contenente la registrazione di un messaggio vocale è gestita dalla finestra 
Associa File Vocale.  

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella 
Cronotermostati della finestra Dispositivi. 

Il file vocale può essere indicato selezionando un elemento dalla lista dei file prevista nella finestra, 
oppure digitando il nome nell'apposito campo. 
È prevista la possibilità di specificare il nome di un file non esistente; in questo caso, una volta disat-
tivata la finestra attuale, dovrà essere effettuata la registrazione del messaggio vocale da inserire 
nel file. Questa funzionalità è gestita dalla finestra Registrazione Messaggi attivabile dalla stessa 
cartella dalla quale è stata richiesta la finestra corrente mediante il pulsante funzione .

Tramite l'attivazione del pulsante funzione , la procedura prevede la visualizzazione 
del percorso completo del file vocale specificato, nell'apposito campo della cartella dalla quale la 
finestra è stata attivata.
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4.4.3 Registrazione messaggi

La finestra Registrazione Messaggi prevede la possibilità di ascoltare la registrazione di un mes-
saggio vocale esistente e di effettuare la registrazione di un nuovo messaggio.

Si può accedere a questa funzionalità dal pulsante funzione  previsto nella cartella 
Cronotermostati della finestra Dispositivi.

La procedura visualizza, nell'apposito campo, il percorso del file vocale gestito dalla finestra corren-
te; il nome del file è desunto dalla cartella dalla quale la finestra è stata attivata.

Se il file vocale contiene già la registrazione di un messaggio, questo può essere ascoltato median-
te l'attivazione del pulsante funzione . 

La finestra prevede inoltre la possibilità di effettuare la registrazione di un nuovo messaggio voca-
le. Questa funzionalità è gestita dal tasto , la cui attivazione dà inizio alla fase di registrazione 
che ha termine con la selezione del pulsante funzione .

Il nuovo messaggio registrato può essere ascoltato, sempre mediante l'attivazione del pulsante 
funzione , e può essere salvato nel file vocale gestito dalla finestra. Questa funzionalità è 
attivabile dal pulsante funzione , previo richiesta di conferma a procedere. 

Utility generali
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4.4.4 Help.

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del 
sistema EasyTool, oppure attraverso il tasto F1 dalle finestre principali. 
Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato 
(ad esempio: premendo F1 dalla finestra “Test ClimaRadio” verrà visualizzata la parte dell'help 
relativa al test dei sistemi radio configurati in un impianto).
Selezionando il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta 
essere in primo piano tra tutte quelle attive nell’applicazione.
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4.5 Esempio Applicativo 

4.5.1 Importazione sistema radio

Creazione di un sistema radio importando i dati di configurazione dell’impianto letti tramite il 
Comunicatore GSM collegato all'interfaccia di Comunicazione Interna.
Nell’impianto risultano installati 2 cronotermostati

	 Operazioni da eseguire

1. Attivare la finestra Dispositivi e selezionare, nella cartella Sistemi Radio, il sistema radio da 
gestire (vedere i paragrafi 4.2 e 4.2.1).

2. Attivare la procedura di importazione dati tramite il pulsante funzione  (vedere il paragrafo 
4.2.1).

3.	Personalizzare eventualmente i due cronotermostati associando un messaggio vocale utente 
o un’etichetta SMS diversa da quella predefinita, selezionando la cartella Cronotermostati e 
modificando il dispositivo da personalizzare (vedere il paragrafo 4.2.2).

	 Dopo aver effettuato le modifiche sui dati di un cronotermostato, eseguire la procedura di confi-
gurazione del Comunicatore GSM tramite il pulsante funzione .

	 Di default il cronotermostato 1 possiede l'etichetta vocale “termostato uno” e l'etichetta SMS 
“C1”, mentre il cronotermostato 2 possiede le etichette “termostato due” e “C2”.

4.	Per avere informazioni sullo stato dei cronotermostati installati e per impostare la modalità di 
funzionamento dei cronotermostati stessi, eseguire le seguenti operazioni:
4.1.	attivare la finestra Test e selezionare, nella cartella Comunicazione, il sistema radio da 

gestire (vedere i paragrafi 4.3 e 4.3.1)
4.2.	selezionare, nella cartella Cronotermostati, il cronotermostato da gestire ed attivare la 

funzione relativa alla visualizzazione dello stato del dispositivo e/o quella che consente di 
modificare la sua modalità di funzionamento (vedere il paragrafo 4.3.2).
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Sezione 2.3
Touch screen
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Sezione 2.3.1
Manuale tecnico per il software

di gestione del touch screen  
20511 - 14511

Touch screen a colori



260



261

Indice

1. Requisiti minimi hardware e software… ……………………………………………………………………    262

2. Installazione del programma… ………………………………………………………………………………    262
2.1 Configurazione dei sistemi per l’inserimento del touch screen… ………………………………………    262

3. Descrizione funzionale del software Touch screen… ……………………………………………………    263
3.1 Funzionalità……………………………………………………………………………………………………    263
3.2 Note generali…………………………………………………………………………………………………    263

3.2.1 Caratteri non consentiti… ……………………………………………………………………………… 263

4. Le funzionalità………………………………………………………………………………………………………  264

5. Parametri di configurazione del Touch screen… ……………………………………………………………  265
5.1 inserimento degli ambienti … …………………………………………………………………………………  266

5.1.1 Scelta della grafica… ………………………………………………………………………………….  266
5.1.2 Inserimento Scenari……………………………………………………………………………………… 267
5.1.3 Inserimento Luci e Tapparelle…………………………………………………………………………… 271
5.1.4 Inserimento Clima… …………………………………………………………………………………    273

5.2 Inserimento Controllo Carichi …………………………………………………………………………………  276

5.3 Antintrusione… …………………………………………………………………………………………………  279

5.4 Selezione della pagina di default………………………………………………………………………………  281

6. Help		 ………………………………………………………………………………………………………………  283



262

Requisiti - Installazione - Funzionalità

262

1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

Affinchè il touch screen possa essere utilizzato nel sistema By-me è necessario che la centrale di 
controllo sia dotata di firmware ver. 2.0 o successive.

2. Installazione del programma

L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

2.1 Configurazione dei sistemi per l’inserimento del touch screen
Questa finestra consente di definire i dispositivi ed i sistemi che devono essere associati all'impianto da 
gestire.  Per poter attivare questa finestra, non devono risultare moduli attivi: si deve procedere quindi alla 
chiusura di tutti i moduli prima di effettuare la configurazione dei sistemi dell'impianto.

Si accede a questa funzionalità dal menu Sistemi ► Configurazione (vd. Capitolo 5.8 - pag. 21)
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3. Descrizione funzionale del software Touch screen

3.1 Funzionalità
Il software per PC contenuto nel CD, allegato al touch screen, permette di:  
1.	configurare i touch screen, inserendo diversi ambienti e, per ogni ambiente, diversi dispositivi; 
2.	visualizzare il layout dei touch screen e modificarlo inserendo e cancellando dispositivi o modificando 

la posizione di quelli esistenti; 
3.	inviare le configurazioni ai touch screen collegati al PC; 
4.	aggiornare il software dei dispositivi touch screen.  

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione. 

Le descrizioni usate nei touch screen devono essere prive di caratteri accentati.
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4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

Pulsanti di funzione:

 	 Mette in modifica il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione touch screen:

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Invia i dati impostati sul software al touch screen

 	 Aggiorna il software del touch screen

Segue il dettaglio delle finestre dell’applicazione e delle operazioni disponibili.
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5. Parametri di configurazione del Touch screen.

Questa cartella gestisce la configurazione generale dei dispositivi Touch Screen definiti in un impianto.

Prima di procedere alla configurazione dei touch screen, è indispensabile inserire almeno una Centrale By-me 
ed effettuarne l'importazione dei dispositivi all'interno del software. Infatti il modulo del touch screen permette 
di aggiungere solamente i dispositivi importati dalle Centrali By-me.

Selezionare quindi la cartella dispositivi Touch-Screen e premere il pulsante “Parametri di configurazione”

La finestra è formata da una sola cartella Touch Screen che permette di: 

• importare dalla Centrale By-me i dati dei dispositivi da inserire nel Touch Screen; 
• disporre e ordinare i dispositivi nelle schermate dei Touch Screen; 
• visualizzare sul PC le immagini di come si presenteranno le schermate dei Touch Screen; 
• esportare i dati sui Touch Screen collegati al PC; 
• aggiornare il software dei Touch Screen collegati al PC;
• impostare la grafica, cioè il colore di sfondo e dei pulsanti del Touch Screen.
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5.1 Inserimento degli ambienti 
Alla funzione Controllo ambienti si possono inserire diversi ambienti da controllare.

Scegliere il Touch screen da modificare (se ce ne fossero presenti più di uno) tramite il pulsante di naviga-
zione  della barra in alto a sinistra.

Premere il pulsante di funzione modifica .

Selezionare Controllo ambienti sulla schermata a sinistra. 

Premere il tasto di inserimento  in basso a sinistra. Si aprirà così la seguente finestra.

Inserire il nome dell’ambiente e premere Applica per confermare o Annulla per uscire dall’aggiunta 
dell’ambiente. Successivamente è possibile inserire i dispositivi, selezionando l'ambiente da popolare e 
trascinandoli col puntatore del mouse dal pannello a destra alla pagina ambiente disegnata in centro che 
rappresenta le schermate del touch screen.
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È possibile modificare in un secondo momento i nominativi degli ambienti tramite il pulsante di funzione 
Modifica  in basso a sinistra.

Per confermare gli inserimenti o le modifiche e continuare con la configurazione premere il pulsante di 
funzione  nella barra degli strumenti in alto a destra.

È possibile scorrere i dispositivi touch screen esistenti, tramite i pulsanti funzione, e modificarli.

Per completare la configurazione, collegare il touch screen al PC tramite l'interfaccia Vimar 01998.S e 
premere il pulsante funzione Invia , che si trova nella barra dei pulsanti in basso a sinistra.

Per aggiornare il software del touch screen, collegarlo al PC tramite l'interfaccia Vimar 01998.S e premere 
il pulsante funzione Aggiorna il software , che si trova nella barra dei pulsanti in basso a sinistra. 

5.1.1 Scelta della grafica

Per default il colore dello sfondo e dei pulsanti del touch screen è nero. Può essere modificato 
selezionando un altro colore dal menu a tendina Grafica, che si trova a fianco della Descrizione.
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Premendo il pulsante A verrà visualizzata l'anteprima della grafica scelta. 
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5.1.2 Inserimento Scenari

Questa finestra gestisce l'inserimento degli scenari nella pagina ambiente dei dispositivi touch screen.

Per inserire uno scenario è necessario: 
1. selezionare l'ambiente in cui inserire lo scenario; 
2. cliccare sul pulsante funzione Modifica .  
3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 

da importare e posizionarsi sull'opportuna scheda
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4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Inserire la descrizione desiderata e scegliere l’immagine che si ritiene più adatta selezionandola 
tra le varie disponibili visibili premendo i tasti 

 
 e  oppure, per una visione più ampia, il 

tasto .

	 Premere Applica per confermare o Annulla per tornare alla schermata principale.

5.	confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della 
barra di strumenti in alto. 

Dopo aver inserito il dispositivo, è possibile modificarne sia la posizione che le impostazioni.

Modifica posizione: cliccare sul pulsante funzione Modifica , nella barra in alto, e trasci-
narlo con il puntatore del mouse. Confermare con il pulsante funzione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il dispositivo è sufficiente selezionarlo col mouse, cliccare sul pulsante funzione 
Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera del PC. 

Parametri di configurazione
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5.1.3 Inserimento Luci e Tapparelle

Per inserire un dispositivo di tipo luce o tapparella è necessario:  

1. selezionare l'ambiente in cui inserire il dispositivo;  
2. cliccare sul pulsante funzione Modifica  sulla barra in alto

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda; 

4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.
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	 Inserire la descrizione desiderata, selezionare il dispositivo di appartenenza e scegliere l’immagi-
ne che si ritiene più adatta tra le varie disponibili visibili premendo i tasti 

 
 e  oppure, per 

una visione più ampia, il tasto .

Premere Applica per confermare o Annulla per tornare alla schermata principale.

5. confermare la configurazione impostata tramite il pulsante funzione  Salva modifiche  della 
barra degli strumenti in alto. 

Dopo aver inserito il dispositivo, è possibile modificarne sia la posizione che le impostazioni.

Modifica posizione: cliccare sul pulsante funzione Modifica , nella barra in alto, e trasci-
narlo con il puntatore del mouse. Confermare con il pulsante funzione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il dispositivo è sufficiente selezionarlo col mouse, cliccare sul pulsante funzione 
Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera del PC.
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5.1.4  Inserimento Clima

Questa finestra gestisce l'inserimento del clima nella pagina ambiente dei dispositivi touch screen.

Per inserire un dispositivo di tipo clima è necessario: 

1. selezionare l'ambiente in cui inserire il clima; 

2. cliccare sul pulsante funzione Modifica  sulla barra in alto

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda

4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Se ci sono altri elementi nel layout dell'ambiente viene inserito il comando Visualizza tempera-
tura.
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	 altrimenti è possibile scegliere tra Visualizza temperatura e Imposta temperatura.

Nel secondo caso non risulta possibile aggiungere altri elementi ed il nome dell'ambiente viene 
sostituito dal nome del termostato.

Premere Applica per confermare o Annulla per tornare alla schermata principale.

5. confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della 
barra degli strumenti in alto. 

Modifica posizione (solo per Visualizza temperatura): cliccare sul pulsante funzione Modifica 
, nella barra in alto, e trascinarlo con il puntatore del mouse. Confermare con il pulsante fun-

zione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.
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Per eliminare il comando Visualizza temperatura è sufficiente selezionarlo, cliccare sul pulsante 
funzione Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera 
del PC. 

Se è stato inserito il comando Imposta temperatura non è possibile cancellare i singoli elementi 
che lo compongono e per eliminarlo è necessario eliminare l'ambiente. 
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5.2 Inserimento Controllo Carichi 
Per inserire un controllo carichi nel touch screen è necessario: 

1. selezionare il nome dell'impianto e premere il pulsante di Modifica , nella barra in alto; 

2.	� inserire un Controllo carichi, cliccando sul pulsante di inserimento  nella barra in basso a sini-
stra; 

3.	inserire i vari Carichi selezionando il Controllo carichi e cliccando sul pulsante di Modifica nella barra 
dei pulsanti in alto ed il pulsante di inserimento nella barra in basso. 
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Ognuno di questi corrisponde ad una schermata del Touch Screen.

4.	inserire i sensori, selezionando la pagina di Carichi da popolare e trascinando i dispositivi dal pannello 
a destra alla pagina ambiente disegnata in centro.

	 Inserire la descrizione desiderata e scegliere l’immagine che si ritiene più adatta tra le varie disponibili 
visibili premendo i tasti 

 
 e  oppure, per una visione più ampia, il tasto .

	 Premere Applica per confermare o Annulla per tornare alla schermata principale. 
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5.	confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della barra 
di strumenti in alto. 

	 Per eliminare il dispositivo da un dal touch screen a colori, è sufficiente selezionarlo direttamente 
sull'albero dell'impianto nella parte destra della finestra, cliccare sul pulsante funzione Modifica  , 
e premere il tasto di cancellazione Canc della tastiera del PC.

Parametri di configurazione
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5.3 Antintrusione 
Per inserire un impianto antintrusione nel touch screen è necessario: 

1.	 selezionare il nome dell'impianto e premere il pulsante di Modifica , nella barra in alto; 

2.	� inserire un impianto Antinutrusione, cliccando sul pulsante di inserimento  nella barra in basso a 
sinistra; 

3.	� confermare la configurazione impostata tramite il pulsante funzioneSalva modifiche  della barra 
di strumenti in alto.

Parametri di configurazione
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Nei touch screen si può solo visualizzare la pagina dell'impianto Antintrusione ed eventualmente elimi-
narla cliccando sul pulsante di Modifica nella barra dei pulsanti in alto e successivamente il pulsante di 
cancellazione nella barra in basso.

Parametri di configurazione
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5.4 Selezione della pagina di default 
La pagina di default è la schermata del touchScreen che verrà visualizzata quando il touchScreen torna 
dalla modalità di risparmio energetico/ screensaver. 

Per definire la pagina di default è necessario:

1. �selezionare la pagina da impostare come default (in questo esempio mettiamo la schermata dell’An-
tintrusione); 

2.	 cliccare sul pulsante funzione Modifica  ;

3.	 cliccare sul pulsante Imposta default  della barra degli strumenti in basso;

Parametri di configurazione
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4.	 confermare tramite il pulsante Salva modifiche  della barra di strumenti in alto. 

Parametri di configurazione
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6. Help

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del sistema Easy 
Tool, oppure attraverso il tasto F1 dalle finestre principali. 

Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato. Selezionando 
il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta essere in primo piano tra 
tutte quelle attive nell’applicazione.
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Sezione 2.3.2
Software di gestione del touch screen

20512 - 16952 - 14512

Touch screen monocromatico
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1. Requisiti minimi hardware e software

Software:

• Sistema Operativo Microsoft Windows 98/2000/XP/Vista.
• Sistema Operativo Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10.

Hardware:

• 100 Mb di spazio di memoria su disco fisso
• Mouse
• CD-ROM
• Porta Seriale

Affinchè il touch screen possa essere utilizzato nel sistema By-me è necessario che la centrale di 
controllo sia dotata di firmware ver. 2.0 o successive.

2. Installazione del programma
L'utente verrà guidato nell'installazione del programma da un apposito wizard le cui informazioni richieste sono 
tutte riportate nel manuale del software e del PC.

2.1 Configurazione dei sistemi per l’inserimento del touch screen
Questa finestra consente di definire i dispositivi ed i sistemi che devono essere associati all'impianto da 
gestire. 
Per poter attivare questa finestra, non devono risultare moduli attivi: si deve procedere quindi alla chiusura 
di tutti i moduli prima di effettuare la configurazione dei sistemi dell'impianto.
Si accede a questa funzionalità dal menu Sistemi ► Configurazione (vd. Capitolo 5.8 - pag. 21)
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All’aggiunta del dispositivo si aprirà una ulteriore schermata che chiederà l’orientamento del touch screen 
sull’impianto, se orizzontale o verticale. Selezionare e proseguire.

Requisiti - Installazione - Funzionalità
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3. Descrizione funzionale del software Touch screen

3.1 Funzionalità
Il software per PC contenuto nel CD, allegato al touch screen, permette di:  
•	 configurare i touch screen, inserendo diversi ambienti e, per ogni ambiente, diversi dispositivi; 
•	 visualizzare il layout dei touch screen e modificarlo inserendo e cancellando dispositivi o modificando 

la posizione di quelli esistenti; 
•	 inviare le configurazioni ai touch screen collegati al PC; 
•	 aggiornare il software dei dispositivi touch screen. 

3.2 Note generali

3.2.1 Caratteri non consentiti

Nei campi di testo non è consentito l’inserimento dei seguenti caratteri:

&

<

>

Di seguito ogni parte dell’applicazione verrà analizzata e spiegata nella sua funzione.

Le descrizioni usate nei touch screen devono essere prive di caratteri accentati. 

Requisiti - Installazione - Funzionalità
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4. Le funzionalità.

Di seguito sono riportate ed analizzate nel dettaglio le funzionalità dell'applicazione.

Legenda dei pulsanti funzione tipici di tutta l’applicazione:

Pulsanti di navigazione:

 	 Porta al primo dato della cartella

 	 Porta al dato precedente a quello visualizzato

 	 Porta al dato successivo a quello visualizzato

 	 Porta all’ultimo dato della cartella

Pulsanti di funzione:

 	 Mette in modifica il dato visualizzato

 	 Conferma tutte le modifiche effettuate (inserimento di un nuovo dato o modifica di un dato esistente)

 	 Annulla le ultime modifiche o il nuovo inserimento e ripristina lo stato precedente

Pulsanti di gestione touch screen:

 	 Permette di inserire un nuovo dato nella cartella

 	 Cancella il dato visualizzato

 	 Invia i dati impostati sul software al touch screen

 	 Aggiorna il software del touch screen

Segue il dettaglio delle finestre dell’applicazione e delle operazioni disponibili.
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5. Parametri di configurazione del Touch screen.

Questa cartella gestisce la configurazione generale dei dispositivi Touch Screen definiti in un impianto.

Prima di procedere alla configurazione dei touch screen, è indispensabile inserire almeno una Centrale By-me 
ed effettuarne l'importazione dei dispositivi all'interno del software. Infatti il modulo del touch screen permette 
di aggiungere solamente i dispositivi importati dalle Centrali By-me.

La finestra è formata da una sola cartella Touch Screen che permette di: 

• importare dalla Centrale By-me i dati dei dispositivi da inserire nel Touch Screen; 
• disporre e ordinare i dispositivi nelle schermate dei Touch Screen; 
• visualizzare sul PC le immagini di come si presenteranno le schermate dei Touch Screen; 
• esportare i dati sui Touch Screen collegati al PC;



293

Parametri di configurazione

5.1 Inserimento degli ambienti 
Alla funzione Controllo ambienti si possono inserire diversi ambienti (al massimo 3) da controllare.

Selezionare Controllo ambienti sulla schermata a sinistra. 

Premere il tasto di inserimento  in basso a sinistra. Si aprirà così la seguente finestra.

Inserire il nome dell’ambiente e premere Applica per confermare o Annulla per uscire dall’aggiunta 
dell’ambiente. Successivamente è possibile inserire i dipositivi, selezionando l'ambiente da popolare e 
trascinandoli col puntatore del mouse dal pannello a destra alla pagina ambiente disegnata in centro che 
rappresenta le schermate del touch screen.



294

Parametri di configurazione

5.1.1 Inserimento Scenari

Questa finestra gestisce l'inserimento degli scenari nella pagina ambiente dei dispositivi touch 
screen.

Per inserire uno scenario è necessario: 
1. selezionare l'ambiente in cui inserire lo scenario; 
2. cliccare sul pulsante funzione Modifica .  

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda

È possibile scorrere i dispositivi touch screen esistenti, tramite i pulsanti funzione, e modificarli.

Per completare la configurazione, collegare il touch screen al PC tramite l'interfaccia Vimar 01998.S e 
premere il pulsante funzione Invia , che si trova nella barra dei pulsanti in basso a sinistra.

Per aggiornare il software del touch screen, collegarlo al PC tramite l'interfaccia Vimar 01998.S e premere 
il pulsante funzione Aggiorna il software , che si trova nella barra dei pulsanti in basso a sinistra. 
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4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Inserire la descrizione desiderata e scegliere l’immagine che si ritiene più adatta selezionandola 
tra le varie disponibili visibili premendo i tasti 

 
 e .

	 Premere Applica per confermare o Annulla per tornare alla schermata principale.

5.	confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della 
barra di strumenti in alto. 

Dopo aver inserito il dispositivo, è possibile modificarne sia la posizione che le impostazioni.

Modifica posizione: cliccare sul pulsante funzione Modifica , nella barra in alto, e trasci-
narlo con il puntatore del mouse. Confermare con il pulsante funzione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il dispositivo è sufficiente selezionarlo col mouse, cliccare sul pulsante funzione 
Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera del PC. 
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5.1.2 Inserimento Luci e Tapparelle

Per inserire un dispositivo di tipo luce o tapparella è necessario:  

1. selezionare l'ambiente in cui inserire il dispositivo;  
2. cliccare sul pulsante funzione Modifica  sulla barra in alto

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda; 
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4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Inserire la descrizione desiderata, selezionare il dispositivo di appartenenza e scegliere l’immagi-
ne che si ritiene più adatta tra le varie disponibili visibili premendo i tasti 

 
 e .

Premere Applica per confermare o Annulla per tornare alla schermata principale.

5. confermare la configurazione impostata tramite il pulsante funzione  Salva modifiche  della 
barra degli strumenti in alto. 

Dopo aver inserito il dispositivo, è possibile modificarne sia la posizione che le impostazioni.

Modifica posizione: cliccare sul pulsante funzione Modifica , nella barra in alto, e trasci-
narlo con il puntatore del mouse. Confermare con il pulsante funzione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il dispositivo è sufficiente selezionarlo col mouse, cliccare sul pulsante funzione 
Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera del PC.
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5.1.3  Inserimento Clima

Questa finestra gestisce l'inserimento del clima nella pagina ambiente dei dispositivi touch screen.

Per inserire un dispositivo di tipo clima è necessario: 
1. selezionare l'ambiente in cui inserire il clima; 
2. cliccare sul pulsante funzione Modifica  sulla barra in alto

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda
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4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Se ci sono altri elementi nel layout dell'ambiente viene inserito il comando Visualizza tempera-
tura

	 altrimenti è possibile scegliere tra Visualizza temperatura e Imposta temperatura.

Nel secondo caso non risulta possibile aggiungere altri elementi ed il nome dell'ambiente viene 
sostituito dal nome del termostato.

Premere Applica per confermare o Annulla per tornare alla schermata principale.

5. confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della 
barra degli strumenti in alto. 
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Modifica posizione (solo per Visualizza temperatura): cliccare sul pulsante funzione Modifica 
, nella barra in alto, e trascinarlo con il puntatore del mouse. Confermare con il pulsante fun-

zione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il comando Visualizza temperatura è sufficiente selezionarlo, cliccare sul pulsante 
funzione Modifica Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della 
tastiera del PC. 

Se è stato inserito il comando Imposta temperatura non è possibile cancellare i singoli elementi 
che lo compongono e per eliminarlo è necessario eliminare l'ambiente. 
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5.1.4  Inserimento Controllo Carichi

Questa finestra gestisce l'inserimento del controllo carichi nella pagina ambiente dei dispositivi 
touch screen.

Per inserire un controllo carichi nel Touch BW è necessario:  
1. selezionare l'ambiente in cui inserire il controllo carichi  
2. cliccare sul pulsante funzione Modifica  sulla barra in alto

3.	dalla sezione sulla destra in alto scegliere la centrale By-me in cui è stato configurato il dispositivo 
da importare e posizionarsi sull'opportuna scheda
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4.	selezionare il dispositivo e trascinarlo col mouse sulla pagina ambiente centrale che rappresenta 
lo schermo del touch screen; a operazione ultimata si aprirà una finestra con delle scelte di 
configurazione da effettuare.

	 Premere Applica per confermare o Annulla per tornare alla schermata principale.

5.	confermare la configurazione impostata tramite il pulsante funzione Salva modifiche  della 
barra degli strumenti in alto. 

Dopo aver inserito il dispositivo, è possibile modificarne sia la posizione che le impostazioni.

Modifica posizione: cliccare sul pulsante funzione Modifica , nella barra in alto, e trasci-
narlo con il puntatore del mouse. Confermare con il pulsante funzione Salva modifiche .

Modifica impostazioni: cliccare sul pulsante funzione Modifica  e selezionare con un doppio 
click il pulsante corrispondente al dispositivo da modificare; apparirà la finestra con le impostazioni 
modificabili.

Per eliminare il dispositivo è sufficiente selezionarlo col mouse, cliccare sul pulsante funzione  
Modifica  nella barra in alto, e premere il tasto di cancellazione Canc della tastiera del PC.
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5.2 Selezione della pagina di default
La pagina di default è la schermata del touchScreen che viene visualizzata quando il touchScreen torna 
dalla modalità di risparmio energetico/ screensaver. 

Per definire la pagina di default è necessario:

1.	 selezionare la pagina da impostare come default; 

2.	 cliccare sul pulsante funzione Modifica ;

3.	 cliccare sul pulsante Imposta default della barra degli strumenti in basso;

4.	 confermare tramite il pulsante Salva modifiche  della barra di strumenti in alto.

È possibile visualizzare sul touchScreen la pagina preferita come screensaver; per impostarlo è sufficiente 
selezionare la voce Pagina preferita some screensaver, che si trova a fianco della Descrizione. Si 
noti che la selezione è possibile se e solo se è stata definita la pagina di default attraverso la procedura 
descritta sopra.
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6. Help

L’applicazione fornisce l’accesso ad un help in linea attraverso il menu Help ► Help in linea del sistema Easy 
Tool, oppure attraverso il tasto F1 dalle finestre principali. 

Si tratta di un help contestuale ovvero visualizza il testo relativo alla finestra da cui viene chiamato. Selezionando 
il menu Help ► Help in linea, viene attivato l’help relativo alla finestra che risulta essere in primo piano tra 
tutte quelle attive nell’applicazione.
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Interfaccia per la programmazione da PC di 
dispositivi predisposti, collegamento al PC su 
porta USB, completa di CD con software.

Il dispositivo consente la programmazione delle centrali 
By-me 01950, 01951, 01952, 01956, 01958, 01960, 
del comunicatore telefonico 01942, del cronotermo-
stato GSM 01913 e dei touch screen 20511, 14511, 
20512, 16952, 14512.  
L’interfaccia, provvista di driver per USB, deve esse-
re connessa ad un personal computer sul quale 
deve essere installato l’apposito software di gestione 
EasyTool. 

CARATTERISTICHE.
•	Alimentazione direttamente da PC attraverso la porta 

USB.  
•	Cavo USB con connettore tipo A  per collegamento PC, 

lunghezza 1,8 metri (fornito).
•	Cavo personalizzato e polarizzato per collegamento 

dispositivo di programmazione, lunghezza  del cavo 
1,5 m (fornito). 

•	Temperatura di funzionamento +5 °C - +40 °C.
•	Dimensioni 115x75x25 mm.

FUNZIONAMENTO.
Collegare il dispositivo secondo la procedura illustrata 
nelle figure a lato.
Nel momento in cui l’interfaccia viene collegata al PC 
tramite il cavo USB, il led ON si accende.
Nel corso della trasmissione/ricezione dei dati, i led h e 
i si accendono come segue:
• led h acceso quando il PC riceve i dati dal dispositivo 

predisposto;
• led i acceso quando il PC trasmette i dati al dispo-

sitivo predisposto.

IMPORTANTE.
In fase di installazione del driver USB, il sistema opera-
tivo Windows XP genera un messaggio di avviso che il 
driver non è certificato da Microsoft; selezionare, quin-
di, l’opzione “Continua” per proseguire ed effettuare 
l’installazione.
Il driver USB funziona correttamente con i sistemi ope-
rativi Windows 98, Windows 2000 e Windows XP.
Al termine dell’installazione di raccomanda di verifi-
care sempre che all’interno di “Risorse del computer 
- Gestione periferiche” sia presente la nuova porta 
seriale “USB Serial Port (COMX)” dove X è un numero 
compreso tra 1 e 9.

REGOLE DI INSTALLAZIONE.
L’installazione deve essere effettuata con l’osservanza 
delle disposizioni regolanti l’installazione del materiale 
elettrico in vigore nel paese dove i prodotti sono 
installati.

CONFORMITÀ NORMATIVA.
Direttiva EMC.
Norme EN 55022, EN 55024.

Interface for programming fitted devices via 
PC, connection to PC via USB port, delivered 
with application software CD.

The device enables programming the control panels 
By-me 01950, 01951, 01952, 01956, 01958, 01960,  
the phone dialler 01942, the chronothermostat GSM 
01913 and the touch screen 20511, 14511, 20512, 
16952, 14512. 
The interface, equipped with a USB driver, must be 
connected to a personal computer that must have the 
specific management software EasyTool installed.

CHARACTERISTICS.
•	Power supply directly from PC via USB.  
•	USB cable with type-A connector for PC connection, 

1.8 metres long (supplied). 
•	Customized and polarized cable for connecting the 

programming device, cable length 1.5 m (supplied). 
•	Operating temperature: -5 °C - +40 °C
•	Dimensions 115x75x25 mm

OPERATION.
Connect the device according to the procedure illus-
trated in the figures alongside.
When the interface is connected to the PC via the USB 
cable, the ON LED lights up.
During transmission/reception of the data, the LEDs h 
and i light up as follows:
• LED h on when the PC receives the data from the 

fitted device;
• LED i on when the PC transmits the data to the 

fitted device.

IMPORTANT.
In the phase of installing the USB driver, the Windows 
XP operating system generates a warning message 
saying that the driver is not certified by Microsoft: select 
the “Continue” option to continue with installation.
The USB driver works correctly with the Windows 98, 
Windows 2000 and Windows XP operating systems.
At the end of installation you are recommended to 
always check that in “My Computer - Drivers” there is 
the new serial port “USB Serial Port (COMX)” where 
X is a number between 1 and 9.

INSTALLATION RULES.
Installation should be carried out in compliance with 
the current regulations regarding the installation of 
electrical systems in the country where the products 
are installed.

CONFORMITY.
EMC directive.
Standards EN 55022, EN 55024.

Interface de programmation sur PC de dis-
positifs prédisposés, connexion au PC sur 
port USB, fournie avec CD de logiciel d’ap-
plication.

Le dispositif permet la programmation du centrales de 
contrôle 01950, 01951, 01952, 01956, 01958, 01960, 
du composeur téléphonique 01942, du chronother-
mostat GSM 01913 et du écran tactile 20511, 14511, 
20512, 19652, 14512.  
L’interface, équipée de driver USB, doit être connectée 
à un PC sur lequel doit être installé le logiciel de gestion 
EasyTool.  

CARACTÉRISTIQUES.
•	Alimentation directement sur PC par le port USB.  
•	Câble USB avec connecteur type A  pour liaison PC, 

longueur 1,8 mètres (fourni). 
•	Câble personnalisé et polarisé pour connexion de 
dispositif de programmation, longueur du câble 1,5 m 
(fourni). 

•	Température de fonctionnement : -5 °C - +40 °C.
•	Dimensions 115x75x25 mm.

FONCTIONNEMENT.
Connecter le dispositif selon la procédure illustrée sur 
la figure ci-contre.
Lorsque l’interface est reliée au PC via le câble USB, la 
led ON s’allume.
Au cours de la transmission/réception des données, les 
leds h  et i s’allument comme suit:
• led h   allumée quand le PC reçoit   les données du 

dispositif prévu à cet effet;
• led i allumée quand le PC transmet les données au 

dispositif prévu à cet effet.

IMPORTANT.
En phase d’installation du driver USB, le système 
d’exploitation Windows XP génère un message d’aver-
tissement que le driver n’est pas certifié Microsoft; 
sélectionner l’option “Continuer” pour continuer et 
effectuer l’installation.
Le driver USB fonctionne correctement avec les sys-
tèmes d’exploitation Windows 98, Windows 2000 et 
Windows XP.
A la fin de l’installation il est conseillé de vérifier toujours 
qu’à l’intérieur de “Ressources de l’ordinateur - Gestion 
périphérique” se trouve le nouveau port série “USB 
Serial Port (COMX)” où X est un numéro compris 
entre 1 et 9.

RÈGLES D’INSTALLATION.
L’installation doit être effectuée dans le respect des 
dispositions régulant l’installation du matériel électrique 
en vigueur dans le pays d’installation des produits.

CONFORMITÉ AUX NORMES.
Directive EMC.
Normes EN 55022, EN 55024.
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Interface για τον προγραμματισμό συμβατών 
μηχανισμών από PC, σύνδεση με PC σε θύρα 
USB, με το λογισμικό του CD.

Ο μηχανισμός επιτρέπει τον προγραμματισμό του 
κεντρική μονάδα ελέγχου 01950, 01951, 01952, 01956, 
01958, 01960 του τηλεφωνικού επιλογέα 01942, του 
touch screen 20511, 14511, 20512, 16952, 14512. 
Το interface διαθέτει οδηγό για USB και πρέπει να συν-
δεθεί με υπολογιστή στον οποίο είναι εγκατεστημένο το 
ειδικό λογισμικό διαχείρισης EasyTool. 

ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ.
•	 Τροφοδοσία απευθείας από το PC μέσω της θύρας 

USB.  
•	 Καλώδιο USB με κοννέκτορα τύπου A  για σύνδεση στο 

PC, μήκους 1,8 μέτρων (διατίθεται). 
•	 Ειδικό καλώδιο με πολικότητα για τη σύνδεση του 

μηχανισμού προγραμματισμού, μήκους 1,5 μέτρου 
(διατίθεται). 

•	 Θερμοκρασία λειτουργίας +5 °C - +40 °C.
•	 Διαστάσεις 115x75x25 mm.

ΛΕΙΤΟΥΡΓΙΑ.
Συνδέστε το μηχανισμό εφαρμόζοντας τη διαδικασία των 
εικόνων παραπλεύρως.
Συνδέοντας το interface στο PC με το καλώδιο USB, το 
led ON ανάβει.
Κατά τη μετάδοση/λήψη των δεδομένων, τα led h και i 
ανάβουν ως εξής:
•	 led h αναμμένο όταν το PC δέχεται δεδομένα από τον 

κατάλληλο μηχανισμό
•	 led i αναμμένο όταν το PC διαβιβάζει δεδομένα στον 

κατάλληλο μηχανισμό.

ΣΗΜΑΝΤΙΚΟ.
Κατά την εγκατάσταση του οδηγού driver USB, το λει-
τουργικό σύστημα Windows XP εμφανίζει ένα μήνυμα 
ειδοποίησης ότι ο οδηγός δεν έχει πιστοποιηθεί από 
την Microsoft. Πιέστε “Συνέχεια” για να συνεχίσετε την 
εγκατάσταση.
Ο οδηγός USB λειτουργεί σωστά με τα λειτουργικά συστή-
ματος Windows 98, Windows 2000 και Windows XP.
Μετά την ολοκλήρωση της εγκατάστασης πρέπει να 
ελέγχετε πάντα ότι στο “Σύστημα - Διαχείριση συσκευών” 
υπάρχει η νέα σειριακή θύρα “USB Serial Port (COMX)” 
όπου X ένας αριθμός από 1 έως 9.

ΚΑΝΟΝΕΣ ΕΓΚΑΤΑΣΤΑΣΗΣ.
Η εγκατάσταση πρέπει να εκτελείται σύμφωνα με τις 
ισχύουσες διατάξεις σχετικά με το ηλεκτρολογικό υλικό 
στη χώρα χρήσης των προϊόντων.

ΣΥΜΜΟΡΦΩΣΗ ΠΡΟΔΙΑΓΡΑΦΩΝ.
Οδηγία EMC.
Πρότυπα EN 55022, EN 55024.

Schnittstelle für die Programmierung der ent-
sprechend vorgerüsteten Geräte vom PC, 
anschluss am PC über USB-Port, geliefert mit 
CD-Anwendersoftware.

Das Gerät gestattet die Programmierung den 
Steuergeräten 01950, 01951, 01952, 01956, 01958, 
01960, des Telefon-Wählgerät 01942, des chrono-
thermostat GSM 01913 und des touch screen 20511, 
14511, 20512, 16952, 14512.  
Die Schnittstelle, die mit USB-Treibern ausgestattet ist, 
muss an einen Personal Computer angeschlossen wer-
den, an dem die entsprechende Verwaltungssoftware 
EasyTool installiert sein muss.  

EIGENSCHAFTEN.
•	Versorgung direkt vom PC über den USB-Port  
•	USB-Kabel mit Steckverbinder Typ A für den Anschluss 
am PC, Länge 1,8 Meter (im Lieferumfang enthalten) 

•	Personalisiertes und gepoltes Kabel für den Anschluss 
des Programmiergeräts, Kabellänge 1,5 m (im 
Lieferumfang enthalten) 

•	Betriebstemperatur:  +5 °C - +40 °C
•	Abmessungen  115x75x25 mm

FUNKTIONSWEISE.
Das Gerät wie auf den nebenstehenden Abbildungen 
dargestellt anschließen.
In dem Augenblick, in dem die Schnittstelle über das 
USB-Kabel an den PC angeschlossen wird, leuchtet 
die Led ON auf.
Während der Datenübertragung und des Datenempfangs 
leuchten die Leds h und i nacheinander wie folgt auf:
• Die Led h leuchtet auf, während der PC die Daten 
vom Gerät empfängt;

• Die Led i leuchtet auf, während der PC die Daten an 
das Gerät überträgt.

WICHTIG.
Während der Installation der USB-Treiber generiert das 
Betriebssystem Windows XP eine Warnmeldung, dass 
der Treiber nicht von Microsoft zertifiziert ist; die Option 
“Fortfahren” wählen, um die Installation durchzuführen.
Der USB-Treiber funktioniert korrekt mit den 
Betriebssystemen Windows 98, Windows 2000 und 
Windows XP.
Am Ende der Installation sollte unbedingt immer 
kontrolliert werden, ob in der “Systemsteuerung - 
Gerätemanager” der neue serielle Anschluss “USB 
Serial Port (COMX)” vorhanden ist, wobei X eine Zahl 
zwischen 1 und 9 ist.

INSTALLATIONSVORSCHRIFTEN.
Die Installation hat gemäß den im jeweiligen 
Verwendungsland der Produkte geltenden Vorschriften 
zur Installation elektrischer Ausrüstungen zu erfolgen.

NORMKONFORMITÄT.
EMV-Richtlinie.
Normen EN 55022, EN 55024.

Interfaz para programar dispositivos median-
te ordenador personal, conexión al ordenador 
personal mediante puerto USB, con CD del 
software de aplicación.

Este dispositivo permite programar las centralitas 
01950, 01951, 01952, 01956, 01958, 01960, el 
comunicador telefónico 01942, el cronotermostato 
GSM 01913 e el pantalla táctil 20511, 14511, 20512, 
16952, 14512. 
La interfaz, dotada con controlador para USB, se tiene 
que conectar a un ordenador personal en el que se 
ha de instalar el correspondiente programa de gestión 
EasyTool.   

CARACTERÍSTICAS.
•   Alimentación directamente desde el ordenador perso-

nal mediante el puerto USB.  
• Cable USB con conector de tipo A para ordenador 

personal con una longitud de 1,8 metros (suministrado 
de serie). 

• Cable personalizado y polarizado para conectar el 
dispositivo de programación con una longitud de 1,5 m 
(suministrado de serie). 

• Temperatura de funcionamiento de +5 a +40°C.
• Medidas: 115x75x25 mm.

FUNCIONAMIENTO.
Conectar el dispositivo siguiendo las instrucciones 
ilustradas en la figura.
Cuando la interfaz se conecta al ordenador personal 
mediante el cable USB, el led ON se enciende.
Durante la transmisión y la recepción de los datos, los 
leds  h  y  i  se encienden de la siguiente manera:
•	Led h : se enciende cuando el ordenador recibe los 

datos desde el dispositivo.
•	Led i : se enciende cuando el ordenador transmite 

los datos al dispositivo.

IMPORTANTE.
Durante la fase de instalación del controlador USB, el 
sistema operativo Windows XP muestra un mensaje 
de aviso en el que se informa que el controlador no 
ha sido certificado por Microsoft; seleccionar la opción 
“Continuar” para efectuar la instalación.
El controlador USB funciona correctamente con los 
sistemas operativos Windows 98, Windows 2000 y 
Windows XP.
Tras la instalación, se aconseja comprobar que en “Mi 
PC - Gestión periféricos” se encuentre el nuevo puerto 
en serie “USB Serial Port (COMX)” donde X es un 
número comprendido entre 1 y 9.

NORMAS DE INSTALACIÓN.
El aparato se ha de instalar en conformidad con las dis-
posiciones sobre material eléctrico vigentes en el país.

CONFORMIDAD NORMATIVA.
Directiva EMC.
Normas EN 55022 y EN 55024.

Anleitungen
Instrucciones

Οδηγίες  
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01942 COMUNICATORE GSM-BUS
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12-30 V 
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20550 + 01960
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